OSA-Express Integrated Console Controller Implementation Guide

Product planning and implementation information

Realistic examples and considerations

Step-by-step configuration procedures

Bill White
Jeff Nesbitt

ibm.com/redbooks
Note: Before using this information and the product it supports, read the information in “Notices” on page vii.

Second Edition (October 2005)

This edition applies to IBM System z9 and eServer zSeries (z990 and z890) servers, which support the OSA-Express Integrated Console Controller (OSA-ICC) function.

© Copyright International Business Machines Corporation 2004, 2005. All rights reserved.
Note to U.S. Government Users Restricted Rights -- Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Notices .......................................................... vii
Trademarks ....................................................... viii

Preface .......................................................... ix
The team that wrote this redbook ............................... ix
Become a published author ...................................... x
Comments welcome ............................................... x

Chapter 1. Introduction ........................................ 1
1.1 OSA-ICC description .......................................... 2
1.2 Hardware support ............................................. 3
1.3 Software support ............................................. 4
1.4 Comparison ................................................... 5
1.5 Migration considerations ....................................... 6
  1.5.1 Migrating OSA-ICC configurations from z990 to z9-109 servers 6
  1.5.2 Migrating from IBM 2074 to OSA-ICC ...................... 7
  1.5.3 Migrating from IBM 3174 to OSA-ICC ...................... 8

Chapter 2. Pre-install ........................................... 11
2.1 Planning overview ........................................... 12
2.2 Configuration steps .......................................... 15
  2.2.1 HCD and IOPC planning .................................. 17
  2.2.2 OSA-ICC planning ....................................... 21
  2.2.3 Network considerations .................................. 33
  2.2.4 TN3270E emulator planning ............................... 35

Chapter 3. Configuration tasks ................................. 39
3.1 Configuration tasks overview ................................. 40
3.2 OSA-ICC quick start .......................................... 41
3.3 OSA-ICC working example .................................... 43
3.4 OSA-Express feature configuration panels .................. 46
  3.4.1 OSA-Express configuration steps for OSA-ICC .............. 47
  3.4.2 OSA-Express Advanced Facilities for OSA-ICC .......... 47
  3.4.3 OSA-ICC server configuration .......................... 50
  3.4.4 OSA-ICC sessions configuration ........................ 52
  3.4.5 OSA-ICC configuration validation ....................... 55
  3.4.6 OSA-ICC configuration source file export, edit, import, and validate 57
  3.4.7 OSA-ICC configuration activation ....................... 61

Chapter 4. Verifying the configuration ......................... 63
4.1 Verification overview ......................................... 64
4.2 TN3270E emulator status .................................... 64
  4.2.1 Session window status .................................. 64
  4.2.2 Display PCOMM host connection log ...................... 66
4.3 OSA-ICC status .............................................. 66
  4.3.1 Display active server configuration ...................... 67
  4.3.2 Display active sessions configuration .................... 68
  4.3.3 Display client connections ............................... 69
  4.3.4 View port parameters .................................... 71
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
## Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

<table>
<thead>
<tr>
<th>Term</th>
<th>Term</th>
<th>Term</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>AF/REMOTE®</td>
<td>Redbooks (logo)™</td>
<td>Wave®</td>
<td></td>
</tr>
<tr>
<td>CICS®</td>
<td>Resource Link™</td>
<td>z9™</td>
<td></td>
</tr>
<tr>
<td>ESCON®</td>
<td>S/390®</td>
<td>z/OS®</td>
<td></td>
</tr>
<tr>
<td>IBM®</td>
<td>System z9™</td>
<td>z/VM®</td>
<td></td>
</tr>
<tr>
<td>IMS™</td>
<td>Tivoli®</td>
<td>z/VSE™</td>
<td></td>
</tr>
<tr>
<td>MVS™</td>
<td>VSE/ESA™</td>
<td>zSeries®</td>
<td></td>
</tr>
<tr>
<td>Redbooks™</td>
<td>VTAM®</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following terms are trademarks of other companies:

Microsoft, Windows NT, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

MCS, Intel logo, Intel Inside logo, and Intel Centrino logo are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
Preface

This IBM® Redbook discusses how to plan, implement, and configure the Open Systems Adapter-Express Integrated Console Controller (OSA-ICC) function. The OSA-ICC function is supported on OSA-Express2 and OSA-Express 1000BASE-T Ethernet features for System z9™, zSeries® 990, and zSeries 890 servers.

The book focuses on the hardware configuration and software definitions needed to provide connectivity from the operating system to the TN3270E client emulator program. It also provides information for planning purposes and system setup. Helpful utilities and commands for monitoring and managing the OSA-ICC environment are also included.

This redbook is intended for system engineers, network administrators, and system programmers who will plan and install OSA-ICC. A solid background in OSA-Express, HCD or IOCP, and TCP/IP is assumed.

The team that wrote this redbook

This book was produced by a team of specialists from around the world working at the International Technical Support Organization, Poughkeepsie Center.

Bill White is a Project Leader and Senior Networking Specialist at the International Technical Support Organization, Poughkeepsie Center.

Jeff Nesbitt is a zSeries Systems Services Representative with IBM Australia. He has 22 years of field experience in zSeries and S/390® servers, Wave® Division Multiplexing products, and Enterprise networking products. He also provides professional services and training to zSeries customers.

Thanks to the following people for their contributions to this project:

Connie Beuselinck
zSeries Product Planning, IBM Poughkeepsie

Allan Bishop
zSeries Product Engineering, IBM Poughkeepsie

Roy Costa
International Technical Support Organization, Poughkeepsie Center

Robert Haimowitz
International Technical Support Organization, Poughkeepsie Center

Michael Keyes
IOS Software Service, IBM Poughkeepsie

Hubert Kordmann
zSeries Support Center, IBM Germany

Frederick Wong
zSeries Product Engineering, IBM Poughkeepsie
Become a published author

Join us for a two- to six-week residency program! Help write an IBM Redbook dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You’ll team with IBM technical professionals, Business Partners, and/or customers.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you’ll develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at: ibm.com/redbooks/residencies.html

Comments welcome

Your comments are important to us!

We want our Redbooks™ to be as helpful as possible. Send us your comments about this or other Redbooks in one of the following ways:

► Use the online Contact us review redbook form found at:
  ibm.com/redbooks

► Send your comments in an e-mail to:
  redbook@us.ibm.com

► Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. HYJ Mail Station P099
  2455 South Road
  Poughkeepsie, NY 12601-5400
Introduction

The Open Systems Adapter-Express Integrated Console Controller (OSA-ICC) function supports TN3270 enhancements (TN3270E) and non-SNA DFT 3270 emulation. This emulation support for console session connections is integrated in the z9-109, z990, and z890 servers. It can help reduce cost and complexity by eliminating the requirement for external console controllers, such as the IBM 2074 and IBM 3174.

This chapter contains:

- A description of the OSA-ICC
- Minimum hardware support
- Minimum software support
- Comparison with the IBM 2074 and HMC Integrated Console
- Migration considerations
1.1 OSA-ICC description

The OSA-Express Integrated Console Controller (OSA-ICC) support is a no-charge function included in Licensed Internal Code (LIC) on z9-109, z990, and z890 servers. It is available via the OSA-Express2 and OSA-Express 1000BASE-T Ethernet features, and supports Ethernet-attached TN3270E consoles.

The OSA-ICC provides a system console function at IPL time and operating systems support for multiple logical partitions. Console support can be used by z/OS®, z/OS.e, z/VM®, zVSE, and TPF. The OSA-ICC also supports local non-SNA DFT 3270 and 328x printer emulation for TSO/E, CICS®, IMS™, or any other 3270 application that communicates through VTAM®.

With the OSA-Express2 and OSA-Express 1000BASE-T Ethernet features, the OSA-ICC is configured on a port-by-port basis, using Channel Path Identifier (CHPID) type OSC. Each port can support up to 120 console session connections, can be shared among logical partitions using Multiple Image Facility (MIF), and can be spanned across multiple Logical Channel Subsystems (LCSSs).

Figure 1-1 shows an example of the OSA-Express Integrated Console Controller in a single system configuration.

---

**Figure 1-1  Example of an OSA-ICC configuration**

The base support for the OSA-ICC includes:

- Local and remote session connectivity, depending on the provided security and networking environment
- Local and remote connections for configuration changes, using security features of the System z9™ and zSeries Hardware Management Console environment
- Coexistence in configurations with IBM 2074 and IBM 3174 console controllers
Benefits
The OSA-ICC provides a number of potential benefits, such as:

- **Simplicity:**
  - Leverage installed 1000BASE-T Ethernet for both console sessions and networking traffic.
  - External controllers are no longer needed.
  - ESCON® ports are not required.

- **Scalable capacity:**
  - Facilitates addition of new partitions and operations support pools.
  - Can be shared by up to 60 logical partitions across multiple Logical Channel SubSystems (LCSS) on z9-109 servers.
  - Can be shared by up to 30 logical partitions across multiple Logical Channel SubSystems (LCSS) on z990 and z890 servers.

- **Improved availability:**
  - Can enable “lights out” operation.
  - Hot plug OSA-Express2 and OSA-Express availability characteristics.
  - The OSA-Express2 and OSA-Express features are highly integrated components of the System z9 and zSeries server platforms. These features have the Reliability, Availability, and Serviceability (RAS) characteristics inherent in System z9 and zSeries.

- **Low operating cost versus external console controller:**
  - Power, cooling, cabling, and floor space.
  - No rack needed.

1.2 Hardware support

System z9 servers have base LIC support for the OSA-ICC function. The z9-109 server must have at least one OSA-Express2 or OSA-Express 1000BASE-T Ethernet feature installed. The OSA-Express 1000BASE-T Ethernet feature is only supported on z9-109 when carried forward from a z990 upgrade.

z990 and z890 servers must be at LIC Driver level 55 or later, and have at least one OSA-Express 1000BASE-T Ethernet feature installed.

The Hardware Management Console (HMC) or Support Element (SE) is used to create the configuration source file for the OSA-ICC CHPID as well as for operation and diagnosis.

The OSA-Express2 1000BASE-T Ethernet feature (FC 3366) occupies one I/O slot in the z9-109 I/O cage. The feature has two independent ports, with one CHPID associated with each port.

The OSA-Express 1000BASE-T Ethernet feature (FC 1366) occupies one I/O slot in the z9-109, z990, or z890 I/O cage. The feature has two independent ports, with one CHPID associated with each port.

Each port supports a connection to either a 1000 Mbps (1 Gbps), 100 Mbps, or 10 Mbps Ethernet LAN. The LAN must conform either to the IEEE 802.3 (ISO/IEC 8802.3) standard or the DIX V2.0, and the 1000BASE-T, 100BASE-TX, or 10BASE-T standard transmission schemes.
Each port has an RJ-45 receptacle for cabling to an Ethernet switch that is appropriate for the LAN speed. The RJ-45 receptacle is required to be attached using EIA/TIA category 5 unshielded twisted pair (UTP) cable with a maximum length of 100 meters (328 feet).

The OSA-Express2 1000BASE-T Ethernet and OSA-Express 1000BASE-T Ethernet features support auto-negotiation when attached to an Ethernet hub, router, or switch. If you allow the LAN speed and duplex mode to default to auto-negotiation, the OSA-Express2 1000BASE-T Ethernet feature or OSA-Express 1000BASE-T Ethernet feature and the attached hub, router, or switch auto-negotiate the LAN speed and duplex mode settings between them. If the attached device (Ethernet hub, router, or switch) does not support auto-negotiation, the OSA-Express port will connect at the speed and duplex mode of the device at the other end of the cable.

You can choose any one of the following settings for the OSA-Express2 1000BASE-T Ethernet feature port or OSA-Express 1000BASE-T Ethernet feature port:

- Auto-negotiate
- 10 Mbps half-duplex
- 10 Mbps full-duplex
- 100 Mbps half-duplex
- 100 Mbps full-duplex
- 1000 Mbps full-duplex

### 1.3 Software support

Software requirements to support the OSA-ICC function are listed in this section. It includes the operating system levels and PTFs when applicable, as well as TN3270E emulator program support.

Refer to the z/OS, z/VM, z/VSE™, and TPF subsets of the 2094DEVICE, 2084DEVICE, and 2086DEVICE Preventive Service Planning (PSP) buckets as required prior to implementation.

**z/OS**

- z/OS System z9 software support for OSA-ICC requires at a minimum z/OS V1R4 with the z/OS V1R4 Exploitation Support feature with PTFs. HCD requires PTF for APAR OA11513.
- z/OS zSeries 990 and 890 software support for OSA-ICC requires at a minimum z/OS V1R3 or z/OS.e V1R3 with PTF for APAR OA05738. HCD requires PTF for APARs OA03689 and OA11513. IOCP requires PTF for APAR OA06464.

**z/VM**

- z/VM System z9, zSeries 990, and zSeries 890 software support for OSA-ICC requires z/VM V5R1 or z/VM V4R4 with PTF for APAR VM63405.

**z/VSE**

- z/VSE System z9, zSeries 990, and zSeries 890 software support for OSA-ICC requires VSE/ESA™ V2R6, VSE/ESA V2R7, or z/VSE V3R1.

**TPF**

- TPF System z9, zSeries 990, and zSeries 890 software support for OSA-ICC requires TPF V4R1 or z/TPF V1R1.
TN3270E emulation
The TN3270E emulation program used in conjunction with the OSA-ICC must comply with the TN3270E (TN3270 Extensions) protocol (RFC 2355), which allows for the following functions:

- The ability to request that a connection be associated with a specific 3270 LU or pool name.
- Access the SNA Bind information. Until it receives the Bind information, the session runs at the SSCP-LU level.
- Handling of SNA positive and negative responses.
- Universal support of the 3270 ATTN and SYSREQ keys.
- Support for the emulation of the 328x class of printer.

IBM Personal Communications (PCOMM) V5.6 or later supports TN3270 Extensions used for OSA-ICC support. PCOMM is a component of the IBM Access Client Package for Multiplatforms program suite.

IBM Tivoli® AF/REMOTE® V1.0.1 or later supports TN3270 Extensions used for OSA-ICC support. However, it does not support 328x printer emulation.

1.4 Comparison

Figure 1-2 compares the OSA-Express Integrated Console Controller function with the IBM 2074-model 003 Console Support Controller and HMC Integrated Console.

<table>
<thead>
<tr>
<th></th>
<th>OSA-ICC</th>
<th>2074-003</th>
<th>HMC Integrated Console</th>
</tr>
</thead>
<tbody>
<tr>
<td>z/OS, OS/390</td>
<td>z9-109: z/OS1.4 plus Exploitation Support feature with PTFs, z990 &amp; z890: z/OS V1.3, z/OS.e V1.3, and higher.</td>
<td>All, even back to MVS/ESA.</td>
<td>No</td>
</tr>
<tr>
<td>Linux</td>
<td>No</td>
<td>No</td>
<td>Linux LPAR only, using ASCII.</td>
</tr>
<tr>
<td>z/VM, VM/ESA</td>
<td>z/VM V4.4 and higher.</td>
<td>All</td>
<td>z/VM V4.4 and higher LPAR only, using 3270.</td>
</tr>
<tr>
<td>z/VSE, VSE/ESA</td>
<td>VSE/ESA V2.6 and higher, z/VSE V3.1.</td>
<td>All</td>
<td>No</td>
</tr>
<tr>
<td>z/TPF, TPF</td>
<td>TPF 4.1, z/TPF V1.1</td>
<td>All</td>
<td>No</td>
</tr>
<tr>
<td># sessions</td>
<td>120 per port. Multiple sessions to multiple LPARs on single server. Up to 48 OSA-Express ports per z9-109, z990, and z890 server.</td>
<td>48 per ESCON, 96 maximum with two ESCONs. Multiple sessions to multiple LPARs and multiple servers.</td>
<td>HMC can simultaneously support one session each of multiple LPARs. HMC can switch a session to another HMC. HMC can control up to 100 Support Elements (SE). A SE can be controlled by up to 32 HMCs.</td>
</tr>
<tr>
<td>Spanned channel</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>User connection</td>
<td>LAN</td>
<td>LAN</td>
<td>LAN</td>
</tr>
<tr>
<td>Connect multiple servers</td>
<td>No, dedicated to server.</td>
<td>Yes, via multiple ESCON cards.</td>
<td>No, dedicated to server.</td>
</tr>
<tr>
<td>Remote access</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Remote configuration</td>
<td>Yes, via HMC.</td>
<td>No, local access only.</td>
<td>Yes, via HMC.</td>
</tr>
<tr>
<td>3270 device</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ESCON to host</td>
<td>No, OSA-Express.</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Ethernet to user</td>
<td>10/100/1000 Mbps</td>
<td>10/100/1000 Mbps</td>
<td>10/100 Mbps</td>
</tr>
<tr>
<td>Token-Ring</td>
<td>No</td>
<td>4/16 Mbps</td>
<td>4/16 Mbps</td>
</tr>
<tr>
<td>S/390 GB/GE</td>
<td>No</td>
<td>Yes</td>
<td>Yes, driver 26: ECF99918.</td>
</tr>
<tr>
<td>z900/z800</td>
<td>No</td>
<td>Yes</td>
<td>Yes, driver 3G: EC J11219.</td>
</tr>
<tr>
<td>z990/z890</td>
<td>Yes, driver 55</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>z9-109</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Figure 1-2  OSA-ICC comparison with 2074 and HMC Integrated Console*
1.5 Migration considerations

Operating system console and local non-SNA DFT 3270 terminals have traditionally been supported by IBM 2074 and 3174 control units. Beginning with z890 and z990 servers, OSA-ICC supersedes these control unit types.

Existing z990 (and later) server configurations implemented with IBM 2074 and 3174 can migrate to OSA-ICC, taking advantage of the enhanced functionality, flexibility, and cost savings of OSA-ICC.

OSA-ICC can coexist with IBM 2074 and 3174 in a System z9 and zSeries server configuration. A client workstation may have some TN3270E sessions connecting via OSA-ICC, and other sessions connecting via IBM 2074, at the same time.

If your current configuration uses IBM 2074 or 3174 for “primary” and “alternate” operating system console control units, you may choose to migrate to an OSA-ICC environment in a staged process. There are many possible configuration options when planning your migration strategy. One migration strategy may be to:

1. Maintain the existing “primary” operating system console controls units (IBM 2074 or 3174).
2. Initially implement the OSA-ICC CHPID function to replace the “alternate” operating system console control units.
3. When you are comfortable with the OSA-ICC function in your environment, swap the OSA-ICC role to “primary” operating system console support.
4. Use existing IBM 2074 or 3174 control units for “alternate” operating system console support.
5. Eventually replace the “alternate” IBM 2074 or 3174 control units with a second OSA-ICC CHPID implementation.

The following sections describe some key considerations when planning to migrate operating system console and local non-SNA DFT 3270 sessions from IBM 2074 and 3174 to an OSA-ICC environment, as well as migrating an OSA-ICC configuration from a z990 to z9-109 server.

1.5.1 Migrating OSA-ICC configurations from z990 to z9-109 servers

There are some special considerations in handling an OSA-ICC configuration when upgrading from a z990 server to a z9-109 server. These considerations are especially important when multiple OSA-ICC PCHIDs are involved.

Each OSA-ICC PCHID (defined as CHPID type OSC) has an OSA-ICC configuration file associated with it. The server upgrade process provides a mechanism to move the OSA-ICC configuration file from the “original” z990 server OSA-ICC PCHID number to the “new” z9-109 server OSA-ICC PCHID number. This process is performed by your IBM Service Representative as part of the server physical upgrade.

When upgrading from a z990 to a z9-109 server, the “original” z990 server OSA-ICC PCHID number may not be the same as the “new” z9-109 server OSA-ICC PCHID number. The IBM eConfig server configuration build process handles a server upgrade to z9-109 the same way as it handles a new-build z9-109 server. That is, PCHID numbers are allocated to the various channel card features in a specific sequence following a defined set of algorithms. In most cases the “original” PCHID number and the “new” PCHID number will be the same, but this cannot be guaranteed. Especially if new channel features are being added as part of the upgrade process.
The eConfig server configuration build process generates a number of reports, including the CFReport, which contains all the hardware features and their PCHID numbers ordered in the new server configuration. If the “new” z9-109 server OSA-ICC PCHID number (allocated in the CFReport) does not match your intended usage of that OSA-ICC port, you can work with your IBM Service Representative to change which OSA-ICC configuration files are migrated to which OSA-ICC PCHIDs as part of the server physical upgrade.

The server upgrade process is designed to migrate the configuration files for all configurable channel features as part of the physical upgrade of the server. As an added level of assurance, you should save copies of your configuration files prior to any upgrade work.

**Note:** As part of normal operational practice, we highly recommend that you export your configuration source files for the OSA-ICC PCHIDs and store them for safe keeping.

### 1.5.2 Migrating from IBM 2074 to OSA-ICC

There are a number of considerations when migrating operating system console and local non-SNA DFT 3270 sessions from an IBM 2074 to an OSA-ICC environment. This section compares some of the significant characteristics of OSA-ICC and IBM 2074 to be considered when planning the migration process. See Figure 2-4 on page 14 for an example OSA-ICC configuration in a mixed environment.

These characteristics are:

- **IBM 2074** attaches to System z9, zSeries, and IBM 9672 servers via one or two ESCON channel interfaces. Each ESCON channel interface may be directly connected to the server channel or via a single ESCON Director or two cascaded ESCON Directors. ESCON channels cannot be spanned; therefore, IBM 2074 does not support attaching to multiple logical channel subsystems via one ESCON channel.

  The OSA-ICC CHPID (channel type OSC) is implemented in the OSA-Express2 and OSA-Express 1000BASE-T feature hardware. OSA-ICC channels can be spanned to multiple logical partitions across multiple LCSSs defined in the System z9 or zSeries server.

- **IBM 2074** emulate[s] multiple, channel attached non-SNA IBM 3174 Enterprise Cluster Controllers. The multiple emulated 3174 Control Units may be defined to multiple logical partitions. If the IBM 2074 is channel attached via an ESCON Director, the multiple emulated 3174 control units may be extended to multiple servers.

  The OSA-ICC CHPID supports one OSC Control Unit, which may be defined to multiple logical partitions in multiple LCSSs on one System z9 or zSeries server.

- **IBM 2074** has two Ethernet and two token-ring LAN adapters. Each LAN adapter can send and receive traffic to either IBM 2074 ESCON channel interface. When implementing two or more LAN interfaces, each interface must have a unique IP address in different subnetworks.

  When multiple OSA-ICC ports are configured in an Ethernet LAN, each OSA-ICC port on the System z9 or zSeries servers requires a unique host IP address. The OSA-ICC host IP addresses may be within the same subnetwork, or in different subnetworks in the case of using VLANs or dedicated switches.

OSA-ICC and IBM 2074 handle channel control words (CCWs) in the same way:

- The device data sent by a CCW must contain a set buffer address (SBA) order. A program cannot depend on the SBA address being carried over from a previous CCW in the channel program. A Write CCW that does not send an SBA order will write to unpredictable addresses in the 3270 session buffer.
Data transferred by a Read Buffer, Read Modified, or Read Modified All CCW begins at the beginning of the 3270 session buffer, not at the point where a previous channel CCW stopped reading. However, a read CCW chained from a Write, Erase Write, or Erase Write Alternate CCW will begin at the address where the Write finished.

A Keyboard Unlock WCC takes effect immediately with OSA-ICC and IBM 2074; with IBM 3174, it takes effect at the end of the channel program. OSA-ICC and IBM 2074 have no concept of command chaining; the keyboard may unlock before the last CCW of the chain has been sent to the client emulator session.

1.5.3 Migrating from IBM 3174 to OSA-ICC

There are a number of considerations when migrating operating system and local non-SNA DFT 3270 sessions from an IBM 3174 Enterprise Cluster Controller to an OSA-ICC environment. This section compares some of the significant characteristics of OSA-ICC and IBM 3174 to be considered when planning the migration process.

These characteristics are:

- IBM 3270 console connectivity has traditionally been provided by parallel (or less frequently, ESCON) channel attached, local non-SNA 3174 Enterprise Cluster Controllers, with at least one, more usually two, channel attached local IBM 3174s per logical partition. The zSeries z900 is the last family of servers to support parallel channels. z9-109, z990, and z890 servers do not support parallel channels; therefore, IBM 3174 control units with parallel channel interfaces must attach to these servers via an ESCON Converter (IBM 9034 or Optica 34600) and ESCON channel type CVC. ESCON channels cannot be spanned; therefore, an IBM 3174 does not support attaching to multiple logical channel subsystems within the System z9 or zSeries server.

- The OSA-ICC channel is implemented in the OSA-Express2 and OSA-Express 1000BASE-T feature hardware. OSA-ICC channels can be spanned to multiple logical partitions across multiple LCSSs defined in the System z9 or zSeries server.

- IBM 3174 supports both coaxial and LAN-attached, SNA and non-SNA, CUT (Control Unit Terminal) and DFT (Distributed Function Terminal) mode terminals. It does not support TCP/IP attached client sessions. When configured in non-SNA, DFT mode, the IBM 3174's maximum 32 coaxial cable attached devices must all be defined to a single logical partition in one System z9, zSeries, or IBM 9672 server.

- OSA-ICC (and IBM 2074) support LAN-attached local non-SNA DFT 3270 sessions only. OSA-ICC (and IBM 2074) do not support CUT terminal sessions. Each one of the maximum 120 OSA-ICC sessions may be defined to one logical partition in any LCSS on the System z9 or zSeries server. This is theoretically equivalent to 120 local non-SNA 3174 “screen controllers,” each with a single 3270 coax attached terminal.

- OSA-ICC (and IBM 2074) handles some Channel Control Words (CCWs) differently to IBM 3174. These differences are partly due to OSA-ICC mapping the CCW data stream into TN3270E protocol, which does not support all aspects of IBM 3270 data stream protocol. In particular, TN3270E does not support command chaining, so CCWs may be processed differently. IBM has tested the OSA-ICC function with System z9 and zSeries operating systems. However, specific customer applications may be impacted if they rely on these CCW features:
  - Read Configuration Data
    The OSA-ICC control unit type reported by Read Configuration Data (CCW Hex ‘72’) returns 2074 instead of 3174. Sense ID (CCW Hex ‘E4’) returns 3174 for compatibility.
Command-Chained Write (CCW Hex ‘01’) commands
IBM 3270 data stream architecture recommends that Write CCWs begin with a Set Buffer Address (SBA) order, rather than rely on a chained Write to begin at the buffer location where the preceding command left off. With OSA-ICC (and IBM 2074), beginning a Write CCW with an SBA is a requirement. The device data sent by a CCW must contain an SBA order. A program cannot depend on the SBA address being carried over from a previous CCW in the channel program. A write CCW that does not send an SBA order will write to unpredictable addresses in the 3270 session buffer.

Command Chained Read CCWs
Data transferred by a Read CCW chained from a Write, Erase Write, or Erase Write Alternate CCW begins at the buffer address where the Write finished. This is the same in both OSA-ICC and IBM 3174. Read CCWs chained from a Read Buffer, Read Modified, or Read Modified All CCW are not supported by the OSA-ICC.

Select commands treated as no-ops.
IBM 3174 enforces various rules for chaining commands from Select CCWs. Violating these rules may result in a unit check on the IBM 3174. The OSA-ICC (and IBM 2074) treats these CCWs as no-ops, and violating the IBM 3174 rules on chaining (for example, chaining a Write from a Select Read CCW) will not result in a unit check on an OSA-ICC (or IBM 2074).

A Keyboard Unlock WCC takes effect immediately with OSA-ICC (and IBM 2074); with IBM 3174, it takes effect at the end of the channel program. OSA-ICC (and IBM 2074) has no concept of command chaining; the keyboard may unlock before the last CCW of the chain has been sent to the client emulator session.
Pre-install

This chapter contains the following topics:

- Planning overview
- HCD and IOCP planning
- OSA-ICC planning
- Network considerations
- TN3270E emulator planning
2.1 Planning overview

Planning for a System z9 or zSeries OSA-ICC implementation requires input from a number of disciplines within your organization. This chapter describes planning for the five OSA-ICC implementation steps:

1. Operating system configuration
2. System z9 and zSeries I/O subsystem configuration
3. OSA-Express feature configuration
4. Ethernet LAN configuration
5. Client TN3270E configuration

Planning for each of the configuration steps is described, referring to a simple example configuration and our working example configuration running in a production environment (see “Configuration steps” on page 15).

**Note:** If you are already familiar with the OSA-ICC configuration process, “OSA-ICC quick start” on page 41 will be useful as a quick reminder checklist.

There are as many different OSA-ICC implementation configurations possible as there are datacenter systems installed. Your OSA-ICC implementation plan will depend on the unique characteristics of your datacenter environment; for example, whether you are planning for a new system installation or for an OSA-ICC implementation in an existing configuration already utilizing IBM 2074 and 3174.

The following high-level configuration examples show some possible ways of implementing your OSA-ICC. For simplicity, the examples depict the TN3270E emulator workstations as being locally attached to the Ethernet LAN environment. They could just as well be remotely connected through an enterprise IP network.

**OSA-ICC basic configuration**

Figure 2-1 shows an example of a basic OSA-ICC hardware configuration.
The basic configuration has hardware redundancy for:

- OSA-Express2 and OSA-Express 1000BASE-T features.
- OSA-ICC ports.
- LAN subnetworks. You may also provide LAN connectivity between the two subnetworks for additional network and TN3270E sessions redundancy.
- Client workstations.

**OSA-ICC multiple LCSS configuration**

Figure 2-2 shows an example of an OSA-ICC configuration with multiple LCSSs.

Logical partitions 1, 2, and 3 are shown with no alternate TN3270E sessions defined. We recommend defining alternate TN3270E sessions via different OSA-ICC ports to maximize redundancy.

**OSA-ICC multiple server configuration**

Figure 2-3 on page 14 shows an example of an OSA-ICC configuration with multiple servers and multiple LCSSs.
We recommend providing LAN connectivity between the subnetworks for additional network and TN3270E session redundancy.

**OSA-ICC mixed environment configuration**

Figure 2-4 shows an example of an OSA-ICC configuration with multiple servers and multiple LCSSs coexisting with IBM 2074. OSA-ICC can coexist with IBM 2074 and 3174.
A client workstation may have some TN3270E sessions connecting via OSA-ICC, and other sessions connecting via IBM 2074, at the same time.

See “Migration considerations” on page 6 for more information on implementing OSA-ICC in a mixed environment.

2.2 Configuration steps

This section describes planning for the five configuration steps that are required to implement the OSA-ICC function. These steps are shown in Figure 2-5, using a simple example of one workstation connected to an OSA-Express PCHID, installed on a zSeries server running three logical partitions.

Note: This example is used purely to demonstrate the steps involved. We do not recommend implementing an OSA-ICC configuration with single points-of-failure, such as a single OSA-ICC PCHID connection, or single workstation.

Figure 2-5 OSA-ICC configuration steps

Note: Throughout this section, Multiple Image Facility Identifier (MIFID) and Image Identifier (IID) are equivalent terms.
The five configuration steps required to implement the OSA-ICC function are:

1. Operating system configuration:
   - z/OS operating system support for NIP (Nucleus Initialization Program) consoles is defined using HCD. NIP consoles receive initial z/OS IPL and response messages. There are no unique considerations in HCD when defining NIP consoles that will attach via an OSA-ICC. They are defined in the same way as consoles attached via IBM 2074 or 3174. See B.2.1, “NIP console definitions” on page 109 for our example configuration.
   - z/OS operating system support for MCS® (Multiple Console Support) consoles is defined in the CONSOLEXX member of the SYS1.PARMLIB dataset. Each MCS console has a number of attributes, such as authority to issue different types of commands, routing codes, and message level, to determine the types of message traffic displayed at the console, message roll time, and so on. There are no unique considerations when defining the CONSOLEXX member for MSC consoles that will attach via an OSA-ICC. They are defined in the same way as consoles attached via IBM 2074 or 3174. See B.2.2, “MCS console definitions” on page 110 for our example configuration.
   - z/OS VTAM support for local non-SNA DFT 3270 terminals and 328x printers is defined in the local non-SNA major node (MAJNODE) members of the SYS1.VTAMLST dataset. Exploiters of local non-SNA DFT 3270 terminal and 328x printer sessions include TSO/E, CICS, and IMS. There are no unique considerations when defining major nodes for local non-SNA DFT 3270 sessions and 328x sessions that will attach via an OSA-ICC. They are defined in the same way as local non-SNA DFT 3270 sessions and 328x sessions attached via IBM 2074, or terminals and printers attached via IBM 3174. See D.1, “VTAM definitions for z/OS” on page 118 for our example configuration.
   - z/VM operating system support for IPL consoles is defined in the system configuration (system config) file on the primary parm (maint cf1) disk. There are no unique considerations when defining major nodes for local non-SNA DFT 3270 sessions and 328x sessions that will attach via an OSA-ICC. They are defined in the same way as consoles attached via IBM 2074 or 3174.
     There are no unique considerations when defining major nodes for local non-SNA DFT 3270 sessions and 328x sessions that will attach via an OSA-ICC. They are defined in the same way as consoles attached via IBM 2074 or 3174.

     See C.1.1, “z/VM console definitions” on page 114 and “z/VM RSCS printer definitions” on page 114 for our example configuration.

2. I/O subsystem configuration:
   The OSA-ICC function requires a unique CHPID, control unit, and device definition. These definitions are made using HCD or IOCP, which defines the OSA-Express2 and OSA-Express features to the I/O hardware configuration in the Input/Output Configuration Data Set (IOCDS). The IOCDS is typically created via HCD, but could also be created from a source IOCP file. See “HCD and IOCP planning” on page 17 for planning considerations.

3. OSA-Express feature configuration:
   The OSA-ICC function of the OSA-Express2 and OSA-Express features is configured using the HMC or SE Advanced Facilities task. Before the OSA-ICC configuration process can be invoked, the System z9 and zSeries servers must have the required OSA-Express CHPIDs defined as type OSC. See “OSA-ICC planning” on page 21 for planning considerations.
4. Ethernet LAN configuration:

The Ethernet LAN supports connectivity from the client workstation to an OSA-Express2 or OSA-Express PCHID port. This LAN is typically segmented from the rest of the corporate intranet by the use of VLANs or dedicated switches.

**Note:** OSA-ICC does not support a Dynamic Host Configuration Protocol (DHCP) LAN environment. All OSA-ICC servers and client workstations must have static IP addresses.

See “Network considerations” on page 33 for planning considerations.

5. Client TN3270E configuration:

The workstation TN3270E (TN3270 Enhancements) session is configured using the emulator program session configuration task; for example, Personal Communications (PCOMM) V5.6 for Windows® (or later), or IBM Tivoli AF/REMOTE V1.0.0.106 (or later). See “TN3270E emulator planning” on page 35 for planning considerations.

See “PCOMM TN3270E emulator configuration panels” on page 122, and “AF/REMOTE TN3270E emulator configuration panels” on page 133 for our example configuration.

The following sections describe planning for the unique requirements in implementing the OSA-ICC function.

### 2.2.1 HCD and IOCP planning

The OSA-ICC function requires a unique CHPID, control unit, and device definition. These definitions are made using HCD or IOCP, which defines the OSA-Express feature to the I/O hardware configuration. OSA-ICC CHPIDs, control units, and devices are defined to the configuration using existing I/O constructs. There are no new statements or keywords needed to define the OSA-ICC function.

HCD and IOCP support for the OSA-ICC function is built with the multiple logical channel subsystem (LCSS) format IOCDS and the ICPIOCP program. No support is added to the previous IOCP (IYPIOCP and IZPIOCP) programs. The ICPIOCP program generates a format 8 IOCDS.

Starting with the zSeries 990 (IBM 2084) family of servers, Basic Mode IOCDS is no longer supported. Therefore, the ICPIOCP program only supports LPAR Mode.

There are four different channel types for OSA-Express CHPIDs. An OSA-Express channel may be defined as a channel type OSD, OSE, OSC, or OSN. The OSA-ICC function requires the OSA-Express channel type OSC.

The example configuration in Figure 2-5 on page 15 has the IOCDS definition statements shown in Example 2-1 to define the OSA-Express feature to the I/O hardware configuration.

**Example 2-1 Example IOCDS definitions**

```plaintext
ID    MSG1='IODF14',    *
      MSG2='SYS6.IODF14.WORK - 2005-07-10 11:03',    *
      SYSTEM=(2084,1),    *
      TOK=('SCZP901',008000190400084155953790104108C00000000, *
            00000000,'05-07-10','11:03:22','        ','        ')    *

      RESOURCE PARTITION=((CSS(1),(A11,1),(A12,2),(A1C,C))),    *
          MAXDEV=((CSS(1),64512))    *
```
HCD and IOCP rules and recommendations

HCD Dynamic I/O configuration changes are supported for CHPID type OSC and attached control units and display devices. This allows definition of the OSA-ICC function for display devices without requiring a power-on-reset (POR) of the System z9 or zSeries server, or an IPL of the z/OS operating systems.

Note: The 3287 printer Unit Information Module (UIM) does not support dynamic activation via HCD.

Defining new 3287 device definitions to any supporting control unit type, including OSC control units, requires a server POR before the new 3287 device definitions can be used.

Changing existing 3287 device definitions to any supporting control unit type (including OSC control units), or any supporting CHPID type (including OSC CHPIDs) that provides new access to logical partitions, requires a re-IPL of the affected logical partitions before the changed 3287 device definitions can be used.

Referring to the IOCDS definitions in Example 2-1 on page 17, HCD and IOCP support for the OSA-ICC function have the following attributes.

ID statement
There are no additions or changes to the ID statement to support OSC CHPIDs.

RESOURCE statement
The RESOURCE statement defines the logical partitions and the logical channel subsystems (LCSS) in the System z9 or zSeries server configuration. It assigns an MIF image ID to each logical partition and the maximum number of devices that can be defined to the LCSS.

There are no additions or changes to the RESOURCE statement to support OSC CHPIDs.

CHPID statement
- HCD and IOCP provide support for the OSA-ICC function with the CHPID type OSC.
- The OSC channel can fully participate in a multiple LCSS environment. It can be spanned by all LCSSs, and up to 60 logical partitions in a System z9 server configuration, and up to 30 logical partitions in a zSeries server configuration.
- CHPID values come from the common pool of Hex '00' to 'FF' for each LCSS.
- OSC CHPIDs may be defined on any CHPID number.
- IOCP will allow OSC CHPIDs to be defined as dedicated (DED), reconfigurable (REC), shared (SHARED), or spanned across multiple LCSSs.
- A PCHID keyword with a valid value (for an OSA-Express2 or OSA-Express 1000BASE-T feature) must be specified for an OSC CHPID. IOCP will issue an error message for an IOCDS creation and a warning message on an input verification if the PCHID keyword is not specified.
HCD and IOCP check to ensure that no more than a maximum of 48 OSA-Express ports (any combination of OSD, OSE, OSC, and OSN channel types) are defined for the z9-109 (IBM 2094) or z990 (IBM 2084). A caution message is issued if this is exceeded.

HCD and IOCP check to ensure that no more than a maximum of 40 OSA-Express ports (any combination of OSD, OSE, OSC, and OSN channel types) are defined for the z890 (IBM 2086). A caution message is issued if this is exceeded.

The CHPARM keyword is not applicable to an OSC CHPID. If specified with a value other than '00', IOCP will issue an error message.

The SWITCH, CPATH, and IOCLUSTER keywords are not allowed on an OSC CHPID definition. IOCP will issue an error message if defined.

For HCD and Stand Alone IOCP, when generating IOCP input statements, do not define the CHPARM, IOCLUSTER, SWITCH, or CPATH keywords for an OSC CHPID.

**CNTLUNIT statement**

- OSC Control Unit numbers come from the common pool of Hex '0000' to 'FFFE'.
- The OSC CHPID supports a maximum of one OSC Control Unit and 254 devices. IOCP will terminate with an error message if the same OSC channel is used for more than one control unit definition.
- Only one OSC channel path from an LCSS may be defined to a Control Unit. If the path is spanned across LCSSs, only one CNTLUNIT statement is allowed, but it may specify the spanned path for each LCSS. That is, you may have four unique paths from four different LCSSs to one Control Unit (via the one spanned OSC channel), but no more than one path per LCSS. IOCP will terminate with an error message if this rule is violated.
- HCD and IOCP allow for 254 devices to be defined per OSC Control Unit. These 254 devices are available to each logical partition to which the OSC Control Unit's channel is defined. In Example 2-1 on page 17, the OSC channel is defined to three logical partitions, providing 762 subchannels (254 devices multiplied by three logical partitions).

However, you can only define (using the HMC or SE Advanced Facilities function) up to 120 sessions on the OSC CHPID (OSA-Express feature port). Each session requires one valid subchannel.

- The HCD default unit address range for the 254 devices is Hex '00' to 'FD'. Devices with unit addresses of Hex 'FE' and 'FF' are not allowed. IOCP will ignore the UNITADD keyword on an OSC Control Unit. If one is specified, IOCP will issue a warning message. IOCP always defaults the unit address range to Hex '00' to 'FD'.
- IOCP does not allow an OSC Control Unit to be managed by DCM. A PATH value of '*' will cause IOCP to terminate with an error message.
- HCD requires a Control Unit type of OSC. IOCP does not validate the UNIT keyword value except for good syntax. We recommend defining a UNIT type of OSC in IOCP.
- The SHARED keyword is ignored for OSC Control Units, and the default is N. OSC Control Units are Type 2 Control Units. IOCP will issue a warning message if the SHARED keyword is specified.
- The PROTOCL keyword is ignored for OSC Control Units. IOCP will issue a warning message if specified.
- The LINK keyword is not allowed for OSC Control Units. IOCP will issue an error message and terminate if specified. Even though the LINK keyword is not allowed, IOCP defines a link address value of Hex '000D' in the IOCDS for the OSC Physical Control Unit (PCU) and Control Unit Header (CUH) records. This destination link address is displayed using the display matrix device command (see Example 4-3 on page 76).
The CUADD keyword is not allowed for OSC control units. IOCP will issue an error message and terminate if specified.

For HCD and StandAlone IOCP, when generating IOCP input statements, do not define the UNITADD, SHARED, PROTOCL, CUADD, or LINK keywords for an OSC Control Unit.

**IODEVICE statement**

- Device numbers for display sessions can come from the common pool of Hex '0000' to 'FFFF'. Device numbers can be duplicated in each logical partition and across LCSSs (for example, similar to the way MCS consoles can be defined).

- Device numbers for printer sessions, for example a z/OS MCS output-only console or VTAM 3287 printer LU, must be in the range specified by the 3287 Unit Information Module (UIM). The supported range is Hex'0000' to '0FFF'. Device numbers can be duplicated in each logical partition and across LCSSs.

- The same device number can be used more than once if the OSA-ICC CHPID is defined to be shared among your logical partitions (indicated by the LCSS ID and MIFID (IID) values). This may be useful if you are using a single CONSOLEXX member across logical partitions, hence requiring the use of the same device numbers.

- HCD requires a device type of 3270 for display sessions. IOCP does not validate the UNIT keyword value except for good syntax. We recommend defining a device type of 3270 for display sessions, in IOCP.

- HCD requires a device model type of X for 3270 display sessions. IOCP does not validate the MODEL keyword value except for good syntax. We recommend defining a device model type of X for display sessions, in IOCP.

- HCD requires a device type of 3287 for printer sessions (for example, a z/OS MCS output-only console or VTAM 3287 printer LU). IOCP does not validate the UNIT keyword value except for good syntax. We recommend defining a device type of 3287 for printer sessions, in IOCP.

- HCD requires a Device Model type of 1, 1C, 2, or 2C for 3287 printer sessions. IOCP does not validate the MODEL keyword value except for good syntax. We recommend defining a Device Model type of 1 for printer sessions, in HCD and IOCP.

- The UNITADD keyword is not required for OSC devices. We recommend not defining the UNITADD keyword.

- A device with a unit address of Hex 'FE' or 'FF' is not allowed because IOCP defaults the Control Unit address range to Hex '00' to 'FD'. If a device is defined with a unit address of Hex 'FE' or 'FF', IOCP will terminate with an error message.

- Device candidate lists may be specified for OSC devices.

- HCD and IOCP allow for 254 devices to be defined per OSC Control Unit. These 254 devices are available to each logical partition to which the OSC Control Unit's channel is
defined. In Example 2-1 on page 17, the OSC channel is defined to three logical partitions, providing 762 subchannels (254 devices multiplied by three logical partitions). However, you can only define (using the HMC or SE Advanced Facilities function) up to 120 sessions on the OSC CHPID (OSA-Express feature port). Each session requires one valid subchannel. We recommend defining 120 devices in the ADDRESS keyword.

- Devices on an OSC CHPID may only be defined to a single OSC Control Unit. IOCP will terminate with an error if multiple Control Units are defined for an OSC Device.
- Illegal Status Detection (STADET) is not supported. IOCP will issue a warning message if specified.
- The PATH keyword is ignored for OSC devices because only one path is allowed per Device. IOCP will issue a warning message if specified.
- The TIMEOUT keyword is ignored for OSC devices because timeout does not apply for OSC Devices. IOCP will issue a warning message if specified.
- For HCD and StandAlone IOCP, when generating IOCP input statements, do not define the TIMEOUT, PATH, or STADET keywords for an OSC Device.

See “HCD and IOCP definitions” on page 102 for the HCD definition panels, and the IOCP input statements, used in our OSA-ICC working example.

**IOCP message definitions**
Throughout this section, IOCP messages are referred to as informational, warning, or error. The meaning of IOCP messages are:

- **Informational**
  - IOCP completes with a return code of 0 and generates an IOCDS.
  - HCD may allow definitions that cause IOCP informational messages.

- **Caution**
  - IOCP completes with a return code of 2 and generates an IOCDS.
  - HCD may allow definitions that cause IOCP caution messages.

- **Warning**
  - IOCP completes with a return code of 4 and generates an IOCDS.
  - HCD does not allow definitions that cause IOCP warning messages.

- **Error**
  - IOCP returns a return code of 8. No IOCDS is generated.
  - HCD does not allow definitions that cause IOCP error messages.

For further information about defining the OSA-ICC function, see *Input/Output Configuration Program User’s Guide for ICP IOCP*, SB10-7037, available on Resource Link™:


### 2.2.2 OSA-ICC planning

Configuring the OSA-ICC PCHID, using the HMC or SE Advanced Facilities function, results in the creation of an OSA-ICC configuration source file. There is one OSA-ICC configuration source file for each defined OSA-ICC PCHID.
An OSA-ICC PCHID configuration source file is built by entering OSA-ICC server and sessions data via the Advanced Facilities panels, by manually editing the configuration source file using a text editor program, or both.

Manual editing is much faster for multiple session data entries because of the editing capabilities of most workstation text editors. There is a text editor available via the HMC or SE Advanced Facilities function, or you can export the configuration source file to a diskette, edit it with the text editor of your choice, and import it back into the Advanced Facilities function.

**Note:** System z9 also provides the facility to import and export the OSA-ICC configuration source file via FTP to an external FTP server.

After the configuration source file is built or imported, it must then be validated and activated for the specific OSA-ICC PCHID.

**Note:** We highly recommend that, after your configuration source file is validated and activated for the OSA-ICC PCHID, you export the configuration source file and store it for safe keeping.

### Session connection rules and recommendations

Referring to the simple example in Figure 2-5 on page 15, configuring the OSA-ICC PCHID configuration source file requires understanding the OSA-ICC session connection rules and session definition options.

The OSA-Express PCHID port, defined as an OSA-ICC CHPID, has an OSA-ICC server function implemented in microcode running within the OSA-Express feature hardware.

When a workstation TN3270E client session is connecting to the OSA-ICC server, the TN3270E client session is allocated to a session index number, based on what is defined in the sessions index table in the OSA-ICC PCHID’s configuration source file. If the TN3270E client does not meet the sessions connection criteria, or all defined sessions in the OSA-ICC sessions index table are in use, that client’s connection is refused.

Session connection rules deal with the set of criteria used to determine whether a TN3270E client emulator can connect a session to the OSA-ICC server. The connection criteria are based on:

- Session parameters defined in the session index table.
  These include the client workstation’s IP address and the TN3270E client session LU name (or pool name). A connecting TN3270E client session must have defined parameters matching the parameters of at least one session index number.

- How the OSA-ICC server will assign a client session to a session index number:
  - A connecting client session has a specified LU name. The first available session index with that LU name will be considered. Furthermore, if that session index has the client workstation IP address specified, then the client workstation IP address of the connecting client session must also match.

Therefore, if a session index is defined with a unique LU name in the OSA-ICC configuration source file, then a connecting client session with matching parameters will always be allocated to that session index number and corresponding z/OS logical partition and device number.
Multiple session indexes for a given logical partition (MIFID), may be defined with similar session parameters. For example, you may define a group of sessions that have the same LU name, and no client workstation IP address, defined. This would allow a client session with a matching LU name, running on any client workstation, to connect to the OSA-ICC server. The OSA-ICC server allocates the next available session index number whose session parameters match the connecting client session, until all session indexes with matching parameters are allocated.

Unique client session LU names are not specifically required for local non-SNA DFT 3270 sessions (such as TSO/E, CICS, or IMS sessions), as VTAM will automatically respond to a client session connection by presenting the VTAM logon screen. However, we do recommend defining all session indexes with unique LU names.

**Note:** Defining session indexes with unique LU names makes session management easier because a given session will always be associated with the same logical partition and device number. This is especially important during problem determination.

We recommend using an LU naming convention that identifies the logical partition name and operating system device number associated with the session (for example, SC64E000). The LU name should be eight or fewer alphanumeric characters for compatibility with most TN3270E emulator programs.

A session index may be defined in the following ways:

- Both the client workstation’s IP address and client session LU name (recommended).
- Only the client session LU name (not recommended).
- Only the client workstation IP address (not recommended).
- Client LU name must be unique for a given logical partition (MIFID). For example, sessions connecting to different logical partitions cannot have the same LU name.

**Note:** For security and session management reasons, we strongly recommend always defining TN3270E type sessions with the client workstation’s IP address and unique LU names.
All sessions connecting to the same logical partition (MIFID) must be defined with:

- Both LU name and client's workstation IP (recommended), or
- Only the LU name (not recommended), or
- Only the client workstation IP address (not recommended)

If only the client workstation IP address (no LU names) is specified for sessions for more than one logical partition, the same IP address cannot be used for multiple logical partitions’ sessions. This session definition method is not recommended.

OSA-ICC server configuration

This section describes planning for the OSA-ICC server configuration parameters. We recommend that you use the OSA-ICC server configuration worksheet to record the server parameters for your configuration (see “Worksheet templates” on page 98).

See “Example configuration worksheets” on page 82 for the parameters used in our configuration example.

Server name

The server name is an ASCII string of up to 16 characters in length. The name appears on the top line of the workstation TN3270E session window when the client workstation TN3270E session initially connects to the OSA-ICC PCHID port (see Example 4-1 on page 64). We recommend using a meaningful description as an aid in identifying to which OSA-ICC CHPID and control unit the session is communicating. For example, in our configuration, server name OSCE000 represents the control unit number (E000) associated with the OSC channel.

In a mixed environment with OSA-ICC and IBM 2074 attached consoles, the OSA-ICC server name is equivalent to the IBM 2074 name defined in the 2074 configuration file.

Host IP address

This is the IP address allocated, by you, to this OSA-ICC PCHID port. This IP address must match the host IP address defined in the workstation TN3270E session (see Figure E-2 on page 123).

Note: OSA-ICC does not support a Dynamic Host Configuration Protocol (DHCP) LAN environment. All OSA-ICC servers and client workstations must have static IP addresses.

When multiple OSA-ICC ports are configured in an Ethernet LAN, each OSA-ICC port on the System z9 and zSeries server requires a unique host IP address. The OSA-ICC host IP addresses may be within the same subnetwork, or in different subnetworks in the case of using VLANs or dedicated Ethernet switches.

Note: We recommend the use of VLANs or dedicated switches when implementing multiple OSA-ICC ports.

TCP port

This is the TCP port number used by the OSA-ICC PCHID and workstation TN3270E session to initially establish session communications. The OSA-ICC listens to this port number for all inbound host traffic from all TN3270E sessions. The session port number defined in the workstation TN3270E session must match this OSA-ICC server port number (see Figure E-2 on page 123). The valid range is 1 to 65535.
After the initial session communication is established, the TN3270E client emulator will bind a different TCP port and socket number to the session to use for outbound host application traffic. The outbound host port and socket number, for a given session connected to the OSA-ICC server, is displayed on the Display Client Connections panel (see Figure 4-4 on page 69). Outbound host port numbers allocated by a TN3270E client emulator are typically in the short-lived port range, from 1024 through 65535 inclusive.

The TCP port number (inbound host port), defined on the Edit Server Configuration panel, can be considered a type of logon password for the session, which enables initial communications to be established between the OSA-ICC port and the workstation TN3270E session.

IBM 2074 has TCP port number default values of 3270 and 3271. You may choose to use one of these values for the OSA-ICC TCP port number for consistency within your 2074 environment. In our configuration, the OSA-ICC default value of 1024 is used. For network security reasons, you may choose to change the default port number to some other value.

It is important to note that these port numbers may have to be applied to your firewall rules, if applicable. Also, ensure that no other application or task running on the workstation operating system uses port numbers that conflict with the OSA-ICC port number.

**Default gateway and subnet mask**
The default gateway is the IP address allocated, by you, to the router that provides access beyond the LAN segment to which this OSA-ICC port is physically connected. The subnet mask will define the number of IP addresses that are available for use in the subnetwork to which this OSA-ICC port is connected.

**Frame type**
Frame type specifies the Ethernet protocol supported by the LAN network to which this OSA-ICC port is connected:

- DIX is Ethernet Version 2 protocol.
- SNAP (SubNetwork Access Protocol) is IEEE 802.3 protocol.

The OSA-ICC server Ethernet frame type must match the frame type supported by the LAN network to avoid network compatibility problems. We recommend using the DIX standard whenever possible.

**MTU Size(B)**
This is the maximum transmission unit size (in bytes) supported by the LAN to which this OSA-ICC port is connected.

*Note: For session throughput reasons, we recommend that the LAN to which the OSA-ICC port is attached supports a minimum MTU size of 576 bytes. If possible, use the maximum supported MTU size of 1492 bytes.*

The OSA-ICC MTU size value does not include the 8-byte Ethernet frame header. So for LANs supporting 1500-byte Ethernet frames, the OSA-ICC MTU size value should be set to 1492 bytes.

**OSA-ICC sessions configuration**
This section describes planning for the OSA-ICC sessions configuration parameters. We recommend that you use the OSA-ICC session configuration worksheet to record the session parameters for your configuration (see “Worksheet templates” on page 98).
See “Example configuration worksheets” on page 82 for the parameters used in our example configuration.

**CSS value**

The CSS value is the LCSS ID of the logical channel subsystem that this session index will connect to. A session index may connect to only one LCSS. The valid LCSS IDs are defined in the RESOURCE statement of the System z9 or zSeries server IOCDS (see “RESOURCE statement” on page 18).

When defining the sessions configuration via the HMC or SE Advanced Facilities function, the LCSS list will contain only LCSS IDs defined in the current I/O configuration in the HSA of the System z9 or zSeries server.

**MIFID**

Multiple Image Facility Identifier (MIFID) and Image Identifier (IID) are equivalent terms. The MIFID value is the MIF ID of the logical partition that this session index will connect to. A session index may only connect to one logical partition. The valid MIF IDs are defined in the RESOURCE statement of the System z9 or zSeries server IOCDS (see “RESOURCE statement” on page 18).

When defining the sessions configuration via the HMC or SE Advanced Facilities function, the MIFID list will only contain MIF IDs defined in the current I/O configuration in the HSA of the System z9 or zSeries server.

**Device Number**

The Device Number is the operating system device number that this session index will connect to. A session index may connect to only one device number. The valid device numbers are defined in the IODEVICE statement of the System z9 or zSeries server IOCDS (see “IODEVICE statement” on page 20).

The same Device Number can be used more than once if the OSA-ICC CHPID is defined to be shared among your logical partitions (indicated by the MIFID value). This may be useful if you are using a single CONSOLEXX member across logical partitions, hence requiring the use of the same device numbers.

When defining the sessions configuration via the HMC or SE Advanced Facilities function, the Device Number list will only contain device numbers defined to this channel path in the current I/O configuration in the HSA of the System z9 or zSeries server.

**Tip:** You can use the z/OS command (d i os,config) or the z/VM command (q token) to check the HSA I/O configuration data. For example:

```
D I O S , C O N F I G
I O S 0 0 0 1 1 6 . 4 6 . 1 6 I / O C O N F I G D A T A 9 0 7
A C T I V E I O D F D A T A S E T = S Y S 1 . I O D F 1 4
C O N F I G U R A T I O N I D = L O G R M V S 1 E D T I D = 0 1
T O K E N : P R O C E S S O R D A T E T I M E D E S C R I P T I O N
S O U R C E : S C Z P 9 0 1 0 5 - 0 7 - 1 0 1 1 : 0 3 : 2 2 S Y S 1 I O D F 1 4
```

**LU name**

The LU name (or pool name) is the TN3270E LU name of the client session that this session index will connect to. The LU name must match the LU name defined in the workstation TN3270E session (see Figure E-2 on page 123).
Defining session indexes with unique LU names makes session management easier because this ensures that a given session will always be associated with the same logical partition and device number. This is especially important during problem determination.

We recommend using an LU naming convention that identifies the logical partition name and operating system device number associated with the session (for example, SC64E000). The LU name should be eight or fewer alphanumeric characters for compatibility with most TN3270E emulator programs.

Defining the LU name for a session index is optional. However, for security and session management reasons, we strongly recommend only defining TN3270E type sessions with the client workstation's IP address, and unique LU names (see “Session connection rules and recommendations” on page 22).

Each z/OS MCS input/output console session, with the DHD option enabled, must have a unique LU name to ensure session auto-reconnection and MSC console recovery occurs correctly. See “Defer Host Disconnect (DHD)” on page 28.

**Client’s IP address**
The client’s IP address is the IP address allocated by you to the client workstation running the TN3270E session. The client IP address must match the static IP address configured in the workstation platform for its network interface card.

**Note:** OSA-ICC does not support a Dynamic Host Configuration Protocol (DHCP) LAN environment. All OSA-ICC servers and client workstations must have static IP addresses.

Defining the client’s IP address for a session index is optional. However, for security and session management reasons, we strongly recommend only defining TN3270E type sessions with the client workstation’s IP address and unique LU names (see “Session connection rules and recommendations” on page 22).

**Session type**
Three session types are supported:

- **TN3270**
  The TN3270 session type is used for local non-SNA DFT 3270 terminal session support (such as TSO/E, CICS, and IMS sessions), and z/VM IPL console and operator console support.

- **Operator console**
  The Operator console session type is used for z/OS NIP/MCS input/output console support only.

  If the Ethernet LAN connection from the OSA-ICC port to a TN3270E client session is lost and then reconnected, and if that client session is being used as a z/OS NIP/MCS operator console, the current screen size setting (the number of lines on the screen) may be lost. That is, the reconnected session might attempt to operate in the default 24x80 screen size mode instead of the intended mode. Defining the session index in the Operator console session type prevents the session from resetting to the default 24x80 screen size if it was originally defined as a larger screen size.

  The Operator console session type does not support local non-SNA DFT 3270 terminal sessions, or z/VM IPL consoles and operator consoles.
Printer

The Printer session type is used for IBM 328x emulated printer sessions. Printer sessions can be used for MCS output-only consoles, 3270 application printing, or for z/VM RSCS printing. The print output sent to the emulated printer session can be directed, by the TN3270E emulator and client workstation operating system, to the workstation attached printer. For example, a USB or serial port attached ink jet printer.

**Note:** Printer sessions are not intended as output devices for bulk printing, but rather for small print jobs, such as printing a hardcopy of the response to a z/OS command, or the contents of a TSO/E dataset.

For example in our configuration, the `l` operand in the z/OS command `(d ios,config,l=prt0130)` directs the response to the MCS output-only console named PRT0130. The 328x emulated printer session, associated with the MCS output-only console, directs the output to its workstation's USB attached ink-jet printer. See “OSA-ICC working example” on page 43.

Multiple printer sessions (for example, MCS output-only consoles on different logical partitions) can be defined on a client workstation to use the one physical printer attached to that workstation. Print jobs from the printer sessions are spooled and queued to the physical printer by the client workstation operating system.

Our example configuration has, on each workstation, multiple 328x emulated printer sessions using one USB attached ink-jet printer.

For either display session type chosen here (TN3270 or Operator console), session type Display is defined in the workstation TN3270E session configuration (see Figure E-3 on page 124).

**Defer Host Disconnect (DHD)**

Defer Host Disconnect is an optional parameter setting for z/OS MCS input/output console sessions only.

DHD is intended as a convenient aid for MCS input/output console session recovery, due to:

- A scheduled client session or workstation shutdown and restart
- Unexpected client session disconnections due to client network load problems
- Unexpected client session disconnections due to intermittent network connectivity problems

The DHD option operates between the OSC-ICC server and the host operating system. It affects if and when the OSA-ICC server notifies the host operating system that OSA-ICC port communications to a z/OS MCS console session has been lost. That is, the MCS console session, running on the client workstation, has been disconnected from the OSA-ICC server.

The DHD option is:

- Only supported for z/OS MCS input/output console sessions
- Not supported for z/OS MCS output-only console sessions (printer sessions)
- Not supported for z/OS VTAM local non-SNA DFT 3270 terminal sessions, including TSO/E, CICS, IMS, or any other 3270 applications.
- Not supported for z/VM, or any other operating systems, IPL console, and operator console sessions
- Not supported for printer sessions
The DHD option operates in the following way: If the OSA-ICC port is disconnected unexpectedly from the MCS console session, and DHD is enabled for the session index, a DHD timer is started. Until this time expires, output sent by the host operating system to the client session is discarded by the OSA-ICC (since the session is not connected), but the host is informed that the Write To Operator (WTO) and Write To Operator with Reply (WTOR) messages were successful. The host operating system is unaware that OSA-ICC port communications to the MCS console session, running on the client workstation, have been lost.

If the client session reconnects to the OSA-ICC port within the DHD timer limit, the OSA-ICC will automatically send a 3270 CLEAR key interrupt to the host operating system. z/OS MCS console support will then reformat the screen and continue sending WTO and WTOR messages.

The z/OS host operating system is not aware that the MCS console session was disconnected for a period of time, and no console recovery action is needed for the temporarily disconnected MCS console session. The missing messages, intended for the MCS console session, are lost to that session. The OSA-ICC does not buffer and retransmit any messages that were sent by the host while the MCS console session was disconnected. The assumption is that messages sent during the disconnected period were also sent to other functioning MCS console sessions, and are also recorded in the SYSLOG and LOGREC datasets and SDSF log.

If the MCS console session does not reconnect within the DHD timer limit, the OSA-ICC server sends an unsolicited device end / intervention required status to the host operating system.

The DHD option can be set to:

- **Disable**
  The host operating system is immediately notified by the OSA-ICC server (unsolicited device end / intervention required) when the client session is disconnected from the OSA-ICC port. z/OS MCS console support will vary the MCS console device number from CONSOLE to ONLINE status. When the client session reconnects to the OSA-ICC port, the session window will display OSA-ICC connection status information (see Example 4-1 on page 64). The z/OS device number associated with the client session must then be manually varied as CONSOLE (via another console session or the HMC Operating System Messages task) to reestablish MCS console services.

  The default setting is DHD disabled.

  When manually editing the configuration source file, to disable DHD do not include the DEFER_HOST_DISCONNECT keyword for the session index.

- **Enable with defaulted deferment of 60 seconds.**
  The host operating system will be notified 60 seconds after the client session is disconnected from the OSA-ICC port. If the client session reconnects within 60 seconds, the OSA-ICC will automatically send a 3270 CLEAR key interrupt to the host operating system. z/OS MCS console support will then reformat the screen and continue sending WTO and WTOR messages.

  When manually editing the configuration source file, this setting is DEFER_HOST_DISCONNECT= 60.

- **Enable with no timeout for deferment**
  The host operating system is never notified when the client session is disconnected from the OSA-ICC port. When manually editing the configuration source file, this setting is DEFER_HOST_DISCONNECT= 0.
Enable with user-specified defaulted deferment

At the end of the user-specified period of time, the host operating system will be notified that the client session is disconnected from the OSA-ICC port. If the client session reconnects within the specified time, the OSA-ICC will automatically send a 3270 CLEAR key interrupt to the host operating system. z/OS MCS console support will then reformat the screen and continue sending WTO and WTOR messages.

**Note:** DHD is an optional parameter setting for z/OS MCS console sessions only. Enabling or disabling DHD for MCS console sessions is your choice based on your data center operational procedures and your client network performance characteristics.

You may choose to enable the DHD option for the default 60 seconds, or a user-specified period of time, to help mask or recover from transient Ethernet LAN problems. Or you may, for example, choose to enable DHD with no timeout for deferment, to allow you to shut down a client workstation overnight.

In our example configuration, we found it convenient to set our z/OS MCS console sessions with a DHD user-defined value of 600 seconds (10 minutes). This enabled us to shut down and restart the client workstations and automatically reconnect the MCS console sessions without having to manually vary the MCS console device numbers as CONSOLE.

**Note:** Each z/OS MCS input/output console session, with the DHD option enabled:
- Must have the auto-reconnect function enabled. See “Defining a PCOMM TN3270E session” on page 122.
- Must have a unique LU name to ensure that session auto-reconnection and MSC console recovery occurs correctly. See “LU name” on page 26.

**Response Mode (RSP)**

Response Mode is an optional parameter setting for TN3270 and operator console display session types only. RSP is not supported for printer sessions, including MCS output-only console sessions.

Response Mode, combined with the Read Time Out option, is intended as an aid for:
- Tuning the TN3270E session connection to the inherent effective data rate and performance characteristics of complex client LANs spanning multiple LAN segments and subnetworks
- Reducing unexpected client session disconnections due to client network performance problems
- Reducing unexpected client session disconnections due to intermittent network connectivity problems
- Diagnosing client network connectivity problems

The Response Mode option operates between the OSC-ICC server and the TN3270E display session running on the client workstation. Response Mode works in conjunction with the Read Time Out (RTO) option. Together, these two options affect whether and when the OSA-ICC server declares connectivity to a display session is lost and drops the session. When Response Mode is enabled for the session index, the OSA-ICC will wait the specified RTO time for the display session to respond before notifying the host operating system that the display session, running on the client workstation, is disconnected.
The Response Mode option is:

- Supported for z/OS MCS input/output console sessions
- Supported for z/OS VTAM local non-SNA DFT 3270 terminal sessions, including TSO/E, CICS, IMS, and any other 3270 applications
- Supported for z/VM, and any other operating systems, IPL console, and operator console sessions
- Not supported for printer sessions
- Not supported for z/OS MCS output-only console sessions (printer sessions)

The Response Mode option operates in the following way: When Response Mode is enabled, each 3270 data stream frame sent from the OSA-ICC server to the TN3270E display session is acknowledged by the display session back to the OSA-ICC server. The OSA-ICC server waits (up to the specified RTO value) for the client session to send a 3270 data stream acknowledgement, for every read, write, or packet received by the client session. After receiving each 3270 acknowledgement, the OSA-ICC continues executing the host channel program (CCW chain) and presenting I/O interrupts to the issuing host application.

The Response Mode option can be set to:

- Enable
  When manually editing the configuration source file, this setting is RESPONSE= ON.
- Disable
  When manually editing the configuration source file, this setting is RESPONSE= OFF.

In our example configuration, we chose to enable Response Mode.

**Read Time Out (RTO)**

The Read Time Out option value is valid and used by the OSA-ICC server only when Response Mode is enabled.

When Response Mode is enabled, the Read Time Out option specifies how long the OSA-ICC will wait (in seconds) for a 3270 data stream acknowledgement from the display session before performing a session disconnect (session drop). If a display session does not respond in this time, the OSA-ICC server declares connectivity to the display session as lost, and it drops the session. The OSA-ICC server then notifies the host operating system that the display session running on the client workstation is disconnected.

When manually editing the configuration source file, this setting is READ_TIMEOUT= n. The valid range is 0 to 300 seconds.

There is no precise calculation of what RTO value best suits a given client network configuration. There are many dependencies unique to your LAN environment that dictate the LAN’s effective data rate and performance characteristics. If the Ethernet LAN is busy, or the network path from the OSA-ICC port to the client session is slow, increasing the RTO value may prevent unexpected session drops.

Some general recommendations for Response Mode and RTO values are:

- For simple client network environments, define all display session types with Response Mode enabled and a minimum RTO value of 60 seconds. Ensure that the RTO value does not exceed the z/OS MIH value set for the device.
- If unexpected session drops occur, increase the RTO for each display session to a value near your z/OS operating system Missing Interrupt Handler (MIH) time. Again, ensure that the RTO value does not exceed the z/OS MIH value set for the device.
For more complex client LANs spanning multiple LAN segments and subnetworks, define all display session types with Response Mode enabled and a minimum RTO value of 180 seconds. Ensure that your z/OS operating system MIH is set to at least 270 seconds (50% higher).

Do not enable DHD, Response Mode, or RTO for any printer sessions, including MCS output-only consoles.

**Note:** To avoid channel- and device-end error conditions for a given z/OS device number, it is important to ensure that the z/OS operating system Missing Interrupt Handler (MIH) time is set to a value higher than the RTO value.

We recommend the MIH time to be at least 50% higher than the RTO value. For example, if the RTO is 180 seconds, then set the MIH to 270 seconds.

In our simple example configuration, we chose to use a minimum RTO value of 60 seconds and an MIH value of 90 seconds for all display sessions.

**Tip:** You can use the z/OS command `setios mih dev=(nnnn),time=mm:ss` to check the MIH time set for a given z/OS device number. For example:

```
13.50.26 SC64   d ios,mih,dev=0130
13.50.26 SC64   IOS086I 13.50.26 MIH DEVICE TIMES 294
0130=01:30.
```

To temporarily set a new MIH value for a device, you may either:

- Issue the z/OS command `setios mih dev=(nnnn),time=mm:ss`, or
- Edit the appropriate `IECIOSxx` member in `SYS1.PARMLIB`, add the `MIH TIME=mm:ss, DEV=(nnnn-nnnn)` values, then activate this definition using the z/OS command `set ios=xx`, where `xx` is the suffix of the IOS member you just edited.

To permanently set the new MIH values, edit the appropriate `IEASYSxx` member in `SYS1.PARMLIB` with the new `IOS=xx` member value.

**OSA-ICC configuration source file management**

An OSA-ICC PCHID's configuration source file is built by entering OSA-ICC server and sessions data via the Advanced Facilities panels, by manually editing the configuration source file using most commonly available text editor programs, or both.

After the configuration source file is built, it is validated and activated for the specific OSA-ICC PCHID.

**Note:** If a validated configuration source file is not activated before exiting the Advanced Facilities function, that configuration source file is lost.

If you do not intend to activate the validated configuration source file immediately, export the file to a diskette using the Export source file task (see “OSA-ICC configuration source file export, edit, import, and validate” on page 57). When you are ready to activate the exported configuration source file, import and validate the file, then activate it.

If an OSA-ICC CHPID is configured offline to every logical partition to which the CHPID is defined (CHPID physically offline), then configured online again, or a power-on reset is performed on the System z9 or zSeries server, the last activated configuration source file is activated in the OSA-ICC PCHID.
2.2.3 Network considerations

The Ethernet LAN configuration, connecting the OSA-ICC ports and client workstations, provides connectivity from the System z9 and zSeries server host operating systems to the operating system console and local non-SNA DFT 3270 display sessions and the 328x printer sessions.

This 3270 console connectivity has traditionally been provided by parallel (or less frequently, ESCON) channel attached, local non-SNA 3174 Enterprise Cluster Controllers with at least one, more usually two, channel attached local IBM 3174s for each logical partition. IBM 3270 type terminals connect to the IBM 3174 screen controllers by coaxial cable runs within the datacenter.

The inherent cable length limitations of parallel channel and coaxial cables made the 3270 console configuration physically secure by default (if not by design). Operating system consoles were almost always confined to the datacenter premises.

With the advent of OSA-ICC, as with its predecessor IBM 2074, operating system console and local non-SNA DFT 3270 sessions are no longer limited to the datacenter premises. The client workstations supporting these console sessions can be located anywhere in the world, limited only by the geographical breadth of the Ethernet LAN connecting them to the System z9 or zSeries server.

This geographically dispersed capability for operating system consoles, provided by OSA-ICC (and IBM 2074), brings a far greater flexibility in how the traditional datacenter is designed and managed. Operations staff controlling the datacenter systems are no longer required to be physically located within the datacenter. The Operations Center can manage the datacenter systems from any location in the world.

This capability brings with it network availability and security issues that should be assessed for your environment.

**Note:** For session availability and security reasons, we strongly recommend the use of VLANs or dedicated switches for the OSA-ICC environment.

The OSA-ICC client workstation TN3270E sessions are protected by LUNAME, TCP port number, and static IP address assignments.

The implementation of the OSA-ICC function, as with its predecessor IBM 2074, presents a number of security issues to be assessed. Where appropriate, processes may need to be put in place to mitigate the security risks in line with your corporate security policy. These may include, but are not limited to, consideration of physical security, IP packet filtering, and the use of a Virtual Private Network (VPN).

A secure, high-availability LAN is your responsibility.

Our example configuration is designed to maximize redundancy (see “OSA-ICC working example” on page 43). The configuration can tolerate a hardware failure of an OSA-Express port, workstation platform, or loss of connectivity in the network to either an OSA-Express port or workstation, and still provide session connectivity to all systems.

**Note:** After your configuration source file is Validated and Activated for the OSA-ICC PCHID, we highly recommend exporting the configuration source file and storing it for safe keeping.
Our Ethernet LAN supports connectivity from any workstation to either OSA-Express port. This LAN is segmented from the rest of the corporate intranet by the use of VLANs. The LAN has a speed of 100 MBps, Full Duplex mode, and supports DIX Version 2 Ethernet protocol and an MTU size of 1492 bytes.

**Note:** OSA-ICC does not support a Dynamic Host Configuration Protocol (DHCP) LAN environment. All OSA-ICC servers and client workstations must have static IP addresses allocated by your LAN administrator.

We recommend that your OSA-ICC LAN design have the following attributes:

- A minimum of two OSA-ICC CHPIDs per System z9 or zSeries server. Each OSA-ICC CHPID is defined to a PCHID on different OSA-Express2 or OSA-Express 1000BASE-T features and, if available, different I/O cages within the System z9 or zSeries server.

- A minimum of two client workstations, with each workstation supporting equivalent TN3270E client sessions to the other workstation, so that if one workstation platform becomes inoperable, equivalent sessions can be connected to the System z9 or zSeries server via the other workstation.

- A given workstation has LAN connectivity to each OSA-ICC PCHID. Each workstation and each OSA-ICC PCHID connect to the LAN via different dedicated switches. The LAN has redundant paths between the switches.

- Half of the defined TN3270E sessions on a workstation connect via one OSA-ICC PCHID. The other half of the defined sessions are equivalent sessions connecting via the second OSA-ICC PCHID. If one OSA-ICC PCHID becomes inoperable, half the sessions on a given workstation are lost, but equivalent workstation sessions can be connected via the second OSA-ICC PCHID.

**Note:** This is an important characteristic of the LAN design for maintaining session availability during System z9 or zSeries server concurrent microcode upgrades.

Activating new OSA-ICC microcode levels (MCLs) is a concurrent operation. However, for the OSA-Express PCHID to be initialized with the new MCLs requires the OSA-ICC CHPID to be configured offline to every logical partition to which the CHPID is defined (CHPID physically offline) then configured online again. This reinitializes the OSA-Express PCHID with the new microcode level and reloads the currently active OSA-ICC configuration file. This process is disruptive to sessions using this OSA-ICC CHPID.

TN3270E session availability is maintained by connecting alternate sessions via the second OSA-ICC CHPID before configuring the first OSA-ICC CHPID off/on. TN3270E sessions can then be reestablished via the first OSA-ICC CHPID before configuring the second OSA-ICC CHPID off/on.

- Only OSA-ICC traffic should be allowed to flow on the LAN via dedicated Ethernet switches. The LAN is considered a private LAN. If the client workstations and OSA-ICC ports are in different subnetworks, then VLANs or dedicated Ethernet switches should be used. If the OSA-ICC traffic is to flow through the corporate intranet, or the Internet, a Virtual Private Network (VPN) should be used.

- TN3270E client emulator programs may use “short-lived” port numbers for outbound host application traffic. Outbound host port numbers allocated by TN3270E client emulator programs are typically in the “short-lived” range of 1024 through 65535 inclusive. If your LAN design uses firewalls, you may have to consider firewall rules to allow short-lived port numbers to flow; otherwise, you may implement a VPN.
The Ethernet protocol supported by the LAN network should be the DIX Ethernet Version 2 protocol.

For session throughput reasons, the LAN network should support a minimum MTU size of 576 bytes. If possible, use the maximum supported MTU size of 1492 bytes. The OSA-ICC server MTU size value does not include the 8-byte Ethernet frame header. So for LANs supporting 1500-byte Ethernet frames, the OSA-ICC MTU size value should be set to 1492 bytes. See “MTU Size(B)” on page 25, and Figure 3-7 on page 51.

2.2.4 TN3270E emulator planning

This section describes planning for the TN3270E emulator session configuration parameters. We recommend that you use the TN3270E configuration worksheet to record the session parameters for your configuration (see “Worksheet templates” on page 98). See “Example configuration worksheets” on page 82 for the parameters used in our example configuration.

TN3270E emulator program support for the OSA-ICC function

The OSA-ICC function complies with TCP/IP RFC 2355 TN3270E Telnet Option. There are currently two Telnet TN3270E (not TN3270) emulator program products that explicitly support the OSA-ICC function:

- IBM Personal Communications (PCOMM) V5.6 and later supports TN3270 Extensions used for OSA-ICC support. PCOMM is a component of the IBM Access Client Package for Multiplatforms program suite. For more information, see:

  Note: We highly recommend that you apply the latest software maintenance available for the PCOMM version and release you are running in your OSA-ICC environment.

  Many PTFs are available for currently supported PCOMM releases, for the TN3270E function, and especially for 328x emulated printer support. For more information about PCOMM service updates, see:

- IBM Tivoli AF/REMOTE V1.0.0.106 and later supports TN3270 Extensions used for OSA-ICC support. For more information, see:

  Note: AF/REMOTE does not currently support the 328x emulated printer function.

Other TN3270E emulators may work with the OSA-ICC function. If you choose to use another TN3270E emulator, we recommend ensuring that the product vendor provides software support for the emulator program. Avoid using freeware or shareware programs with no software support.

  Note: IBM supports only Personal Communications (PCOMM) V5.6 for Windows (or later) and IBM Tivoli AF/REMOTE V1.0.0.106 (or later) for use with the OSA-ICC function.

TN3270E session configuration

The TN3270E client sessions appear to the host operating system as local non-SNA DFT 3270 terminals and 328x printers. The use of a LAN and TCP/IP connections is not visible to
the host applications. A TN3270E client session is associated with a single device number in a single logical partition by the OSA-ICC session configuration.

For an OSA-ICC implementation, the TN3270E emulator session configuration parameters are:

- **Type of host: zSeries or S/390**
- **Interface: LAN**
- **Attachment: Telnet3270**
- **Host Name or IP Address**
  - This is the IP address that you allocate to the OSA-ICC PCHID port. The host IP address must match the host IP address configured in the OSA-ICC server configuration (see Figure 3-7 on page 51).
- **LU Name**
  - This is the LU name for this session. It must match the LU name defined in the corresponding OSA-ICC PCHID session configuration (see Figure 3-9 on page 53).
  
  We recommend using an LU naming convention that identifies the logical partition system name and device number associated with this TN3270E session (for example, SC64E000). The LU name should have eight or fewer alphanumeric characters for compatibility with most TN3270E emulator programs.
- **Port Number**
  - This is the TCP port number used by the OSA-ICC PCHID and workstation TN3270E session to initially establish session communications. The OSA-ICC listens to this port number for all inbound host traffic from all TN3270E sessions. This port number must match the port number defined in the corresponding OSA-ICC PCHID server configuration (see Figure 3-7 on page 51).

  After the initial session communication is established, the TN3270E client emulator program will bind a different TCP port and socket number to the session to use for outbound host application traffic. The outbound host port and socket number for a given session connected to the OSA-ICC server is displayed on the Display Client Connections panel (see Figure 4-4 on page 69). Outbound host port numbers allocated by a TN3270E client emulator are typically in the short-lived port range, from 1024 through 65535 inclusive.

  The TCP port number (inbound host port) defined in the TN3270E session can be considered a type of logon password for the session, which enables initial communications to be established between the OSA-ICC port and the workstation TN3270E session.

  IBM 2074 has TCP port number default values of 3270 and 3271. You may choose to use one of these values for the OSA-ICC TCP port number for consistency within your IBM 2074 environment. Our configuration uses the OSA-ICC default value of 1024. For network security reasons, you may choose to change the default port number.

  It is also important to note that these port numbers may have to be applied to your firewall rules if applicable. Also, ensure that no other application or task running on the workstation operating system uses port numbers that conflict with the OSA-ICC port number.

- **Auto-reconnect**
  - If the TN3270E session is disconnected (dropped) from the OSA-ICC (see “Drop Session” on page 75), and if the Auto-reconnect box is checked on the PCOMM Host Definition page, the session is reconnected automatically.
z/OS MCS console sessions, with the DHD option enabled must have the auto-reconnect function enabled. See “Defer Host Disconnect (DHD)” on page 28.

We recommend enabling Auto-reconnect for all session types.

- **Session Type**
  Session type can be either Display or Printer. See “Session type” on page 27.
  The Display session type is used for TN3270 and operator console displays.
  The Printer session type is used for IBM 328x emulated printer sessions. Printer sessions can be used for MCS output-only consoles, 3270 application printing, or for z/VM RSCS printing.

- **Screen Size**
  We recommend selecting a screen size for the TN3270E display session to match the display type defined for the MCS console or local non-SNA 3270 terminal. For example:
  - Display type 3277 model 2 has a screen size of 24 rows by 80 columns.
  - Display type 3277 model 3 has a screen size of 32 rows by 80 columns.
  See B.2.2, “MCS console definitions” on page 110 and “VTAM definitions for z/OS” on page 118.

- **Host Code-page**
  Select the required host code-page table for your environment.

- **Host Graphics**
  We recommend that host graphics be disabled.

**TN3270E session recommendations**

We recommend that you ensure that the client workstations running the TN3270E emulator sessions do not have any sort of power-saving or sleep mode enabled, either in hardware (BIOS setting) or software (Windows setting). Otherwise, if any outbound host traffic (WTO or WTO messages) is sent to a TN3270E session while the client workstation is “snoozing,” the session through the OSA-ICC may be dropped. If this is a z/OS or other operating system console, it may require manual commands to be entered at another operating system console to reactivate the TN3270E console session.

Modifying a session window banner title to include the LU name defined to the session (for example, SC64E000) can aid in managing multiple session windows on a workstation platform. The user can quickly identify which system and device number is associated with this session, even if the session is not connected to the host. See “Modifying the PCOMM session window settings” on page 127.

It is important for systems operators in a computer operations environment to have workstation consoles that have a consistent look and feel. For example, a particular console workstation used for a specific task may have the following attributes:

- A defined set of TN3270E sessions are active for the particular role of the workstation. A workstation console in the operations room will have a different set of sessions active, compared to a workstation console in the tape or printer rooms.
- A workstation's set of normally active sessions are the only sessions that automatically reactivate if the workstation is restarted.
- These normally active sessions are automatically activated in a certain sequence, so that a particular session to a particular system device number always has the same PCOMM session prefix letter. For example, LU session SC64E000 is always running in Workstation 1, PCOMM session window A.
Defining these attributes on a workstation console means that operations staff are presented with a consistent user interface, enabling them to become familiar with navigating the workstation desktop. This may help improve the users’ efficiency in performing their role, which is especially important when performing system problem determination. See “PCOMM sessions batch file” on page 128 for more information about how to customize the look and feel of a client workstation.
Configuration tasks

This chapter contains the following sections about hardware and software configuration tasks:

- Configuration tasks overview
- OSA-ICC quick start
- OSA-ICC working example
- OSA-Express feature configuration panels
3.1 Configuration tasks overview

An OSA-ICC implementation involves configuration tasks in the host operating system software, the System z9 and zSeries server I/O subsystem, the OSA-Express2 and OSA-Express features (via the Hardware Management Console (HMC) or Support Element (SE)), and the workstation running the TN3270E emulator program. See 2.2, “Configuration steps” on page 15 for information about planning for these tasks.

This section describes performing each of these tasks, using the configuration described in 3.3, “OSA-ICC working example” on page 43.

Note: If you are already familiar with the OSA-ICC configuration process, “OSA-ICC quick start” on page 41 will be useful as a quick reminder checklist.

The OSA-ICC configuration tasks are:

- **Hardware Configuration Definition (HCD) and Input/Output Configuration Program (IOCP)**
  The OSA-ICC function requires a unique channel path identifier (CHPID) type, control unit, and device definition. These definitions are made using the HCD on z/OS, or IOCP (see “OSA-ICC definitions using HCD” on page 102, and “OSA-ICC definitions using IOCP” on page 108).

- **Console definitions for z/OS**
  z/OS operating system support for NIP (Nucleus Initialization Program) consoles is defined using the HCD (see B.2.1, “NIP console definitions” on page 109).

- **Console definitions for z/VM and printer definitions for z/VM RSCS**
  z/VM operating system support for IPL consoles is defined in the system configuration (system config) file on the primary parm (MAINT CF1) disk (see “z/VM console definitions” on page 114).

  z/VM RSCS printer support for 328x printers is defined in the RSCS configuration (RSCS CONFIG) file, and Group Control System profile (PROFILE GCS) file, on the RSCS (191) disk (see “z/VM RSCS printer definitions” on page 114).

- **VTAM member definitions for z/OS**
  z/OS VTAM support for local non-SNA DFT 3270 terminals and 328x printers is defined in the local non-SNA major node (MAJNODE) members of the SYS1.VTAMLST dataset (see “VTAM definitions for z/OS” on page 118).

- **OSA-Express feature configuration**
  The OSA-ICC function of the System z9 and zSeries server OSA-Express2 and OSA-Express features is configured using the HMC or SE Advanced Facilities task (see “OSA-Express feature configuration panels” on page 46; also see “Set card mode” on page 146 to set the speed and duplex mode of the OSA-ICC port).

Note: Before the OSA-ICC configuration process can be invoked, the System z9 or zSeries server must have the required OSA-Express CHPIDs defined as type OSC.
TN3270E emulator configuration

The workstation TN3270E session is configured using the emulator program session configuration task. See “PCOMM TN3270E emulator configuration panels” on page 122, and “AF/REMOTE TN3270E emulator configuration panels” on page 133.

Two emulator program products are used in our configuration:

– IBM Personal Communications (PCOMM) V5.7.3.3 CSD2 for Windows

PCOMM is a component of the IBM Host Access Client Package for Multiplatforms program suite. This emulator is used for display and printer sessions. For more information, see:


– IBM Tivoli AF/REMOTE V1.0.0.106

This emulator is used for display sessions only. For more information, see:


**Note:** IBM only supports Personal Communications (PCOMM) V5.6 for Windows (or later) and IBM Tivoli AF/REMOTE V1.0.0.106 or later for use with the OSA-ICC function.

Other TN3270E emulators may work with the OSA-ICC function. If you choose to use another TN3270E emulator, we recommend ensuring that the product vendor provides software support for the emulator program. Avoid using freeware or shareware programs with no software support.

PCOMM session modification for local non-SNA DFT 3270 display session use

The PCOMM session profile must be updated to ignore printer Write Control Characters (WCC) when the session is used as a local non-SNA DFT 3270 terminal (see “Modifying a PCOMM session for local non-SNA DFT 3270 use” on page 125).

PCOMM session modification for 328x emulated printer session use

The PCOMM session profile must be updated with printer time-out keyword values when the session is used as a 328x emulated printer (see “Modifying a PCOMM session for 328x emulated printer use” on page 126).

Verification of the OSA-ICC configuration

Verifying the correct operation of an OSA-ICC session involves checking session status via the operating system console, HMC Advanced Facilities task, and workstation emulator program (see Chapter 4, “Verifying the configuration” on page 63).

### 3.2 OSA-ICC quick start

Table 3-1 on page 42 provides information to help you achieve a quick start with your OSA-ICC implementation. It assists you in determining which key elements to consider, based on your TN3270E display and printer requirements. It also directs you to the appropriate sections in this book for details.

If you are already familiar with the OSA-ICC configuration process, this table will be useful as a quick reminder checklist.
The table field values are:

X  Mandatory requirement for this device mode of operation
O  Optional setting, but recommended for this device mode of operation
<blank>  Invalid or unsupported for this device mode of operation

Table 3-1  OSA-ICC implementation quick-start

<table>
<thead>
<tr>
<th>OSA-ICC implementation definitions X = mandatory O = optional / recommended</th>
<th>MCS input</th>
<th>MCS output-only console</th>
<th>VTAM 3270 display</th>
<th>VTAM 328x printer</th>
<th>VM 3270 console</th>
<th>VM RSCS 328x printer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HCD / IOCP definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HCD type OSC</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CU type OSC / 254 devices</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O DEVICE type 3270-X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O DEVICE type 3287-1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>z/OS NIP console definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NIP console</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>z/OS MCS console definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O cons ROUTCODE(ALL)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output-only ROUTCODE(NONE)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>z/VM console definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oper console</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emergency message console</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>z/OS VTAM definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local non-SNA 3277-2 display</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local non-SNA 328x printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>z/VM RSCS definition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RSCS printer definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>OSA-Express OSA-ICC definitions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session type 3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session type Operator console</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session type Printer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unique LU name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See “HCD and IOCP planning” on page 17
See “HCD and IOCP definitions” on page 102
See “Configuration steps” on page 15
See “NIP console definitions” on page 109
See “Configuration steps” on page 15
See “MCS console definitions” on page 110
See “Configuration steps” on page 15
See “z/VM console definitions” on page 114
See “Configuration steps” on page 15
See “VTAM definitions for z/OS” on page 118
See “Configuration steps” on page 15
See “z/VM RSCS printer definitions” on page 114
See “OSA-ICC sessions configuration” on page 25
See “OSA-Express feature configuration panels” on page 46
3.3 OSA-ICC working example

This section describes the OSA-ICC working example used throughout this chapter. All OSA-ICC configuration tasks described in this chapter are taken from this real configuration running in our lab environment.

Our configuration is designed to maximize redundancy. It can tolerate a hardware failure of an OSA-Express port, workstation platform, or loss of connectivity in the network to either an OSA-Express port or workstation, and still provide session connectivity to all systems (see Figure 3-1 on page 44).
Our OSA-ICC configuration has the following attributes:

- One z990 server (microcode driver level 55) running multiple logical partitions.
- Three logical partitions (A11, A12, and A1C) defined to LCSS1 exploit the OSA-ICC function:
  - Logical partition A11 is running a z/OS Version 1.6 operating system, with a VTAM system name of SC64.
  - Logical partition A12 is running a z/OS Version 1.7 operating system, with a VTAM system name of SC65.
  - Logical partition A1C is running a z/VM Version 5.1 operating system, with a system name of VM5.

- Two OSA-Express 1000BASE-T features installed in separate z990 server I/O cages.
In the production Input/Output Configuration Dataset (IOCDS) generated by HCD:

- One OSA-Express 1000BASE-T port on each feature (PCHIDs 110 and 381) is defined as CHPID type OSC, and SHARED among the three logical partitions.
- CHPID 0A is mapped to PCHID 110.
- CHPID 07 is mapped to PCHID 381.
- Each OSC CHPID has one logical control unit defined with a default address range starting at 00, for 254 addresses (hex 00 to FD).
- Each OSC CHPID has the maximum allowed 120 logical devices defined:
  - CHPID 0A supports device numbers E000 to E02F, 0030 to 0035, and E036 to E077.
  - CHPID 07 supports device numbers E100 to E12F, 0130 to 0135, and E136 to E177.

Three Microsoft® Windows XP SP1 workstations (W/S1, W/S2, and W/S3) support TN3270E emulator sessions to each of the three systems:

- A given workstation is the primary workstation for one of the systems. Typically, only sessions to that system are active on the workstation. Sessions to other systems are disconnected, and are activated only if a backup session is required.
- Workstation display sessions associated with the E0xx device numbers, and printer sessions associated with the 003x device numbers, connect via CHPID 0A.
- Workstation display sessions associated with the E1xx device numbers, and printer sessions associated with the 013x device numbers, connect via CHPID 07.

In our example configuration, we chose to use unique device numbers defined to each of the logical partitions. This was done for clarity in describing the OSA-ICC configuration process. However, the same device number can be used more than once if the OSA-ICC CHPID is defined to be shared among your logical partitions (indicated by the MIFID value). This may be useful if you are using a single CONSOLEXX member across logical partitions, hence requiring the use of the same device numbers.

Workstation W/S1 is:
- The primary workstation for the SC64 system (devices E000 and E003, E100 and E103, 0030 and 0033, 0130 and 0133)
  - E000 and E100 are defined as SC64 MCS input/output consoles. E003 and E103 are defined as SC64 local non-SNA DFT 3270 terminals.
  - 0030 and 0130 are defined as SC64 MCS output-only consoles. 0033 and 0133 are defined as SC64 local non-SNA 328x printers.
- A backup workstation for the SC65 system (devices E010 and E013, E110 and E113)
  - E010 and E110 are defined as SC65 MCS input/out consoles. E013 and E113 are defined as SC65 local non-SNA DFT 3270 terminals.
- A backup workstation for the VM5 system (devices E020 and E023, E120 and E123)
  - All four devices are defined as VM5 system consoles.

Workstation W/S2 is:
- The primary workstation for the SC65 system (devices E011 and E014, E111 and E114, 0031 and 0034, 0131 and 0134)
  - E011 and E111 are defined as SC65 MCS input/output consoles. E014 and E114 are defined as SC65 local non-SNA DFT 3270 terminals.
0031 and 0131 are defined as SC65 MCS output-only consoles. 0034 and 0134 are defined as SC65 local non-SNA 328x printers.

- A backup workstation for the SC64 system (devices E001 and E004, E101 and E104)
  E001 and E101 are defined as SC64 MCS input/output consoles. E004 and E104 are defined as SC64 local non-SNA DFT 3270 terminals.
- A backup workstation for the VM5 system (devices E021 and E024, E121 and E124)
  All four devices are defined as VM5 system consoles.

Workstation W/S3 is:
- The primary workstation for the VM5 system (devices E022 and E025, E122 and E125, 0032 and 0035, 0132 and 0135)
  E022 and E122, E025 and E125 are defined as VM5 system consoles.
  0032 and 0132, 0035 and 0135 are defined as VM5 RSCS 328x printers.
- A backup workstation for the SC64 system (devices E002 and E005, E102 and E105)
  E002 and E102 are defined as SC64 MCS input/output consoles. E005 and E105 are defined as SC64 local non-SNA DFT 3270 terminals.
- A backup workstation for the SC65 system (devices E012 and E015, E112 and E115)
  E012 and E112 are defined as SC65 MCS input/output consoles. E015 and E115 are defined as SC65 local non-SNA DFT 3270 terminals.

Our Ethernet LAN supports connectivity from any workstation to either OSA-Express port. This LAN is segmented from the rest of the corporate intranet by the use of VLANs. The LAN has a speed of 100 Mbps, Full Duplex mode, and supports DIX Version 2 Ethernet protocol, and an MTU size of 1492 bytes.

**Note:** For session availability and security reasons, we strongly recommend the use of VLANs or dedicated Ethernet switches for the OSA-ICC environment.

The OSA-ICC client workstation TN3270E sessions are protected by LUNAME, TCP port number, and static IP address assignments.

The implementation of the OSA-ICC function, as with its predecessor IBM 2074, presents a number of security issues to assess. Where appropriate, processes may have to be put in place to mitigate the security risks in line with your corporate security policy. This may include, but is not limited to, consideration of physical security, IP packet filtering, and the use of a Virtual Private Network (VPN).

A secure, high-available LAN is your responsibility.

See Appendix A, “OSA-ICC worksheets and files” on page 81 for our complete configuration worksheets and source files for both OSA-ICC PCHIDs.

### 3.4 OSA-Express feature configuration panels

The OSA-ICC function of the OSA-Express feature is configured using the Hardware Management Console (HMC) or Support Element (SE) Advanced Facilities task.

**Note:** Before the OSA-ICC configuration process can be invoked, the System z9 or zSeries server must have the required OSA-Express CHPIDs defined as type OSC.
Whether performed at the HMC or the SE, the OSA-Express configuration process via the Advanced Facilities task is the same. The examples throughout this section are performed via the HMC.

### 3.4.1 OSA-Express configuration steps for OSA-ICC

The configuration steps for the OSA-ICC function are:

2. Perform OSA-ICC server configuration (see “OSA-ICC server configuration” on page 50).
3. Perform OSA-ICC sessions configuration (see “OSA-ICC sessions configuration” on page 52).
4. Validate the server and sessions configuration (see “OSA-ICC configuration validation” on page 55).
5. Export, text edit, import, and validate the OSA-ICC configuration source file (see “OSA-ICC configuration source file export, edit, import, and validate” on page 57).
6. Activate the OSA-ICC configuration (see “OSA-ICC configuration activation” on page 61).

**Note:** We highly recommend that you export the configuration source file and store it for safe keeping after your configuration source file is Validated and Activated for the OSA-ICC PCHID.

### 3.4.2 OSA-Express Advanced Facilities for OSA-ICC

1. Start with the HMC workplace logged on in System Programmer (Sysprog) authority mode (see Figure 3-2).

![Figure 3-2 HMC workplace](image)
2. Select the CPC object in the Defined CPCs Work Area of the HMC Workplace, and double-click the **OSA Advanced Facilities** task. The OSA Advanced Facilities PCHID selection panel is displayed (see Figure 3-3).

![OSA Advanced Facilities PCHID selection](image1)

*Figure 3-3  OSA advanced facilities PCHID selection*

The OSA Advanced Facilities PCHID selection panel displays all OSA-Express PCHIDs and their CHPID type, as defined in the current I/O configuration in the HSA of the System z9 or zSeries server.

3. On the OSA Advanced Facilities PCHID selection panel, select the required PCHID, and click **OK**. The Standard Channel Advanced Facilities panel is displayed (see Figure 3-4).

![Standard Channel Advanced Facilities](image2)

*Figure 3-4  Standard channel advanced facilities*
This window shows the selected PCHID number and the appropriate CHPID channel type.

4. On the Standard Channel Advanced Facilities panel, click **Card specific advanced facilities**, and click **OK**. The Advanced Facilities panel is displayed (see Figure 3-5).

![Advanced Facilities panel]

**Figure 3-5  Advanced facilities**

The Advanced Facilities panel lists the OSA-ICC options available in System Programer (Sysprog) authority mode. Note the LAN port type is **OSC for OSA Console Controller**.

To set the speed and duplex mode of the OSA-Express port, see "Set card mode" on page 146.
3.4.3 OSA-ICC server configuration

1. Starting with the Advanced Facilities panel, click **Panel configuration options**, and click **OK**. The Panel Configuration Options panel is displayed (see Figure 3-6).

![Panel Configuration Options](image)

---

Note: After the panel values have been validated, you must use the **Activate Configuration function** on the Advanced Facilities panel to make them active, or your present changes will be lost.

---

**Figure 3-6  Panel configuration options**
2. On the Panel Configuration Options panel, click **Edit server configuration**, and click **OK**. The Edit Server Configuration panel is displayed (see Figure 3-7).

![Edit Server Configuration Panel](image)

**Figure 3-7 Edit server configuration**

For details about the settings used in the subsequent steps, refer to “OSA-ICC server configuration” on page 24.

3. On the Edit Server Configuration screen, enter the:

   - **Server Name**
     In our configuration, server name OSCE000 represents the control unit number (E000) associated with the OSC channel.

   - **Host IP Address**
     This is the IP address that you allocated to this OSA-ICC PCHID port. For all TN3270E sessions connecting via this OSA-ICC server, the TN3270E session Host IP Address definition must match the OSA-ICC server Host IP Address defined here. See Figure E-2 on page 123.

   - **TCP Port**
     This is the TCP port number used by the OSA-ICC PCHID and workstation TN3270E session to initially establish session communications. The valid range is 1 to 65535. For all TN3270E sessions connecting via this OSA-ICC server, the TN3270E session TCP port number definition must match the OSA-ICC server TCP port number defined here. See Figure E-2 on page 123.

   - **Default Gateway and Subnet Mask**
     This is the default gateway IP address and subnet mask for the IP subnetwork to which this OSA-ICC port is connected.
– Frame Type
Frame type specifies the Ethernet protocol supported by the LAN network to which this OSA-ICC port is connected.
– MTU Size (B)
This is the maximum transmission unit maximum size (in bytes) supported by the LAN to which this OSA-ICC port is connected.

4. Complete the server definitions on the Edit Server Configuration panel.

Attention: Note the warning message on the Edit Server Configuration panel.

Changing any of the above server configuration definitions, other than Server Name, will result in all sessions currently connected through this OSA-ICC port to be dropped, when the validated configuration is next activated.

Clicking OK on the Edit Server Configuration panel will not drop sessions.

Click OK. The Edit Server Configuration command completed panel is displayed.

5. On the Edit Server Configuration command completed panel, click OK. The Panel Configuration Options panel is displayed.

3.4.4 OSA-ICC sessions configuration

1. Starting with the Panel Configuration Options panel, click Edit sessions configuration, and click OK. The Edit Sessions Configuration panel is displayed (see Figure 3-8).

![Figure 3-8 Edit sessions configuration](image-url)
Use the scroll bar on the right side of the panel to see the session definitions with session index numbers higher than Index 15. Alternatively, click on a session index entry and use the keyboard up-arrow and down-arrow keys to navigate the panel.

2. On the Edit Sessions Configuration panel, select the top session index line (Index 1), and click **Change**. The Edit Session Configuration panel is displayed (see Figure 3-9 and Figure 3-10 on page 54).

![Figure 3-9  Edit session configuration part 1](image)

3. On the Edit Session Configuration panel:
   - Select the CSS Value from the pull-down list.
   - Select the MIFID from the pull-down list.
   - Select the Device Number from the pull-down list.

   **Note:** The Device Number pull-down list contains only the values defined to the channel path ID in the current I/O configuration in the HSA of the System z9 or zSeries server.

   **Tip:** You can use the z/OS command (**d ios,config**) or the z/VM command (**q token**) to check the HSA I/O configuration data. For example:

```
D IOS, CONFIG
IOS5061 16.46.16 I/O CONFIG DATA 907
ACTIVE IODF DATA SET = SYS1.IODF14
CONFIGURATION ID = L06RMVS1  EDT ID = 01
TOKEN:  PROCESSOR DATE     TIME     DESCRIPTION
SOURCE: SCZP901  05-07-10 11:03:22 SYS1   IODF14
```
- Enter the LU name for this session. It must match the LU name defined in the workstation TN3270E session configuration (see Figure E-2 on page 123).
- Enter the client's IP address. This must match the static IP address configured in the workstation platform for its network interface card.
- Click on the required session type. For planning information see “Session type” on page 27.
  The TN3270 session type is used for local non-SNA DFT 3270 sessions, and z/VM IPL console and operator console support.
  The Operator console session type is used for z/OS NIP/MCS input/output console support only.
  The Printer session type is used for IBM 328x emulated printer sessions. Printer sessions can be used for MCS output-only consoles, 3270 application printing, or for z/VM RSCS printing.
- Select the required Defer Host Disconnect, Response mode, and Read Timeout options.

**Note:** Defer Host Disconnect (DHD) is an optional parameter setting for z/OS MCS input/output console sessions only. Do not define DHD for any other display or printer session type.

For planning information see “Defer Host Disconnect (DHD)” on page 28.
4. Complete the session options and click **OK**. The Edit Sessions Configuration panel is displayed (see Figure 3-11).

![Edit Sessions Configuration](image.png)

**Figure 3-11   Edit sessions configuration with one session**

Figure 3-11 shows the first OSA-ICC session configured for PCHID 110.

Depending on how many sessions have to be configured for this PCHID, you may choose to repeat the session configuration steps for subsequent session index numbers, or save, validate, and export this configuration now.

The exported source configuration file can then be updated with additional session definitions using an external text editor program. After all required sessions are defined, the configuration source file is imported and validated.

The configured sessions in the updated source file can then be displayed using the **Edit sessions configuration** option (see Figure 3-20 on page 60).

5. On the Edit Sessions Configuration panel, click **Save**. The Edit Sessions Configuration command completed panel is displayed.

6. Click **OK**. The Panel Configuration Options panel is displayed.

**3.4.5 OSA-ICC configuration validation**

The server and session panel values are validated for correct syntax, and checked against the current I/O configuration in the HSA of the System z9 or zSeries server, for valid LCSS IDs, MIF IDs, and device numbers defined for this OSC channel.

1. Starting with the Panel Configuration Options panel, click **Validate panel values** and **OK**.

If the validation process completes without errors, the Validate Panel Values “command completed” window displays after a few seconds (see Figure 3-12 on page 56).
If the validation process stops with an error, the Validate Panel Values error window displays (see Figure 3-13).

If an error occurs, click OK on the error panel and do the following:

- Select Display validate panel errors and click OK. The error messages panel is displayed. Figure 3-14 shows an example error message.

To close the error message panel, click File → Exit or press F3. The Panel Configuration Options panel is displayed.

- Depending on where the error occurred, select Edit sessions configuration or Edit server configuration, and click OK. Correct the error, then save and validate the panel values again; if necessary, repeat until validation completes successfully.
2. On the Validate Panel Values command completed panel, click **OK**. The Panel Configuration Options panel is displayed.

3. On the Panel Configuration Options panel, click **Cancel**. The Advanced Facilities panel is displayed.

### 3.4.6 OSA-ICC configuration source file export, edit, import, and validate

You can edit the configuration source file directly on your HMC or SE console by selecting **Edit source file** on the Manual Configuration Options panel. Or you can export the configuration source file to a diskette, edit the contents using a text editor, and import it back to the HMC or SE for validation.

**Note:** System z9 also provides the facility to import and export the OSA-ICC configuration source file via FTP to an external FTP server.

We chose to use the export option. Exporting the OSA-ICC configuration source file for a given PCHID is a quick and easy way to configure multiple sessions using an external text editor program:

1. Starting with the Advanced Facilities panel, click **Manual configuration options** and **OK**. The Manual Configuration Options panel is displayed (see Figure 3-15).

![Manual Configuration Options](image)

**Figure 3-15  Manual configuration options**
2. On the Manual Configuration Options panel, click **Export source file** and **OK**. The Export Source File panel is displayed (see Figure 3-16).

![Export Source File](image)

**Figure 3-16  Export source file**

3. Insert a blank, formatted diskette into the diskette drive on the HMC.

4. On the Export Source File panel, type in a file name with a file extension of txt, and click **OK**. This will export a flat ASCII text file to the diskette.

5. After the file is exported, remove the diskette and click **OK** on the Export Source File completed successfully panel. The Manual Configuration Options panel is displayed.

   The exported text file can be edited to add session definitions, using most commonly available text editors.

Example 3-1 shows our exported configuration source file for PCHID 110, with the server configuration and one session defined.

**Example 3-1  OSA-ICC source file with one session**

// This file has been generated from the binary file D:\POKCODE\IQZC0110.HUL

```
<OSC_SERVER>
  HOST_IP= 10.10.4.2
  DEFAULT_GATEWAY= 10.10.4.1
  SUBNET_MASK= 255.255.255.0
  PORT= 1024
  ETHERNET_FRAME= DIX
  MTU= 1492
  NAME= OSCE000
</OSC_SERVER>

<CONFIG_SESSION>
<SESSION1>
  CSS= 01 IID= 01 DEVICE= E000
  GROUP= "SC64E000"
  CONSOLE_TYPE= 2 RESPONSE= ON
  READ_TIMEOUT = 60
  DEFER_HOST_DISCONNECT = 600
  CLIENT_IP= 10.10.10.2
</SESSION1>
</CONFIG_SESSION>
```

6. After you have finished editing the OSA-ICC source file, insert the diskette containing the updated configuration source file into the diskette drive on the HMC.

7. On the Manual Configuration Options panel, click **Import source file** and **OK**. The Import Source File panel is displayed.
8. On the Import Source File panel, select the source file name you wish to import from the diskette and click OK. This will import the flat ASCII text file from the diskette in the diskette drive of the HMC.

9. After the file is imported, the Import Source File completed successfully panel is displayed (see Figure 3-17).

10. Remove the diskette from the diskette drive and click OK. The Manual Configuration Options panel is displayed.

11. On the Manual Configuration Options panel, click Validate source file and OK.

   The imported source file will be validated for correct syntax and checked against the current I/O configuration in the HSA of the System z9 or zSeries server for valid LCSS IDs, MIF IDs, and device numbers defined for this OSC channel.

   If the validation process completes without errors, the Validate Source File completed successfully panel is displayed (see Figure 3-18).

   If the validation process stops with an error, an error message panel is displayed. Figure 3-19 on page 60 shows an example error message.
To close the error message panel, click File → Exit or press F3. The Manual Configuration Options panel is displayed. Edit the source file and correct the error, then import and validate the source file again until validation completes successfully.

12. On the Validate Source File completed successfully panel, click OK. The Manual Configuration Options panel is displayed.


14. The validated source file can now be viewed, or further session changes made. On the Advanced Facilities panel, click Panel configuration options and OK. The Panel Configuration Options panel is displayed.

15. On the Panel Configuration Options panel, click Edit sessions configuration and OK. The Edit Sessions Configuration panel is displayed (see Figure 3-20).

Figure 3-20  Edit sessions configuration with all sessions
Use the scroll bar on the right side of the panel to see the session definitions with session index numbers higher than Index 15. Alternatively, click on a session index entry and use the keyboard up-arrow and down-arrow keys to navigate the panel.

The Edit Sessions Configuration panel shows the sessions defined in the imported and validated source file for PCHID 110.

Check the session definitions and make any changes if necessary.

**Note:** Any additional session changes made here must be saved and then validated using the **Validate panel changes** option on the Panel Configuration Options panel.

16. On the Edit Sessions Configuration panel, click **Save** if any additional changes were made; otherwise, click **Cancel**. The Panel Configuration Options panel is displayed.

17. If any additional changes were made during step 16, click **Validate panel changes**, and click **OK**. Otherwise, continue with the next step.

18. On the Panel Configuration Options panel, click **Cancel**. The Advanced Facilities panel is displayed.

### 3.4.7 OSA-ICC configuration activation

1. Starting with the Advanced Facilities panel, click **Activate configuration** and **OK**. The Activate Configuration Warning panel is displayed (see Figure 3-21).

![Activate Configuration](image)

**Figure 3-21  Activate configuration warning**

2. On the Activate Configuration Warning panel, note the warning message:
   
   - Changing any server configuration parameter other than Server Name will result in all sessions (currently connected through this OSA-ICC) being dropped, when the validated configuration is next **activated**.
   
   - Changing any session configuration parameter will result in that session being dropped when the validated configuration is next **activated**.

**Attention:** Activating an OSA-ICC configuration may be disruptive to some or all currently active sessions connected via this OSC channel.
3. On the Activate Configuration Warning panel, click **OK**. The Activate Configuration command completed panel is displayed (see Figure 3-22).

![Activate Configuration panel](Image)

*Figure 3-22  Activate Configuration command completed*

4. On the Activate Configuration command completed panel, click **OK**. The Advanced Facilities panel is displayed.

**Note:** We highly recommend that you export the configuration source file and store it for safe keeping after your configuration source file is Validated and Activated for the OSA-ICC PCHID.
Verifying the configuration

This chapter contains the following:

- Verification overview
- TN3270E emulator status
- OSA-ICC status
- Host status
- Gathering OSA-ICC trace and log data
4.1 Verification overview

Host software, System z9 and zSeries I/O configuration, OSA-ICC hardware configuration, and TN3270E emulator configuration have a number of interdependent configuration settings that must be defined correctly for your OSA-ICC implementation to be successful.

Add to this the complexities of setting up a high availability and secure network connection between your System z9 or zSeries server and client workstations, and you may agree that there is ample opportunity for something not to work properly.

It is important to understand what tools and information are available to verify your OSA-ICC configuration. This chapter discusses some of those tools and information, which are available at the TN3270E client workstation, OSA-ICC Advanced Facilities, and the host operating system.

Note: As with any OSA-Express implementation, it is important for you to understand that network connectivity and network problem determination are your responsibility.

4.2 TN3270E emulator status

TN3270E session status can be viewed from the workstation session window, regardless of the emulator used. This section, using PCOMM as an example, describes the connection status information sent from the OSA-ICC to the client, and displaying the PCOMM host connection log.

4.2.1 Session window status

When a TN3270E client first connects to an OSA-ICC, the OSA-ICC sends connection status information, which is displayed in the client session window (see Example 4-1).

Example 4-1 TN3270E session window status

```
** OSC Index 01 connected to OSCE000 via IP Addr 10.10.4.2:1024 **
** LT Index=00 CSSID=01 MIFID=01 CU=0 UA=00 LUName=SC64E000 **
** Type=2084-C24 Mfg=IBM SN=00000026A3A CHPID=0A Status=Active **
```

10.10.10.2:2532

This information is displayed in the session window until host application communications is established. For example:

- A z/OS MCS device number is varied as an MCS console (v E000, console).
- A local non-SNA DFT 3270 device is allocated to VTAM, by varying its VTAM logical unit name active (v net,act,id=sc64e003).

The connection status information is displayed only momentarily if the session's initial status, as defined in the host, is set to active (ISTATUS=ACTIVE) (see Example D-1 on page 118).

Connection status information is displayed in the top three lines of the session window. Additional information is displayed in the bottom line.
The information displayed at the top of the window (see Figure 4-1 on page 66) includes:

- Session index number: OSC Index 01 (see Figure 4-4 on page 69).
- OSA-ICC server name: OSC001 (defined in Figure 3-7 on page 51).
- OSA-ICC host IP address: 10.10.4.2 (defined in Figure 3-7 on page 51 and Figure E-2 on page 123).
- OSA-ICC inbound host port: 1024 (defined in Figure 3-7 on page 51 and Figure E-2 on page 123).
- Logical Terminal Index number: 00 (see Figure 4-4 on page 69).
- Logical Channel Subsystem Identifier: CSSID=01 (defined in Example B-1 on page 108 and Figure 3-9 on page 53).
- Multiple Image Facility Identifier: MIFID=01 (defined in Example B-1 on page 108 and Figure 3-9 on page 53).
- Logical Control Unit and Unit Address: CU=0 and UA=00 (HCD/IOCP defaults are defined in Figure B-5 on page 105 and Figure B-8 on page 107).
- Client session LU name: SC64E000 (defined in Figure 3-9 on page 53 and Figure E-2 on page 123).
- zSeries server machine type, model, and serial number: 2084-C24, serial 26A3A.
- OSA-ICC CHPID number: CHPID=0A (defined in Example B-1 on page 108).
- TN3270E session status: Active.

The information displayed at the bottom of the window includes:

- Client workstation IP address: 10.10.10.2 (defined in Figure 3-9 on page 53).
- OSA-ICC outbound host port: 2532. Allocated by the TN3270E emulator program for this session connection (see Figure 4-4 on page 69).

Figure 4-1 on page 66 shows how the information in the TN3270E session window relates to the actual configuration. In this example we show PCOMM; however, the same values are defined when using AF/REMOTE as the client emulator program.
4.2.2 Display PCOMM host connection log

To see the PCOMM host connection log, on the PCOMM session window, click View → Status Bar History. The Status Bar History panel is displayed (see Example 4-2).

Example 4-2 PCOMM status bar history

Connecting...
Creating a local socket...
Local socket is connecting to remote server/host 10.10.4.2 using port 1024...
Connected to remote server/host 10.10.4.2 using lu/pool SC64E000 and port 1024

The Status Bar History panel shows the session connection events since this session window was first opened.

4.3 OSA-ICC status

The status of the OSA-ICC sessions can be viewed from the Advanced Facilities task on the Hardware Management Console (HMC). To access the OSA-ICC Advanced Facilities, see “OSA-Express Advanced Facilities for OSA-ICC” on page 47.

The OSA-ICC status display panels include:
- Display Active Server Configuration (see “Display active server configuration” on page 67).
- Display Active Server Configuration (see “Display active sessions configuration” on page 68).
- Display Client Connections (see “Display client connections” on page 69).
4.3.1 Display active server configuration

1. Starting with the Advanced Facilities panel, click Display active server configuration, and click OK.

2. The Display Active Server Configuration panel is displayed (Figure 4-2), showing the active server definitions for this OSA-ICC PCHID. These are the server definitions in the OSA-ICC configuration source file that was last activated.

Here you can confirm that the active configuration matches the intended definitions. Click OK to return to the Advanced Facilities panel.

![Display Active Server Configuration](image)

Figure 4-2   Display active server configuration
4.3.2 Display active sessions configuration

1. Starting with the Advanced Facilities panel, click **Display active sessions configuration**, and click **OK**. The Display Active Sessions Configuration panel is displayed (Figure 4-3).

2. The Display Active Sessions Configuration panel shows the active session definitions for this OSA-ICC PCHID. These are the session definitions in the OSA-ICC configuration source file that was last **activated**.

   Use the scroll bar on the right side of the panel to see the sessions with session index numbers higher than Index 15. Alternatively, click on a session index entry, and use the keyboard up-arrow and down-arrow keys to navigate the panel.

   Click **OK** to return to the Advanced Facilities panel.

---

![Display Active Sessions Configuration](image)

*Figure 4-3 Display active sessions configuration*
4.3.3 Display client connections

1. Starting with the Advanced Facilities panel, click **Display client connections**, and click **OK**. The Display Client Connections panel is displayed (Figure 4-4).

![Display Client Connections Panel](image)

**Figure 4-4  Display client connections**

The Display Client Connections panel shows the *current* status of all sessions defined in the last activated OSA-ICC configuration. The status information shown is:

- **Session Index**
  The session index number is a place holder in the session list. It is not used for session communications.

  The Session Index number is also used in the debug utilities drop session task to identify which session is to be dropped (see “Drop Session” on page 75).

- **Status**
  The session status indicates the current state of the session connection:

  - *Not configured*
    - A session has not been configured for this index entry.

  - *Definition error*
    - A session index entry has a definition error, due to a mismatch between the OSA-ICC session configuration parameters, and those defined in the current I/O configuration in the HSA of the System z9 or zSeries server.

  - *Available*
    - A configured session is available for use. There is currently no connection to a workstation TN3270E client.
- Connected
  A configured session is currently connected to a workstation TN3270E client.
- DHD pending
  A connected session has lost connectivity with the OSA-ICC server port, and
  OSA-ICC has started the DHD timer for this session.

  MAC
  This is the MAC (Media Access Control) address of the “first hop” device connected to
  the OSA-ICC. The MAC address field displays the MAC of:
  - The client workstation, if the workstation is in the same Ethernet LAN segment as
    the OSA-ICC and the TN3270E session is connected
  - The attached router, if the client workstation is in a different IP network than the
    OSA-ICC and the TN3270E session is connected
  - All zeros, if the TN3270E session has never connected, or is in the process of
    connecting, or a session has not been configured for this index entry
  - The last device to have successfully connected (workstation or router), if the
    session status is available or definition error

- Client’s IP
  The IP address of the client workstation.

- Port and Socket Number
  The outbound host port and socket number, assigned by the TN3270E session
  emulator, for a given session connected to the OSA-ICC server. The TN3270E session
  emulator on the client workstation “listens” for this outbound host port for session
  communications.

- LT Index
  The Logical Terminal Index number is one of the details displayed on the TN3270E
  session window, when the workstation session first establishes communications with
  the OSA-ICC (see Example 4-1 on page 64).

- Connect rule
  The connection rules defined in the OSA-ICC configuration for this session are:
  - IP and LU
    This session will only connect to a client workstation with the matching Client IP
    address and TN3270E LU name.
  - LU
    This session’s OSA-ICC configuration has no client IP address defined. Therefore,
    the session will connect to any client workstation with the matching TN3270E LU
    name, regardless of the workstation’s IP address.

2. Use the scroll bar on the right side of the panel to see the sessions with session index
   numbers higher than Index 15. Alternatively, click on a session index entry, and use the
   keyboard up-arrow and down-arrow keys to navigate the panel.

Important: The Display Client Connections panel is not a dynamic display.

The panel shows the session status at the time the panel was invoked. Any session whose
status changes while the panel is open will not be updated in the panel view.
3. To refresh the panel view, click **OK** to close the panel. Click **Display client connections**, and click **OK** to re-open the panel.

4. Click **OK** to return to the Advanced Facilities panel.

### 4.3.4 View port parameters

The current speed and mode of an OSA-Express port, and port traffic statistics, can be displayed via the **View port parameters** option on the Advanced Facilities panel.

1. Starting with the Advanced Facilities panel, click **View port parameters** and click **OK**.
2. The view Port Parameters panel is displayed (see Figure 4-5).

   Note the port speed in the Settings Group. This is the speed explicitly set in the Set Card Mode panel, or auto-negotiated by the OSA-ICC port and the attached switch port.

![View port parameters panel](Image)

*Figure 4-5  View port parameters part 1*

3. Use the vertical scroll bar on the right side to scroll down the panel (see Figure 4-6 on page 72).
4. On the View Port Parameters panel, click OK to return to the Advanced Facilities panel.

4.3.5 Debug utilities

The Debug utilities are for use in problem determination of session connection problems. Starting with the Advanced Facilities panel, click Debug utilities, and click OK. The Debug Utilities panel is displayed (see Figure 4-7).

Figure 4-6  View port parameters part 2

Note the Speed/Mode Control setting in the Statistics Group. This is the setting applied in the Set Card Mode panel.

Figure 4-7  Debug utilities
Ping utility
This utility is used to ping a workstation that is hosting a TN3270E session client in order to verify the state of the IP network connection.

1. Starting at the Debug Utilities panel, click **Ping utility**, and click **OK**. The Ping Utility panel is displayed (see Figure 4-8).

![Figure 4-8 Ping utility](image1)

Here you enter the client workstation’s IP address. You also have the option to customize the length of the packet, the number of packets sent, and how long to wait on the return packet before timing out.

2. On the Ping Utility panel, enter the client workstation’s IP address and click **OK**. The Ping Utility results panel is displayed (see Figure 4-9).

![Figure 4-9 Ping utility results](image2)

3. Click **OK** to return to the Debug Utilities panel.
Trace route utility
This utility is used to trace the IP network connection to the client workstation for use in problem determination of network connection problems.

1. Starting with the Debug Utilities panel, click **Trace route utility**, and click **OK**.
2. The Trace Route Utility panel is displayed (see Figure 4-10). Here you enter the client workstation’s IP address. You also have the option to customize the maximum time-to-live of the ICMP Echo reply, the number of attempts, the port number used, and the wait time, as well as receiving additional debug messages. Enter the client workstation’s IP address and click **OK**.

![Trace Route Utility](image)

**Figure 4-10  Trace route utility**

3. The Trace Route Utility results panel opens. Click **OK** to return to the Debug Utilities panel.

![Trace Route Utility Results](image)

**Figure 4-11  Trace route utility results**
**Drop Session**

This utility is used to drop a session from the OSA-ICC. The dropped TN3270E session will reconnect automatically if the session configuration on the client workstation is set to Auto-reconnect (see Figure E-2 on page 123).

1. Starting at the Debug Utilities panel, click **Drop session**, and click **OK**. The Drop Session panel is displayed (see Figure 4-12).

![Figure 4-12  Drop Session](Image)

**Attention:** The number entered in the Drop Session panel is the Session Index number, *not* the Logical Terminal Index number (see Figure 4-4 on page 69).

2. On the Drop Session panel, enter the session index number of the session you wish to drop, and click **OK**. The Drop Session command-completed panel appears, as shown in Figure 4-13.

![Figure 4-13  Drop Session command completed](Image)

3. Click **OK** to return to the Debug Utilities panel.
4. On the Debug Utilities panel, click **Cancel**. The Advanced Facilities panel is displayed.

### 4.4 Host status

The host operating system status of the OSA-ICC sessions can be viewed using various display and query commands issued via the operating system consoles.

This section shows some of the commands that can be used for the z/OS and z/VM operating systems.
4.4.1 z/OS MCS console status

Example 4-3 shows some example z/OS commands, and their responses, to display the host status of the OSA-ICC sessions and CHPIDs.

Example 4-3  z/OS MCS console status

```
- 20.11.14 SC64  d u,,e000,6
  20.11.14 SC64  IEE457I 20.11.14 UNIT STATUS 084
  UNIT TYPE STATUS  VOLSER  VOLSTATE
  E000  3270  C-BSY
  E001  3270  C
  00  E002  3270  C
  E003  3277  A
  E004  3277  A
  E005  3277  A

- 20.12.00 SC64  d m=dev(e000)
  20.12.00 SC64  IEE174I 20.12.00 DISPLAY M 087
  DEVICE E000  STATUS=ONLINE
  CHP   0A
  DEST LINK ADDRESS  0D
  ENTRY LINK ADDRESS ..
  PATH ONLINE   Y
  CHP PHYSICALLY ONLINE  Y
  PATH OPERATIONAL  Y
  MANAGED   N
  00  MAXIMUM MANAGED CHPID(S) ALLOWED:  0
  DESTINATION CU LOGICAL ADDRESS = 00
  CU ND = NOT AVAILABLE
  DEVICE NED = 002074.002.IBM.02.208400026A3A.0400

- 10.05.21 SC64  d m=chp(0A)
  10.05.21 SC64  IEE174I 10.05.21 DISPLAY M 933
  CHPID 0A:  TYPE=14, DESC=OSA CONSOLE, ONLINE
  DEVICE STATUS FOR CHANNEL PATH 0A
  0  1  2  3  4  5  6  7  8  9  A  B  C  D  E  F
  003 + + +@ +@ + + + + . . . . . . . .
  E00 + + + + + + + + + + + + + + + + + + +
  E01 + + + + + + + + + + + + + + + + + + +
  E02 + + + + + + + + + + + + + + + + + + +
  E03 . . . . + + + + + + + + + + + + + + +
  E04 + + + + + + + + + + + + + + + + + + +
  E05 + + + + + + + + + + + + + + + + + + +
  E06 + + + + + + + + + + + + + + + + + + +
  E07 + + + + + + + + + + + + + + + + + + +
  SWITCH DEVICE NUMBER = NONE
  PHYSICAL CHANNEL ID = 0110

*****************************************************************************
** SYMBOLE EXPLANATIONS ********************************************************
  + ONLINE  @ PATH NOT VALIDATED  - OFFLINE  . DOES NOT EXIST
  * PHYSICALLY ONLINE  $ PATH NOT OPERATIONAL

- 10.16.20 SC64  d c
  10.16.20 SC64  IEE889I 10.16.20 CONSOLE DISPLAY 954
  MSG: CURR=7  LIM=1500  RPLY:CURR=1  LIM=999  SYS=SC64  PFK=00
  CONSOLE ID ---------------- SPECIFICATIONS -------------------
  SYSLOG  COND=H  AUTH=CMDS  NBUF=N/A
  OPERLOG  COND=H  AUTH=CMDS  NBUF=N/A
  XE000  03  COND=N  AUTH=MASTER  NBUF=7
```
4.4.2 z/VM operator console status

Example 4-4 shows some example z/VM commands, and their responses, to display the host status of the OSA-ICC sessions and CHPIDs.

Example 4-4  z/VM operator console status

```
query e022
GRAF E022 ENABLED
Ready; T=0.01/0.01 18:01:57

query paths to e022
Device E022, Status ENABLE
CHPIDs to Device E022 (PIM) : 0A
Physically Available (PAM) : +
Online (LPM) : +
Legend + Yes - No
Ready; T=0.01/0.01 18:02:09

query chpid 0A pchid
Path 0A is associated with physical channel 0110
Ready; T=0.01/0.01 18:02:43

query chpid 0A type
Path 0A is an Open Systems Adapter 3270-Console (OSC) channel
Ready; T=0.01/0.01 18:02:57
```
4.4.3 VTAM local non-SNA 3270 status

This section shows example VTAM commands for displaying the status of a local non-SNA 3270 device.

Display major node

Example 4-5 shows an example of displaying the status of a local non-SNA 3270 device’s VTAM major node.

Example 4-5  VTAM display major node

```
- 18.23.34 SC64  d net, id=culne00x.e
18.23.34 SC64 STC25872 IST097I DISPLAY ACCEPTED
18.23.34 SC64 STC25872 IST075I NAME = CULNE00X, TYPE = LCL 3270 MAJ NODE
IST486I STATUS= ACTIV, DESIRED STATE= ACTIV
IST355I LOGICAL UNITS:
00 IST089I SC64E003 TYPE = LOGICAL UNIT , ACTIV , CUA=E003
IST089I SC64E004 TYPE = LOGICAL UNIT , ACTIV , CUA=E004
IST089I SC64E005 TYPE = LOGICAL UNIT , ACTIV , CUA=E005
IST314I END
IEE612I CN=XE000 DEVNUM=E000 SYS=SC64 CMDSYS=SC64
IST314I END
```

Display logical unit

Example 4-6 shows an example z/OS command for displaying a local non-SNA 3270 device allocated to VTAM, and a VTAM command for displaying the status of the logical unit associated with the same local non-SNA 3270 device.

Example 4-6  VTAM display logical unit

```
- 18.23.19 SC64  d u,,,e003,1
18.23.19 SC64 IEE457I 18.23.19 UNIT STATUS 955 C
UNIT TYPE STATUS VOLSER VOLSTATE
E003 3277 A

- 18.24.30 SC64  d net, id=sc64e003
18.24.30 SC64 STC25872 IST097I DISPLAY ACCEPTED
18.24.30 SC64 STC25872 IST075I NAME = USIBMSC.SC64E003, TYPE = LOGICAL UNIT
IST486I STATUS= ACTIV, DESIRED STATE= ACTIV
IST1447I REGISTRATION TYPE = NETSRVR
IST977I MDLTAB=***NA*** ASLTAB=***NA***
IST861I MODETAB=NEWMTAB USSTAB=USSBENCH LOGTAB=***NA***
IST934I DLOGMOD=DNYSBC USS LANGTAB=***NA***
IST597I CAPABILITY=PLU INHIBITED,SLU ENABLED ,SESSION LIMIT 00000001
IST314I LOCAL 3270 MAJOR NODE = CULNE00X
IST077I SI0 = 00002 CUA = E003
IST082I DEVTYPE = LU
IST654I I/O TRACE = OFF, BUFFER TRACE = OFF
IST1500I STATE TRACE = OFF
00 IST171I ACTIVE SESSIONS = 0000000000, SESSION REQUESTS = 0000000000
IST314I END
```
4.5 Gathering OSA-ICC trace and log data

When performing problem determination for an OSA-ICC connectivity problem, it is important that you are able to clearly define the problem boundary based on the observed symptoms.

You may be asked by the IBM Remote Technical Support Center or your IBM Service Representative to capture the OSA-ICC trace and log data as part of information gathering to analyze a problem.

**Note:** It is important that this procedure be performed immediately after the OSA-ICC problem occurs and prior to any recovery action being performed. This ensures that valid data for the problem event is captured.

This procedure can be performed concurrently, without affecting any running sessions connected through the OSA-ICC server.

1. To access the OSA Advanced Facilities task, see “OSA-Express Advanced Facilities for OSA-ICC” on page 47.
2. Starting at the Standard Channel Advanced Facilities panel, select **Card Trace/Log/Dump Facilities**, and click **OK**. The Card Trace/Log/Dump Facilities panel is displayed (see Figure 4-14).

![Card Trace/Log/Dump Facilities](image)

*Figure 4-14  Card Trace/Log/Dump Facilities*

The Card Trace/Log/Dump Facilities panel has three selections. The first selection is to be used only under guidance from the IBM Remote Technical Support Center or your IBM Service Representative. It is not required for normal data capture.

1. On the Card Trace/Log/Dump Facilities panel, select **Read trace buffer** and click **OK**. The Read trace buffer command-completed panel is displayed after a few seconds. Click **OK** on the command-completed panel.
2. On the Card Trace/Log/Dump Facilities panel, select **Read log buffer**, and click **OK**. The Read log buffer command-completed panel is displayed after a few seconds. Click **OK** on the command-completed panel.
3. On the Card Trace/Log/Dump Facilities panel, click **Cancel** to return to the Standard Channel Advanced Facilities panel.
4. On the Standard Channel Advanced Facilities panel, click **Cancel** to return to the OSA Advanced Facilities panel.
5. Contact your IBM Service Representative and advise that the OSA-ICC trace and log data are ready for collection.

*Note:* It is important that this procedure be performed immediately after the OSA-ICC problem occurs and prior to any recovery action being performed. This ensures that valid data for the problem event is captured.

This procedure can be performed concurrently, without affecting any running sessions connected through the OSA-ICC server.
Appendix A. OSA-ICC worksheets and files

This appendix contains the following:

- Configuration worksheets used in our configuration
  See A.1, “Example configuration worksheets” on page 82.
- OSA-ICC PCHID source files used in our configuration
- PCOMM session profile examples used in our configuration
  See A.2.3, “PCOMM display session profile” on page 96 and A.2.4, “PCOMM printer session profile” on page 97.
- Worksheet templates for you to use in planning your OSA-ICC configuration
A.1 Example configuration worksheets

This section shows the worksheets we used for our configuration.

A.1.1 OSA-ICC server worksheet

Figure A-1 shows the OSA-ICC server configuration worksheet for PCHIDs 0110 and 0381.

<table>
<thead>
<tr>
<th>OSA-ICC Edit Server Configuration: 2084-C24 SCZP901</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCHID (CHPID)</td>
</tr>
<tr>
<td>Server Name</td>
</tr>
<tr>
<td>Host IP Address</td>
</tr>
<tr>
<td>TCP Port</td>
</tr>
<tr>
<td>Default Gateway</td>
</tr>
<tr>
<td>Subnet Mask</td>
</tr>
<tr>
<td>Frame type</td>
</tr>
<tr>
<td>MTU Size (B)</td>
</tr>
</tbody>
</table>

*Figure A-1  PCHIDs 0110 and 0381 server worksheet*
A.1.2 PCHID 0110 OSA-ICC sessions worksheet

Figure A-2 shows the sessions configuration worksheet for PCHID 0110.

<table>
<thead>
<tr>
<th>Index</th>
<th>CSS</th>
<th>MIFID (IID)</th>
<th>Device Number</th>
<th>LU Name</th>
<th>Client's IP</th>
<th>Session type</th>
<th>DHD</th>
<th>RSP</th>
<th>RTO</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>E000</td>
<td>SC64E000</td>
<td>10.10.10.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>E001</td>
<td>SC64E001</td>
<td>10.10.11.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>E002</td>
<td>SC64E002</td>
<td>10.10.12.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>E003</td>
<td>SC64E003</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Enable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>1</td>
<td>E004</td>
<td>SC64E004</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>1</td>
<td>E005</td>
<td>SC64E005</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>2</td>
<td>E010</td>
<td>SC65E010</td>
<td>10.10.10.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>2</td>
<td>E011</td>
<td>SC65E011</td>
<td>10.10.11.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>2</td>
<td>E012</td>
<td>SC65E012</td>
<td>10.10.12.2</td>
<td>Op Console</td>
<td>Ena-600</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>2</td>
<td>E013</td>
<td>SC65E013</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>2</td>
<td>E014</td>
<td>SC65E014</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>2</td>
<td>E015</td>
<td>SC65E015</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>C</td>
<td>E020</td>
<td>VM5E020</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>C</td>
<td>E021</td>
<td>VM5E021</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>C</td>
<td>E022</td>
<td>VM5E022</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>C</td>
<td>E023</td>
<td>VM5E023</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 1</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>C</td>
<td>E024</td>
<td>VM5E024</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 2</td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>C</td>
<td>E025</td>
<td>VM5E025</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable</td>
<td>Enable</td>
<td>60</td>
<td>W/S 3</td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>1</td>
<td>0030</td>
<td>SC640030</td>
<td>10.10.10.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 1 z/OS print</td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>2</td>
<td>0031</td>
<td>SC650031</td>
<td>10.10.11.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 2 z/OS print</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>C</td>
<td>0032</td>
<td>SC650032</td>
<td>10.10.12.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 3 RSCS print</td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>1</td>
<td>0033</td>
<td>SC640033</td>
<td>10.10.10.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 1 VTAM print</td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>2</td>
<td>0034</td>
<td>SC650034</td>
<td>10.10.11.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 2 VTAM print</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>C</td>
<td>0035</td>
<td>VM50035</td>
<td>10.10.12.2</td>
<td>Printer</td>
<td>Disable</td>
<td>Disable</td>
<td>n/a</td>
<td>W/S 3 RSCS print</td>
</tr>
</tbody>
</table>

Figure A-2  PCHID 0110 sessions worksheet
## A.1.3 PCHID 0381 OSA-ICC sessions worksheet

Figure A-3 shows the sessions configuration worksheet for PCHID 0381.

<table>
<thead>
<tr>
<th>Index</th>
<th>CSS</th>
<th>MIFID (IID)</th>
<th>Device Number</th>
<th>LU Name</th>
<th>Client’s IP</th>
<th>Session type</th>
<th>DHD</th>
<th>RSP</th>
<th>RTO</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>E100</td>
<td>SC64E100</td>
<td>10.10.10.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>E101</td>
<td>SC64E101</td>
<td>10.10.11.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>E102</td>
<td>SC64E102</td>
<td>10.10.12.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>E103</td>
<td>SC64E103</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>1</td>
<td>E104</td>
<td>SC64E104</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>1</td>
<td>E105</td>
<td>SC64E105</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>2</td>
<td>E110</td>
<td>SC65E110</td>
<td>10.10.10.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>2</td>
<td>E111</td>
<td>SC65E111</td>
<td>10.10.11.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>2</td>
<td>E112</td>
<td>SC65E112</td>
<td>10.10.12.2</td>
<td>Op Console</td>
<td>Ena-600 Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>2</td>
<td>E113</td>
<td>SC65E113</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>2</td>
<td>E114</td>
<td>SC65E114</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>2</td>
<td>E115</td>
<td>SC65E115</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>C</td>
<td>E120</td>
<td>VM5E120</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>C</td>
<td>E121</td>
<td>VM5E121</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>C</td>
<td>E122</td>
<td>VM5E122</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>C</td>
<td>E123</td>
<td>VM5E123</td>
<td>10.10.10.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 1</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>C</td>
<td>E124</td>
<td>VM5E124</td>
<td>10.10.11.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 2</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>C</td>
<td>E125</td>
<td>VM5E125</td>
<td>10.10.12.2</td>
<td>TN3270</td>
<td>Disable Enable</td>
<td>60</td>
<td>W/S 3</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>1</td>
<td>0130</td>
<td>SC640130</td>
<td>10.10.10.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 1 z/OS print</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>2</td>
<td>0131</td>
<td>SC650131</td>
<td>10.10.10.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 2 z/OS print</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>1</td>
<td>0132</td>
<td>VM50132</td>
<td>10.10.12.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 3 RSCS print</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>1</td>
<td>0133</td>
<td>SC640133</td>
<td>10.10.10.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 1 VTAM print</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>2</td>
<td>0134</td>
<td>SC650134</td>
<td>10.10.11.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 2 VTAM print</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>C</td>
<td>0135</td>
<td>VM50135</td>
<td>10.10.12.2</td>
<td>Printer</td>
<td>Disable Disable</td>
<td>n/a</td>
<td>W/S 3 RSCS print</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.1.4 Workstation 1 PCOMM worksheet

Figure A-4 shows the sessions configuration worksheet for Workstation 1.

#### Workstation 1 configuration

Workstation : 10.10.10.2  
Default Gateway: 10.10.10.1

PCOMM TN3270E Sessions Configuration:

<table>
<thead>
<tr>
<th>PCOMM Session</th>
<th>Host Type</th>
<th>Intf</th>
<th>Attachment</th>
<th>Host IP</th>
<th>LU Name</th>
<th>Port</th>
<th>Session Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E000</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 111</td>
</tr>
<tr>
<td>B</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E100</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 311</td>
</tr>
<tr>
<td>C</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E003</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 111</td>
</tr>
<tr>
<td>D</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E103</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 311</td>
</tr>
<tr>
<td>E</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC65E010</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 111</td>
</tr>
<tr>
<td>F</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E110</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 311</td>
</tr>
<tr>
<td>G</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC65E013</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 111</td>
</tr>
<tr>
<td>H</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E113</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 311</td>
</tr>
<tr>
<td>I</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E020</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
</tr>
<tr>
<td>J</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E120</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
</tr>
<tr>
<td>K</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E023</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
</tr>
<tr>
<td>L</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E123</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
</tr>
<tr>
<td>M</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC640030</td>
<td>1024</td>
<td>Printer</td>
<td>SC64 z/OS print via 111</td>
</tr>
<tr>
<td>N</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC640130</td>
<td>1024</td>
<td>Printer</td>
<td>SC64 z/OS print via 311</td>
</tr>
<tr>
<td>O</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC640033</td>
<td>1024</td>
<td>Printer</td>
<td>SC64 VTAM print via 111</td>
</tr>
<tr>
<td>P</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC640133</td>
<td>1024</td>
<td>Printer</td>
<td>SC64 VTAM print via 311</td>
</tr>
</tbody>
</table>
### A.1.5 Workstation 2 PCOMM worksheet

Figure A-5 shows the sessions configuration worksheet for Workstation 2.

#### Workstation 2 configuration

**Workstation:** 10.10.11.2  
**Default Gateway:** 10.10.11.1

**PCOMM TN3270E Sessions Configuration:**

<table>
<thead>
<tr>
<th>PCOMM Session</th>
<th>Host Type</th>
<th>Intf</th>
<th>Attachment</th>
<th>Host IP</th>
<th>LU Name</th>
<th>Port</th>
<th>Session Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E001</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 111</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E101</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 311</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E004</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 111</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E104</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 311</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC65E011</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 111</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E111</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 311</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC65E014</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 111</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E114</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 311</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E021</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E121</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E024</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E124</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC650031</td>
<td>1024</td>
<td>Printer</td>
<td>SC65 z/OS print via 111</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC650131</td>
<td>1024</td>
<td>Printer</td>
<td>SC65 z/OS print via 311</td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC650034</td>
<td>1024</td>
<td>Printer</td>
<td>SC65 VTAM print via 111</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>zSeries</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC650134</td>
<td>1024</td>
<td>Printer</td>
<td>SC65 VTAM print via 311</td>
<td></td>
</tr>
</tbody>
</table>

*Figure A-5  Workstation 2 sessions worksheet*
A.1.6 Workstation 3 PCOMM worksheet

Figure A-6 shows the sessions configuration worksheet for Workstation 3.

![Workstation 3 configuration](image)

PCOMM TN3270E Sessions Configuration:

<table>
<thead>
<tr>
<th>PCOMM Session</th>
<th>Host Type</th>
<th>Inf</th>
<th>Attachment</th>
<th>Host IP</th>
<th>LU Name</th>
<th>Port</th>
<th>Session Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E002</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 111</td>
</tr>
<tr>
<td>B</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E102</td>
<td>1024</td>
<td>Display</td>
<td>SC64 MCS console via 311</td>
</tr>
<tr>
<td>C</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC64E005</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 111</td>
</tr>
<tr>
<td>D</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC64E105</td>
<td>1024</td>
<td>Display</td>
<td>SC64 VTAM console via 311</td>
</tr>
<tr>
<td>E</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>SC65E012</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 111</td>
</tr>
<tr>
<td>F</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E112</td>
<td>1024</td>
<td>Display</td>
<td>SC65 MCS console via 311</td>
</tr>
<tr>
<td>G</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E015</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 111</td>
</tr>
<tr>
<td>H</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>SC65E115</td>
<td>1024</td>
<td>Display</td>
<td>SC65 VTAM console via 311</td>
</tr>
<tr>
<td>I</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E022</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
</tr>
<tr>
<td>J</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E122</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
</tr>
<tr>
<td>K</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM5E025</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 111</td>
</tr>
<tr>
<td>L</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM5E125</td>
<td>1024</td>
<td>Display</td>
<td>VM5 Oper console via 311</td>
</tr>
<tr>
<td>M</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM50032</td>
<td>1024</td>
<td>Printer</td>
<td>VM5 RSCS print via 111</td>
</tr>
<tr>
<td>N</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM50132</td>
<td>1024</td>
<td>Printer</td>
<td>VM5 RSCS print via 311</td>
</tr>
<tr>
<td>O</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.4.2</td>
<td>VM50035</td>
<td>1024</td>
<td>Printer</td>
<td>VM5 RSCS print via 111</td>
</tr>
<tr>
<td>P</td>
<td>zSeries</td>
<td>LAN</td>
<td>Telnet3270</td>
<td>10.10.6.2</td>
<td>VM50135</td>
<td>1024</td>
<td>Printer</td>
<td>VM5 RSCS print via 311</td>
</tr>
</tbody>
</table>

A.2 OSA-ICC source files

This section shows the OSA-ICC source files used in our configuration. For a description of the tags used in the source files, refer to the Open Systems Adapter-Express Integrated Console Controller User’s Guide, SA22-7990.

A.2.1 OSA-ICC source file for PCHID 0110

Example A-1 on page 88 shows the OSA-ICC source file for PCHID 0110.

Between the `<SESSIONn>` and `</SESSIONn>` tokens in the source file, the:

- `CONSOLE_TYPE` parameter is:
  - Type 1 for 3270
  - Type 2 for Operator console
  - Type 3 for Printer

- `IID` parameter is the Image Identifier, also known as the MIF ID
Example: A-1  PCHID 0110 source file

// This file has been generated from the binary file D:\POKCODE\IQZC0110.HUL

<OSC_SERVER>
  HOST_IP= 10.10.4.2
  DEFAULT_GATEWAY= 10.10.4.1
  SUBNET_MASK= 255.255.255.0
  PORT= 1024
  ETHERNET_FRAME= DIX
  MTU= 1492
  NAME= OSCE000
</OSC_SERVER>

<CONFIG_SESSION>
  <SESSION1>
    CSS= 01 IID= 01 DEVICE= E000
    GROUP= "SC64E000"
    CONSOLE_TYPE= 2 RESPONSE= ON
    READ_TIMEOUT= 60
    DEFER_HOST_DISCONNECT= 600
    CLIENT_IP= 10.10.10.2
  </SESSION1>

  <SESSION2>
    CSS= 01 IID= 01 DEVICE= E001
    GROUP= "SC64E001"
    CONSOLE_TYPE= 2 RESPONSE= ON
    READ_TIMEOUT= 60
    DEFER_HOST_DISCONNECT= 600
    CLIENT_IP= 10.10.11.2
  </SESSION2>

  <SESSION3>
    CSS= 01 IID= 01 DEVICE= E002
    GROUP= "SC64E002"
    CONSOLE_TYPE= 2 RESPONSE= ON
    READ_TIMEOUT= 60
    DEFER_HOST_DISCONNECT= 600
    CLIENT_IP= 10.10.12.2
  </SESSION3>

  <SESSION4>
    CSS= 01 IID= 01 DEVICE= E003
    GROUP= "SC64E003"
    CONSOLE_TYPE= 1 RESPONSE= ON
    READ_TIMEOUT= 60
    CLIENT_IP= 10.10.10.2
  </SESSION4>

  <SESSION5>
    CSS= 01 IID= 01 DEVICE= E004
    GROUP= "SC64E004"
    CONSOLE_TYPE= 1 RESPONSE= ON
    READ_TIMEOUT= 60
    CLIENT_IP= 10.10.11.2
  </SESSION5>

  <SESSION6>
    CSS= 01 IID= 01 DEVICE= E005
GROUP= "SC64E005"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION6>

<SESSION7>
CSS= 01 IID= 02 DEVICE= E010
GROUP= "SC65E010"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.10.2
</SESSION7>

<SESSION8>
CSS= 01 IID= 02 DEVICE= E011
GROUP= "SC65E011"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.11.2
</SESSION8>

<SESSION9>
CSS= 01 IID= 02 DEVICE= E012
GROUP= "SC65E012"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.12.2
</SESSION9>

<SESSION10>
CSS= 01 IID= 02 DEVICE= E013
GROUP= "SC65E013"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION10>

<SESSION11>
CSS= 01 IID= 02 DEVICE= E014
GROUP= "SC65E014"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION11>

<SESSION12>
CSS= 01 IID= 02 DEVICE= E015
GROUP= "SC65E015"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION12>

<SESSION13>
CSS= 01 IID= 0C DEVICE= E020
GROUP= "VMSE020"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION13>

SESSION14
CSS= 01 IID= 0C DEVICE= E021
GROUP= "VM5EO21"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION14>

SESSION15
CSS= 01 IID= 0C DEVICE= E022
GROUP= "VM5EO22"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION15>

SESSION16
CSS= 01 IID= 0C DEVICE= E023
GROUP= "VM5EO23"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION16>

SESSION17
CSS= 01 IID= 0C DEVICE= E024
GROUP= "VM5EO24"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION17>

SESSION18
CSS= 01 IID= 0C DEVICE= E025
GROUP= "VM5EO25"
CONSOLE_TYPE= 1  RESPONSE=  ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION18>

SESSION19
CSS= 01 IID= 01 DEVICE= 0030
GROUP= "SC640030"
CONSOLE_TYPE= 3  RESPONSE=  OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION19>

SESSION20
CSS= 01 IID= 02 DEVICE= 0031
GROUP= "SC650031"
CONSOLE_TYPE= 3  RESPONSE=  OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION20>
<SESSION21>
CSS= 01 IID= 0C DEVICE= 0032
GROUP= "VM50032"
CONSOLE_TYPE= 3 RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION21>

<SESSION22>
CSS= 01 IID= 01 DEVICE= 0033
GROUP= "SC640033"
CONSOLE_TYPE= 3 RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION22>

<SESSION23>
CSS= 01 IID= 02 DEVICE= 0034
GROUP= "SC650034"
CONSOLE_TYPE= 3 RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION23>

<SESSION24>
CSS= 01 IID= 0C DEVICE= 0035
GROUP= "VM50035"
CONSOLE_TYPE= 3 RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION24>

</CONFIG_SESSION>
A.2.2 OSA-ICC source file for PCHID 0381

Example A-2 shows the OSA-ICC source file for PCHID 0381.

Example: A-2   PCHID 0381 source file

// This file has been generated from the binary file D:\POKCODE\IQZC0381.HUL

<OSC_SERVER>
HOST_IP= 10.10.6.2
DEFAULT_GATEWAY= 10.10.6.1
SUBNET_MASK= 255.255.255.0
PORT= 1024
ETHERNET_FRAME= DIX
MTU= 1492
NAME= OSCE100
</OSC_SERVER>

<CONFIG_SESSION>
<SESSION1>
CSS= 01 IID= 01 DEVICE= E100
GROUP= "SC64E100"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.10.2
</SESSION1>

<SESSION2>
CSS= 01 IID= 01 DEVICE= E101
GROUP= "SC64E101"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.11.2
</SESSION2>

<SESSION3>
CSS= 01 IID= 01 DEVICE= E102
GROUP= "SC64E102"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.12.2
</SESSION3>

<SESSION4>
CSS= 01 IID= 01 DEVICE= E103
GROUP= "SC64E103"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION4>

<SESSION5>
CSS= 01 IID= 01 DEVICE= E104
GROUP= "SC64E104"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION5>
<SESSION5>

<SESSION6>
CSS= 01 IID= 01 DEVICE= E105
GROUP= "SC64E105"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION6>

<SESSION7>
CSS= 01 IID= 02 DEVICE= E110
GROUP= "SC65E110"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.10.2
</SESSION7>

<SESSION8>
CSS= 01 IID= 02 DEVICE= E111
GROUP= "SC65E111"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.11.2
</SESSION8>

<SESSION9>
CSS= 01 IID= 02 DEVICE= E112
GROUP= "SC65E112"
CONSOLE_TYPE= 2 RESPONSE= ON
READ_TIMEOUT= 60
DEFER_HOST_DISCONNECT= 600
CLIENT_IP= 10.10.12.2
</SESSION9>

<SESSION10>
CSS= 01 IID= 02 DEVICE= E113
GROUP= "SC65E113"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION10>

<SESSION11>
CSS= 01 IID= 02 DEVICE= E114
GROUP= "SC65E114"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION11>

<SESSION12>
CSS= 01 IID= 02 DEVICE= E115
GROUP= "SC65E115"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION12>
<SESSION13>
CSS= 01 IID= OC DEVICE= E120
GROUP= "VMSE120"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION13>

<SESSION14>
CSS= 01 IID= OC DEVICE= E121
GROUP= "VMSE121"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION14>

<SESSION15>
CSS= 01 IID= OC DEVICE= E122
GROUP= "VMSE122"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION15>

<SESSION16>
CSS= 01 IID= OC DEVICE= E123
GROUP= "VMSE123"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION16>

<SESSION17>
CSS= 01 IID= OC DEVICE= E124
GROUP= "VMSE124"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION17>

<SESSION18>
CSS= 01 IID= OC DEVICE= E125
GROUP= "VMSE125"
CONSOLE_TYPE= 1 RESPONSE= ON
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION18>

<SESSION19>
CSS= 01 IID= 01 DEVICE= 0130
GROUP= "SC640130"
CONSOLE_TYPE= 3 RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION19>

<SESSION20>
CSS= 01 IID= 02 DEVICE= 0131
GROUP= "SC650131"
CONSOLE_TYPE= 3    RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION20>

<SESSION21>
CSS= 01 IID= 0C DEVICE= 0132
GROUP= "VM50132"
CONSOLE_TYPE= 3    RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION21>

<SESSION22>
CSS= 01 IID= 01 DEVICE= 0133
GROUP= "SC640133"
CONSOLE_TYPE= 3    RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.10.2
</SESSION22>

<SESSION23>
CSS= 01 IID= 02 DEVICE= 0134
GROUP= "SC650134"
CONSOLE_TYPE= 3    RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.11.2
</SESSION23>

<SESSION24>
CSS= 01 IID= 0C DEVICE= 0135
GROUP= "VM50135"
CONSOLE_TYPE= 3    RESPONSE= OFF
READ_TIMEOUT= 60
CLIENT_IP= 10.10.12.2
</SESSION24>

</CONFIG_SESSION>
A.2.3 PCOMM display session profile

Example A-3 shows the PCOMM display session profile for the SC64E003 non-SNA DFT 3270 session on Workstation 1.

Example: A-3  PCOMM display session profile for SC64E003

[Profile]
ID=WS
[Telnet3270]
HostName=10.10.4.2
HostPortNumber=1024
Security=N
AutoReconnect=Y
LUName=SC64E003

[Communication]
Link=telnet3270
[3270]
QueryReplyMode=Auto
HostCodePage=037-U

[Keyboard]
Language=United-States
DefaultKeyboard=$$BLANK$$

[Window]
ViewFlags=CE00
CaptionFormat=2D -
UserTitle=SC64E003
RuleLinePos=0 0
MFIColor=Y

[LT]
IgnoreWCCStartPrint=Y
UndefinedCode=Y

The z/OS operating system forces a print screen whenever you log on to a local non-SNA 3270 terminal (for example, a TSO/E user session). When using a PCOMM session via OSA-ICC (or IBM 2074) for local non-SNA DFT 3270 session support, the last two [LT] group statement entries, in the example profile in Example A-3, must be added to the PCOMM session profile. See E.2, “Modifying a PCOMM session for local non-SNA DFT 3270 use” on page 125.

The first statement in the [LT] group ensures that printer Write Control Characters (WCC) are ignored when sent by the host. The second statement prevents PROG751 errors if the host application sends illegal characters to the PCOMM session.
A.2.4 PCOMM printer session profile

Example A-4 shows the PCOMM printer session profile for the SC640130 non-SNA 328x emulated printer session on Workstation 1.

Example: A-4  PCOMM printer session profile for SC640130

```plaintext
[Profile]
ID=WS
Version=7
[Telnet3270]
HostName=10.10.6.2
HostPortNumber=1024
LUName=SC640130
Security=N
AutoReconnect=Y
[Communication]
Link=telnet3270
[3270]
SessionType=Printer
QueryReplyMode=Auto
HostCodePage=037-U
[Keyboard]
CuaKeyboard=1
Language=United-States
DefaultKeyboard=$$BLANK$$
[Window]
SessFlags=3CC6A
ViewFlags=CE00
CaptionFormat=25 -
UserTitle=SC640130 PRINTER
IconFile=C:\Program Files\IBM\Personal Communications\pcsws.exe
RuleLinePos=0
MFIcolor=Y
[printers]
printer=Lexmark Z600 Series, winspool, USB001
Drawer1Orient=Portrait
Drawer2Orient=Portrait
VTPrintArea=Scroll
VTPrintChar=ASCII
VTTerminator=None
CPI=10
LPI=6
FaceName=[BookMaster]
Raster=N
TerminateTime=5
```

When using a PCOMM session via OSA-ICC (or IBM 2074) for 328x emulated printer session support, a local printer definition section must be added to the PCOMM session profile. See E.3, “Modifying a PCOMM session for 328x emulated printer use” on page 126.

After the printer section is added to the session profile, an additional keyword must be added. See the last line in Example A-4.

The TerminateTime keyword added to the existing [printers] section ensures that the printer session does not hang at the end of a print job. Without this keyword, the print job indicator popup panel remains on the session screen, and the Operator Information Area (OIA) at the bottom of the session screen displays the printer in use input inhibit indicator.
### A.3 Worksheet templates

**Server configuration worksheet**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCHID (CHPID)</td>
<td></td>
</tr>
<tr>
<td>Server Name</td>
<td></td>
</tr>
<tr>
<td>Host IP Address</td>
<td></td>
</tr>
<tr>
<td>TCP Port</td>
<td></td>
</tr>
<tr>
<td>Default Gateway</td>
<td></td>
</tr>
<tr>
<td>Subnet Mask</td>
<td></td>
</tr>
<tr>
<td>Frame type</td>
<td></td>
</tr>
<tr>
<td>MTU Size (B)</td>
<td></td>
</tr>
</tbody>
</table>

*Figure A-7  OSA-ICC server worksheet*
Figure A-8   OSA-ICC sessions worksheet

<table>
<thead>
<tr>
<th>Index</th>
<th>CSS</th>
<th>MIFID</th>
<th>Device Number</th>
<th>LU Name</th>
<th>IP address</th>
<th>Session Type</th>
<th>DHD</th>
<th>RTO</th>
<th>RSP</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## PCOMM Configuration Worksheet

**Workstation IP:**

<table>
<thead>
<tr>
<th>PCOMM Session</th>
<th>Host Type</th>
<th>Interface</th>
<th>Attachment</th>
<th>Host IP Address</th>
<th>LU Name</th>
<th>Port Number</th>
<th>Screen Size</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>z/Series</td>
<td>LAN</td>
<td>Telnet3270</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Default Gateway:**

Workstation IP: Default Gateway:

<table>
<thead>
<tr>
<th>Workstation IP</th>
<th>Default Gateway</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Figure A.9** PCOMM workstation worksheet
Appendix B. HCD / IOCP and console definitions

This appendix contains the following:
- “HCD and IOCP definitions” on page 102
- “NIP console definitions” on page 109
- “MCS console definitions” on page 110
B.1 HCD and IOCP definitions

The OSA-ICC function requires a unique CHPID, control unit, and device definition. These definitions are made using HCD or IOCP, which defines the OSA-Express feature to the I/O hardware configuration.

B.1.1 OSA-ICC definitions using HCD

In our configuration, we used HCD on a z/OS Version 1.7 system to define:

- Channel path
- Control unit
- Devices

**Channel path definition**

Start on the HCD main menu screen (Figure B-1).

![Figure B-1   HCD main menu](image)

1. Select option 1, and press Enter.
2. The Define, Modify, or View Configuration Data menu is displayed. Select option 3 Processors, and press Enter.
3. The Processor List is displayed. Select the processor to update, and press Enter. The Actions on Selected Processors screen is displayed.

**Note:** The screen selection options are identified here by the action code entered rather than the screen item number to avoid confusion when a particular HCD menu changes.

4. On the Actions on Selected Processors screen, select S Work with attached channel paths, and press Enter.
5. The Channel Subsystem List is displayed. Select the required CSSID and press Enter.
6. The Actions on Selected Channel Subsystems screen is displayed. Select **S Work with attached channel paths** and press Enter.
7. The Channel Path List is displayed. Press F11 to add a channel path.
8. On the Add Channel Path screen, enter the:
   - Channel path ID (our configuration: 0A)
   - PCHID (our configuration: 110)
   - Channel path type OSC (to define the OSA-ICC function)
   - Operation mode SHR (to share this channel path among logical partitions)
   - Description (our configuration: OSCE000)

We recommend using a meaningful description, which will serve as a reference point in HCD. In our configuration, OSCE000 represents the single control unit number (E000) associated with OSC channel path 0A.

Complete the channel path definitions on the screen and press Enter.

---

**Figure B-2 Add channel path**

<table>
<thead>
<tr>
<th>Add Channel Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify or revise the following values.</td>
</tr>
<tr>
<td>Processor ID . . . : SCZP901</td>
</tr>
<tr>
<td>Configuration mode . : LPAR</td>
</tr>
<tr>
<td>Channel Subsystem ID : 1</td>
</tr>
<tr>
<td>Channel path ID . . . 0A + PCHID . . . 110</td>
</tr>
<tr>
<td>Number of CHPIDs . . . 1</td>
</tr>
<tr>
<td>Channel path type . . OSC +</td>
</tr>
<tr>
<td>Operation mode . . . SHR +</td>
</tr>
<tr>
<td>Managed . . . . . . No (Yes or No) I/O Cluster ______ +</td>
</tr>
<tr>
<td>Description . . . . . OSCE000 (server name in HMC)____</td>
</tr>
</tbody>
</table>

Specify the following values only if connected to a switch:
- Dynamic entry switch ID ___ + (00 - FF)
- Entry switch ID . . . . ___ +
- Entry port . . . . . . ___ +

F1=Help F2=Split F3=Exit F4=Prompt F5=Reset F9=Swap F12=Cancel

---

Appendix B. HCD / IOCP and console definitions 103
9. This displays the Define Access List (Figure B-3).

In our configuration, three logical partitions share this OSA-ICC channel: A11, A12, and A1C. Complete the Access List for the partitions sharing the channel and press Enter.

```
Define Access List

Command ==> ____________________________________ Scroll ==> PAGE

Select one or more partitions for inclusion in the access list.

Channel subsystem ID : 1
Channel path ID . . . : 0A Channel path type . : OSC
Operation mode . . . : SHR Number of CHPIDs . . . : 1

/ CSS ID Partition Name Number Usage Description
/ 1 A1C C OS VM5
_ 1 A1D D CF xxxx
_ 1 A1F E CF Sysplex CF03
_ 1 A1F F CF Sandbox Sysplex CF2
/ 1 A11 1 OS Sandbox Sysplex SC64
/ 1 A12 2 OS Sandbox Sysplex SC65
_ 1 A13 3 OS Sandbox Sysplex SC70
_ 1 A14 4 OS SC60
_ 1 A15 5 OS Test + AO target
_ 1 A16 6 OS xxxx

F1=Help       F2=Split      F3=Exit       F5=Reset      F6=Previous
F7=Backward   F8=Forward    F9=Swap      F12=Cancel
```

Figure B-3  Define access list

10. The Candidate List Definition screen is displayed.
11. Select the partitions to include in the candidate list and press Enter, or simply press Enter if you do not want any additional partitions in the candidate list. The Channel Path List screen is displayed.

**Control unit definition**

Starting from the Channel Path List screen:

1. Select the CHPID just defined (CHPID 0A, in our configuration), and press Enter.
2. The Actions on selected channel paths screen is displayed. Select S Work with attached control units, and press Enter.
3. The Control Unit List is displayed. On the Control Unit List, press F11 to add a control unit.
4. The Add Control Unit screen is displayed (see Figure B-4 on page 105). Enter the:
   - Control unit number (our configuration: E000)
   - Control unit type OSC
   - Description (our configuration: OSCE000)

   We recommend using a meaningful description, which will serve as a reference point in HCD. In our configuration, OSCE000 represents the single control unit number (E000) associated with OSC channel path 0A.

Complete the channel path definitions on the screen, and press Enter.
5. The Select Processor / CU screen is displayed. Select the processor for the control unit, and press Enter.

6. The Actions on Selected Processors screen is displayed. Select S for Select (connect, change), and press Enter. This displays the Add Control Unit screen (Figure B-5), which shows the just-entered OSC control unit information. The unit address is set to 00 and the number of units must be 254.
7. Confirm that the control unit definitions on the screen are correct, and press Enter.
8. The Select Processor / CU screen is displayed again. Press Enter again to return to the Control Unit List screen.

**Device definition**

From the Control Unit List screen:

1. Select the control unit (E000) and press Enter.

2. The Actions on Selected Control Units screen is displayed. Select **Work with attached devices** and press Enter.

3. The I/O Device List is displayed. Press F11 to add a device.

4. The Add Device screen is displayed (Figure B-6).

   Enter the:
   - Device number (our configuration: E000 for 3270-X devices, 0030 for 3287-1 devices)
   - Number of devices (our configuration: 48 and 66 for 3270-X, 6 for 3287-1).

   We recommend defining the maximum number of 120 devices (supported by an OSA-ICC) per OSC channel path.

   - Device type
     In the Device type field, press F4 to add a device type.

   ![Add Device](image)

   **Figure B-6  Add devices**

This displays the Available Device Types screen (see Figure B-7 on page 107).

Device type 3270-X is the only valid device type for display sessions, including z/OS MCS input/output consoles, local non-SNA DFT 3270 terminals, and z/VM system consoles.

There are four device types specified by the 3287 UIM. When defining 3287 printers for use as z/OS MCS output-only consoles, local non-SNA DFT 328x emulated printers, or z/VM RSCS 328x emulated printers, we recommend selecting 3287 model 1.

The HCD configuration process will not allow any other device type, other than those listed, to be defined.
On the Available Device Types screen, select the required device type (3270-X or 3287-1), and press Enter.

![Available Device Types](image)

Select one.

<table>
<thead>
<tr>
<th>Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3270-X</td>
<td></td>
</tr>
<tr>
<td>3287-1</td>
<td></td>
</tr>
<tr>
<td>3287-1C</td>
<td></td>
</tr>
<tr>
<td>3287-2</td>
<td></td>
</tr>
<tr>
<td>3287-2C</td>
<td></td>
</tr>
</tbody>
</table>

***** Bottom of data ******

F1=Help        F2=Split
F3=Exit        F7=Backward
F8=Forward     F9=Swap
F12=Cancel     F22=Command

**Figure B-7 Available device types**

- Description (our configuration: OSCE000)
  
  We recommend using a meaningful description, which will serve as a reference point in HCD. In our configuration, OSCE000 represents the single control unit number (E000) associated with OSC channel path 0A.

5. Complete the device definitions on the screen and press Enter.

6. The Update Serial Number, Description, and VOLSER screen is displayed; press Enter.

7. The Device / Processor Definition screen is displayed. Select the required processor, and press Enter.

8. The Define Device / Processor screen is displayed (see Figure B-8).

![Define Device / Processor](image)

Specify or revise the following values.

<table>
<thead>
<tr>
<th>Device number : E000</th>
<th>Number of devices : 48</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device type : 3270-X</td>
<td></td>
</tr>
<tr>
<td>Processor ID : SCZP901</td>
<td></td>
</tr>
<tr>
<td>Channel Subsystem ID : 1</td>
<td></td>
</tr>
</tbody>
</table>

Unit address : 00 + (Only necessary when different from the last 2 digits of device number)
Time-Out : No (Yes or No)
STADET : No (Yes or No)

Preferred CHPID : +
Explicit device candidate list : No (Yes or No)
F1=Help        F2=Split
F3=Exit        F4=Prompt
F5=Reset       F9=Swap
F12=Cancel
You have the option of changing the starting unit address. Verify the value and press Enter.

9. The Device / Processor Definition screen displays again. Press Enter.

10. The Define Device to Operating System Configuration screen is displayed. Select the operating system to which you want to connect the devices, and press Enter.

11. The Actions on selected Operating Systems screen is displayed. Select S and press Enter.

12. The Define Device Parameter / Features screen is displayed. Make the appropriate changes based on your environment, and press Enter.

13. The Assign / Unassign Device to Esoteric screen is displayed. Make appropriate changes based on your environment, and then press Enter.

14. Repeat the process for each operating system as needed, then exit from the Define Device to Operating System Configuration screen by pressing F3 or F12.

15. You should now be at the Device List panel. Press F3 multiple times to return to the main HCD screen (Hardware Configuration) in order to activate or process the configuration data you just defined.

### B.1.2 OSA-ICC definitions using IOCP

Our configuration has the IOCP input statements shown in Example B-1. This shows the IOCP input statements generated by the HCD configuration process, performed in B.1.1, “OSA-ICC definitions using HCD” on page 102.

**Example: B-1   IOCP definitions**

<table>
<thead>
<tr>
<th>ID</th>
<th>MSG1=‘IODF14’,MSG2=‘SYS6.IODF14 - 2005-07-19 08:27’,</th>
<th>SYSTEM=(2084,1),</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>TOK=('SCZP901',0080000A63A20841103225101591F00000000,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>00000000,'05-07-10', '11:03:22','SYS6','IODF14')</td>
</tr>
<tr>
<td></td>
<td>RESOURCE PARTITION=((CSS(0),(A0A,A),(A0B,B),(A0C,C),(A0D,D),(A*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0E,E),(A0F,F),(A01,1),(A02,2),(A03,3),(A04,4),(A05,5),(A*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>06,6),(A07,7),(A08,8),(A09,9)),(CSS(1),(A1A,A),(A1B,B),(*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A14,4),(A15,5),(A16,6),(A17,7),(A18,8),(A19,9))),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MAXDEV=((CSS(0),64512),(CSS(1),64512))</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHPID PATH=(CSS(1),07),SHARED,PARTITION=((A11,A12,A1C),(*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PCHID=381,TYPE=OSC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHPID PATH=(CSS(1),0A),SHARED,PARTITION=((A11,A12,A1C),(*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PCHID=110,TYPE=OSC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CNTLUNIT CUNUMBR=E000,PATH=((CSS(1),0A)),UNIT=OSC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(030,006),MODEL=1,CUNUMBR=(E000),UNIT=3287</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(E000,48),MODEL=X,CUNUMBR=(E000),UNIT=3270</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(E036,66),MODEL=X,CUNUMBR=(E000),UNIT=3270</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CNTLUNIT CUNUMBR=E100,PATH=((CSS(1),07)),UNIT=OSC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(130,006),MODEL=1,CUNUMBR=(E100),UNIT=3287</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(E100,48),MODEL=X,CUNUMBR=(E100),UNIT=3270</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IODEVICE ADDRESS=(E136,66),MODEL=X,CUNUMBR=(E100),UNIT=3270</td>
<td></td>
</tr>
</tbody>
</table>

See 2.2.1, “HCD and IOCP planning” on page 17 for IOCP planning considerations and keyword rules for OSC CHPIDs.
Appendix B. HCD / IOCP and console definitions

B.2 z/OS console definitions

z/OS operating system support for NIP and MCS consoles attached via OSA-ICC is defined in the same way as for consoles attached via IBM 2074 or 3174. This section describes the console definitions used in our configuration.

In our example configuration, we chose to use unique device numbers defined to each of the logical partitions. This was done for clarity in describing the OSA-ICC configuration process. However, the same device number can be used more than once if the OSA-ICC CHPID is defined to be shared among your logical partitions (indicated by the MIFID value).

B.2.1 NIP console definitions

z/OS operating system support for NIP consoles is defined using HCD. Our configuration has the console definitions shown in Figure B-9.

![NIP Console List](image)

Figure B-9  NIP console definitions

NIP consoles E200 and E201 are for logical partitions defined to LCSS0 and are not part of our configuration.
B.2.2 MCS console definitions

z/OS operating system support for MCS consoles is defined in the CONSOLEXX member of the SYS1.PARMLIB dataset. MCS consoles attached via OSA-ICC are defined in the same way as consoles attached via IBM 2074 or 3174.

Our configuration has the following MCS console definitions. Example B-2 shows the first two devices (E000 and E001) of the six MCS input/output console definitions for system SC64.

**Example: B-2 CONSOLEXX member definitions for input/output consoles**

```plaintext
CONSOLE  DEVNUM(E000)
UNIT(3270-X)
NAME(XE000)
AUTH(MASTER)
USE(FC)
ROUTCODE(ALL)
ALTRGLP(MASTER)
MSCOPE(*ALL)
CMDSYS(*)
LEVEL(ALL)
CON(N)
DEL(R)
RNUM(28)
SEG(28)
AREA(NONE)
RTME(1/4)
MFORM(T,S,J,X)
PFKTAB(MCONPFK0)
```

```plaintext
CONSOLE  DEVNUM(E001)
UNIT(3270-X)
NAME(XE001)
AUTH(MASTER)
USE(FC)
ROUTCODE(ALL)
ALTRGLP(MASTER)
MSCOPE(*ALL)
CMDSYS(*)
LEVEL(ALL)
CON(N)
DEL(R)
RNUM(28)
SEG(28)
AREA(NONE)
RTME(1/4)
MFORM(T,S,J,X)
PFKTAB(MCONPFK0)
```

Example B-3 shows the two MCS output-only console definitions (devices 0030 and 0130) for system SC64.

**Example: B-3 CONSOLEXX member definitions for output-only consoles**

```plaintext
CONSOLE  DEVNUM(0030)
UNIT(PRT)
NAME(PRT0030)
USE(MS)
ROUTCODE(NONE)
ALTRGLP(PRINT)
```

Example B-3 shows the two MCS output-only console definitions (devices 0030 and 0130) for system SC64.
Appendix B. HCD / IOCP and console definitions

MSCOPE(*ALL)
LEVEL(ALL)
MFORM(T,S,J,X)

CONSOLE
DEVNUM(0130)
UNIT(PRT)
NAME(PRT0130)
USE(MS)
ROUTCODE(NONE)
ALTGRP(PRINT)
MSCOPE(*ALL)
LEVEL(ALL)
MFORM(T,S,J,X)

We recommend setting the message routing keyword as ROUTCODE(NONE) for MCS output-only consoles. With this setting, no output will be directed to the 328x emulated printer session unless it is explicitly directed there by using the l= operand.

In our configuration, the l= operand in the z/OS command (d  ios,config,l=prt0030) directs the response to the MCS output-only console named PRT0030. The 328x emulated printer session, associated with the MCS output-only console, directs the output to its workstation's USB attached ink-jet printer.

Note: Printer sessions are not intended as output devices for bulk printing, but rather for small print jobs, such as printing a hard copy of the response to a z/OS command or the contents of a TSO/E dataset.
z/VM and RSCS definitions

This appendix contains the following:

- z/VM console definitions
- z/VM RSCS printer definitions
C.1 z/VM console and printer definitions

z/VM operating system support for IPL consoles and Remote Spooling Communications Subsystem (RSCS) printer support for 328x printers attached via OSA-ICC are defined in the same way as for consoles and printers attached via IBM 2074 or 3174. This section describes the console and printer definitions used in our configuration.

C.1.1 z/VM console definitions

z/VM operating system support for IPL consoles is defined in the system configuration (SYSTEM CONFIG) file on the primary parm (MAINT CF1) disk.

Our configuration has the following definitions in the system configuration file (Example C-1).

Example: C-1 z/VM console definitions

```
SYSTEM  CONFIG   F1   F  80  Trunc=80  Size=288  Line=207  Col=1  Alt=0

/**********************************************************************/
/*                     Console Definitions                            */
/**********************************************************************/
Operator_Consoles     E022 E122 E020 E120 E021 E121 ,
                     System_Console System_3270
Emergency_Message_Consoles E022 E122 E020 E120 E021 E121

At system IPL time, IPL messages are routed to the first available operator console beginning with device E022. At system shutdown time, shutdown messages are routed to all defined Emergency Message Consoles.

C.1.2 z/VM RSCS printer definitions

z/VM RSCS printer support for 328x printers is defined in the RSCS configuration file (RSCS CONFIG) and Group Control System profile file (PROFILE GCS) on the RSCS (191) disk.

Our configuration has the following definitions in the RSCS CONFIG file (see Example C-2).

Example: C-2 RSCS configuration definitions

```
*  * Top of File  *  *
****************************************************************************
* WARNING: CONFIGURATION FILE STATEMENTS AND THEIR OPERANDS MUST
*          BE IN UPPER CASE. THIS FILE MUST NOT CONTAIN SEQUENCE
*          NUMBERS.
*
****************************************************************************
LOCAL VM5 *
CHANNELS F
DUMP CP MAINT
MSGNOH
HIDECHARACTER \
IMBED AUTHS
****************************************************************************
Our configuration has the following GCS startup command statements in the PROFILE GCS file (see Example C-3).

Example: C-3  Profile GCS definitions

** ** Top of File ** **
/*********************************************/
/* */
/* PROFILE GCS */
/* */
/* Invoked automatically when the RSCS Virtual Machine is */
/* IPLed. Setup the RSCS environment and initiate RSCS */
/* operations. */
/* */
/* Note: Some of the commands in this exec have upper case */
/* options. This signifies that these options can be */
/* changed, but the options specified here are the */
/* recommended options. */
/* */
/*********************************************/
/* LINE ATTACHES. */
/* *********************************************/
'CP SPOOL CONSOLE START'
  'CP VARY ONLINE 5090'  /* WTSCVMXA*/
  'CP ATT 5090 RSCS 5090'
  'CP VARY ONLINE 0032'  /* PC Workstation Attached Printer */
  'CP DISABLE 0032'
  'CP ATT 0032 RSCS 0032'
  'CP VARY ONLINE 0035'  /* PC Workstation Attached Printer */
  'CP DISABLE 0035'
  'CP ATT 0035 RSCS 0035'
  'CP VARY ONLINE 0132'  /* PC Workstation Attached Printer */
  'CP DISABLE 0132'
  'CP ATT 0132 RSCS 0132'
  'CP VARY ONLINE 0135'  /* PC Workstation Attached Printer */
  'CP DISABLE 0135'
  'CP ATT 0135 RSCS 0135'
/*********************************************/
/* SPECIFY RSCS LOADLIB & CONFIG FILE; LOAD RSCS MODULE */
/*********************************************/
'GLOBAL LOADLIB RSCS RSCSEXIT'
  'FILEDEF CONFIG DISK RSCS  CONFIG *'
  'FILEDEF AUTHS DISK AUTHS  CONFIG *'
  'LOADCMD RSCS DMTMAN'
There is also a printer link identifier GCS file for each defined printer link. This file allows RSCS to attempt to automatically restart a printer link that has deactivated (Example C-4).

**Example: C-4  Printer link T0032 GCS file**

```
** Top of File **
/* THIS WILL RESTART THE LINE */
ADDRESS 'RSCS'
'START T0032'
** End of File **
```
VTAM definitions

This appendix contains the VTAM definitions for z/OS.
D.1 VTAM definitions for z/OS

z/OS VTAM support for local non-SNA DFT 3270 terminals is defined in the local non-SNA major node (MAJNODE) member of the SYS1.VTAMLST data set. Local non-SNA DFT 3270 sessions attached via OSA-ICC are defined in the same way as sessions attached via IBM 2074 or terminals attached via IBM 3174.

Our configuration has the following VTAM major node definitions:

- Logical partition SC64:
  - Major node CULNE00X (device numbers E003, E004, and E005)
  - Major node CULNE10X (device numbers E103, E104, and E105)
  - Major node CULN0033 (device number 0033)
  - Major node CULN0133 (device number 0133)

- Logical partition SC65:
  - Major node CULNE01X (device numbers E013, E014, and E015)
  - Major node CULNE11X (device numbers E113, E114, and E115)
  - Major node CULN0034 (device number 0034)
  - Major node CULN0134 (device number 0134)

Example D-1 shows the three local non-SNA 3720 display devices (E003, E004, and E005) defined in VTAM major node CULNE00X for system SC64. Similar definitions were made for the other three major nodes with their corresponding device numbers.

Example: D-1  VTAM major node display definition for SC64

<table>
<thead>
<tr>
<th>CULNE00X LBUILD</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
</tr>
<tr>
<td>SC64E003 LOCAL</td>
</tr>
<tr>
<td>CUADDR=E003,</td>
</tr>
<tr>
<td>DLOGMOD=D4B32782,</td>
</tr>
<tr>
<td>MODETAB=ISTINCLM,</td>
</tr>
<tr>
<td>ISTATUS=ACTIVE,</td>
</tr>
<tr>
<td>TERM=3277,</td>
</tr>
<tr>
<td>FEATUR2=MODEL2,</td>
</tr>
<tr>
<td>USSTAB=USSBENCH</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>SC64E004 LOCAL</td>
</tr>
<tr>
<td>CUADDR=E004,</td>
</tr>
<tr>
<td>DLOGMOD=D4B32782,</td>
</tr>
<tr>
<td>MODETAB=ISTINCLM,</td>
</tr>
<tr>
<td>ISTATUS=ACTIVE,</td>
</tr>
<tr>
<td>TERM=3277,</td>
</tr>
<tr>
<td>FEATUR2=MODEL2,</td>
</tr>
<tr>
<td>USSTAB=USSBENCH</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>SC64E005 LOCAL</td>
</tr>
<tr>
<td>CUADDR=E005,</td>
</tr>
<tr>
<td>DLOGMOD=D4B32782,</td>
</tr>
<tr>
<td>MODETAB=ISTINCLM,</td>
</tr>
<tr>
<td>ISTATUS=ACTIVE,</td>
</tr>
<tr>
<td>TERM=3277,</td>
</tr>
<tr>
<td>FEATUR2=MODEL2,</td>
</tr>
<tr>
<td>USSTAB=USSBENCH</td>
</tr>
</tbody>
</table>

118  OSA-Express Integrated Console Controller Implementation Guide
Example D-2 shows both local non-SNA 328x printer devices (0033 and 0133) for system SC64, each separately defined in a VTAM major node (CULN0033 and CULN0133).

**Example: D-2  VTAM major node printer definition for SC64**

<table>
<thead>
<tr>
<th>CULN0033 LBUILD *</th>
</tr>
</thead>
<tbody>
<tr>
<td>SC640033 LOCAL</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CULN0133 LBUILD *</th>
</tr>
</thead>
<tbody>
<tr>
<td>SC640133 LOCAL</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
PCOMM definitions

This appendix contains the following:

- Defining a PCOMM TN3270E session
- Modifying a PCOMM session for local non-SNA DFT 3270 use
- Modifying a PCOMM session for 328x emulated printer use
- Modifying the PCOMM session window settings
- Creating a PCOMM batch file
- Adding a PCOMM batch file to the Workstation startup
E.1 PCOMM TN3270E emulator configuration panels

This section describes configuring a PCOMM TN3270E session on the client workstation.

E.1.1 Defining a PCOMM TN3270E session

Starting from the Windows desktop:

1. Click Start → Programs → IBM Personal Communications → Start or Configure Sessions.

2. The IBM Personal Communications (PCOMM) Sessions Manager panel is displayed. Click New Session.

3. The Customize Communication panel is displayed (see Figure E-1).

For the Select Connection to Host settings, use the following settings:

- **Type of Host**: zSeries (S/390 in earlier PCOMM versions)
- **Interface**: LAN
- **Attachment**: Telnet3270

Click Link Parameters.

![PCOMM customize communication](image)

*Figure E-1  PCOMM customize communication*
4. This displays the Telnet3270 notebook Host Definition page (Figure E-2). For details about the settings used in the subsequent steps, refer to “TN3270E session configuration” on page 35.

![Telnet 3270 Host Definition](image)

**Figure E-2  PCOMM telnet3270 host definition**

The following options are defined on the Host Definition page:

- **Host Name or IP address**
  
  This is the IP address that you allocated to the OSA-ICC PCHID port. The Host IP Address must match the host IP address configured in the OSA-ICC server configuration (see Figure 3-7 on page 51).

- **LU Name**
  
  This is the LU name for this session. The LU name must match the LU name defined in the corresponding OSA-ICC PCHID session configuration (Figure 3-9 on page 53).

- **Port Number**
  
  This is the TCP port number used by the OSA-ICC PCHID and workstation TN3270E session to initially establish session communications. This port number must match the port number defined in the corresponding OSA-ICC PCHID server configuration (Figure 3-7 on page 51).

- **Auto-reconnect**
  
  With Auto-reconnect enabled, if the TN3270E session is disconnected (dropped) from the OSA-ICC, the TN3270E emulator program attempts to automatically reconnect the session. We recommend enabling Auto-reconnect.
Complete the host definition options, and click **OK**.

5. The Customize Communication panel is displayed. Click **Session Parameters**.

6. The Session Parameters panel is displayed (Figure E-3) with the following options defined:
   - **Session type**
     Select session type **Display** for this session.
   - **Screen size**
     For display sessions, select the required screen size. We recommend matching the screen size for the TN3270E session with the display type defined for the MCS console or local non-SNA 3270 terminal. For example;
     - Display type 3277 model 2 has a screen size of 24 rows by 80 columns.
     - Display type 3277 model 3 has a screen size of 32 rows by 80 columns.
     See “MCS console definitions” on page 110 and “VTAM definitions for z/OS” on page 118.
   - **Host code-page**
     Select the required host code-page table.
   - **Host graphics**
     We recommend that host graphics be disabled.

Complete the session parameters and click **OK**.

![Figure E-3  PCOMM session parameters](image)

7. The Customize Communication panel is displayed. Click **OK**.

8. The PCOMM session window is displayed. The PCOMM emulator will attempt to connect to the host (OSA-ICC) at this time. Click **File → Save as**.
9. The Save Workstation Profile panel is displayed. Enter the file name this session will be saved as and click **Save**.

We recommend that the file name be the same as the LU name defined in the session (see Figure E-4).

![Save Workstation Profile](image)

**Figure E-4  PCOMM save workstation profile**

10. Repeat the session definition steps for all required sessions on this workstation.

**Important:**

- If a defined session will be used as a local non-SNA DFT 3270 terminal (for example, a TSO/E user), the PCOMM session profile must be edited to include additional definition statements; otherwise, the session will not work (covered in the next section).
- If a defined session will be used as a 328x emulated printer (for example, an MCS output-only console, 3270 application printer, or z/VM RSCS printer), the PCOMM session profile must be edited to include additional definition statements; otherwise, the session will not work (see “Modifying a PCOMM session for 328x emulated printer use” on page 126).

**E.2 Modifying a PCOMM session for local non-SNA DFT 3270 use**

The z/OS operating system forces a print screen whenever you log on to a local non-SNA 3270 terminal (for example, a TSO/E user session). When using a PCOMM session via OSA-ICC (or IBM 2074) for local non-SNA DFT 3270 session support, the following additional keywords must be present in the PCOMM session profile (see Example E-1 on page 126).
The PCOMM session profile can be edited by most commonly available text editor programs. The default file directory for PCOMM on Windows XP is C:\Documents and Settings\Administrator\Application Data\IBM\Personal Communications.

The first keyword in the [LT] section ensures printer Write Control Characters (WCC) are ignored when sent by the host. The second keyword prevents PROG751 errors if the host application sends illegal characters to the PCOMM session. See “PCOMM display session profile” on page 96 for an example session profile used in our configuration.

E.3 Modifying a PCOMM session for 328x emulated printer use

When using a PCOMM session via OSA-ICC (or IBM 2074) for 328x emulated printer session support, a local printer definition section must be added to the PCOMM session profile.

1. On the PCOMM session window, click File → Printer setup. The Printer Setup panel is displayed.

2. On the Printer Setup panel, select the workstation’s locally attached printer (in our case, a USB attached ink-jet printer), and click OK.

   This adds the printer section, with default keyword values, to the session profile, see Example E-2. You can further tailor the printer keywords by clicking File → Printer setup → Setup, and File → Page setup.

3. When complete, click File → Save, to save your settings to the printer session profile.

4. After the printer section is added to the session profile, an additional keyword must be added. See the last line in Example E-2.

Example: E-2  PCOMM 328x print timers

```
[printers]
printer=Lexmark Z600 Series,winspool,USB001
Drawer1Orient=Portrait
Drawer2Orient=Portrait
VTPrintArea=Scroll
VTPrintChar=ASCII
VT Terminator=None
CPI=10
LPI=6
FaceName=[BookMaster]
Raster=N
TerminateTime=5
```

The PCOMM session profile can be edited by most commonly available text editor programs. The default file directory for PCOMM on Windows XP is C:\Documents and Settings\Administrator\Application Data\IBM\Personal Communications.

The TerminateTime keyword added to the existing [printers] section ensures that the printer session does not hang at the end of a print job. Without this keyword, the print job indicator pop-up panel remains on the session screen, and the Operator Information Area (OIA) at the bottom of the session screen displays the printer in use input inhibit indicator.
See “PCOMM printer session profile” on page 97 for an example session profile used in our configuration.

E.4 Modifying the PCOMM session window settings

This section describes modifying the PCOMM session window banner.

Modifying a session window banner title to include the LU name defined to this session (for example, SC64E000) can aid in managing multiple session windows on a workstation platform. The user is able to quickly identify which system and device number is associated with this session, even if the session is not connected to the host.

Starting with the PCOMM session window:

1. Click **Edit → Preferences → Appearance → Window setup**.
2. The Window Setup panel is displayed. Figure E-5 shows the default window setup settings and the resulting window banner title above. Change the window settings to match Figure E-6 on page 128, and click **OK**.

![Figure E-5  PCOMM window setup defaults](image)
The session window banner title now has a single letter for the session identifier, and the session LU name as the window banner name. This information can be seen in the Windows launch bar when the session window is minimized, even with multiple sessions open.

### E.5 PCOMM sessions batch file

It is important for systems operators in a computer operations environment to have workstation consoles that have a consistent look and feel. For example, a particular console workstation used for a specific task may have the following attributes:

- A defined set of TN3270E sessions are active for the particular role of the workstation. A workstation console in the operations room will have a different set of sessions active, compared to a workstation console in the tape or printer rooms.
- A workstation’s set of normally active sessions are the only sessions that automatically reactivate if the workstation is rebooted.
- These normally active sessions are automatically activated in a certain sequence, so that a particular session to a particular system device number always has the same PCOMM session prefix letter. For example, LU session SC64E000 is always running in Workstation 1, PCOMM session window A.

Defining these attributes on a workstation console means that operations staff are presented with a consistent user interface, enabling them to become familiar with navigating the workstation desktop. This may help improve the users’ efficiency in performing their role, which is especially important when performing system problem determination.

This section describes creating a PCOMM batch file which, when run, activates a set of PCOMM sessions in a given sequence. This batch file can be added to the workstation’s startup folder to automatically activate the set of sessions at workstation startup time.
E.6 Creating a PCOMM batch file

Starting from the Windows desktop:

1. Click **Start → Programs → IBM Personal Communications → Utilities → Multiple Sessions.**

2. The Create/Modify Batch File panel is displayed (see Figure E-7). Select the required session profile from the File Name list, and click **Add.**

![Figure E-7 PCOMM create batch file](image)

3. The session file name is added to the Batch-File Entries window.

   Continue adding session file names to the Batch-File Entries window in the desired activation sequence. When complete, use the horizontal side bar in the Batch-File Entries window to check the session profile names and their activation sequence (Figure E-8).

![Figure E-8 PCOMM batch file entries](image)
Figure E-8 on page 129 shows four profile names and their activation sequence for Workstation 1’s primary system SC64 sessions. When the batch file is run, the sessions will activate in the following sequence:

- PCOMM session A: LU SC64E000
- PCOMM session B: LU SC64E100
- PCOMM session C: LU SC64E003
- PCOMM session D: LU SC64E103

4. Click File → Save as. Enter a name for the batch file with a file extension of BCH, and click OK (see Figure E-9).

![Save Batch File as dialog box](image)

*Figure E-9  PCOMM batch file save*

5. Click Yes to add this batch file to a folder.

6. Click OK to add this batch file icon to the Windows desktop, and run the batch file when the icon is selected.

7. Click OK on the Add Complete message panel.

8. On the Create/Modify Batch File panel, click File → Exit.

### E.6.1 Adding a PCOMM batch file to the Workstation startup

Starting from the Windows desktop:

1. Right-click on the batch file icon on the Windows desktop.

2. Drag the batch file icon with the right mouse button over the Windows Start button → Programs → Startup, and drop the icon in the Startup list.

3. On the pop-up menu, click Copy Here. The batch file is now added to the Windows Startup folder.

Shut down and reboot the workstation. The batch file will run as part of the workstation startup, and the batch file PCOMM sessions will automatically start in the desired sequence.
AF/REMOTE definitions

This appendix contains the following:

- AF/REMOTE client/server model
- AF/REMOTE workstation example configuration
- AF/REMOTE TN3270E emulator configuration panels
- Modifying AF/REMOTE client and server profile parameters
F.1 AF/REMOTE client/server model

AF/REMOTE is a client/server application that provides host systems management tasks from either a local or remote location using a set of emulation, access, screen analysis, and notification tools. Some examples of the uses of AF/REMOTE are:

- Access and control host servers and distributed systems by connecting TN3270E sessions via the AF/REMOTE server function.
- Monitor and maintain a variety of distributed systems.
- Use the REXX programming language and a library of AF/REMOTE functions for task automation (for example, automating Hardware Management Console tasks via the HMC Application Programming Interface [API]).
- Use AF/REMOTE’s peer-to-peer communication services to send messages to and receive messages from other TCP/IP hosts.

When used as a standalone product, AF/REMOTE provides remote access from LAN-based or modem-based connections to serial-connected, Telnet-connected, and 3270-connected systems and service consoles. Through its REXX-based automation capabilities, event trapping and voice/beeper/e-mail notification are also supported.

AF/REMOTE is based on a standard client/server application model, which enables any authorized user to log on from the AF/REMOTE client to one or more AF/REMOTE servers. After the client/server connection is established, you can use the AF/REMOTE client to interact with the connected AF/REMOTE server.

All activities, with the exception of initially starting and stopping the AF/REMOTE server, are performed from the AF/REMOTE client. You use the AF/REMOTE client to view and interact with active TN3270E sessions running on the AF/REMOTE server, to manage the log, and to perform AF/REMOTE server configuration. If you need to update the AF/REMOTE server configuration, you can automatically restart the AF/REMOTE server from the AF/REMOTE client and then log back on.

F.2 AF/REMOTE workstation example configuration

In our example configuration, the AF/REMOTE workstation configuration has the following attributes:

- The AF/REMOTE client and AF/REMOTE server programs are installed on each client workstation.
- The AF/REMOTE client program running on a workstation logs onto and manages only the AF/REMOTE server program running on the same workstation.
- The AF/REMOTE server program running on a workstation manages only TN3270E client sessions running on that workstation. The term used to describe this type of AF/REMOTE client session is **AF/REMOTE local client**.

We chose to configure our AF/REMOTE environment in this way for a number of reasons:

- Simplicity. The AF/REMOTE client program, AF/REMOTE server program, and all TN3270E sessions running on an AF/REMOTE server (AF/REMOTE local clients), are all within the one workstation.
- No TN3270E client session running on a workstation is dependent on having IP access to an AF/REMOTE server running on a different workstation.
If a workstation or AF/REMOTE server fails, only TN3270E client sessions on that workstation are affected.

LAN network traffic is reduced, as there is no requirement for IP connectivity between TN3270E client sessions running on one workstation and an AF/REMOTE server running on a different workstation.

TCP/IP port assignment contentions with other workstation services or applications are avoided. For example, contentions with short-lived port assignments or workstation operating system services.

F.3 AF/REMOTE TN3270E emulator configuration panels

This section describes configuring AF/REMOTE for TN3270E session support on the client workstation. We show one AF/REMOTE server managing a few resources (TN3270E sessions); however, it is possible to distribute resources among many AF/REMOTE servers and have the client access multiple servers (one locally, the others remotely) simultaneously.

It is assumed this is a new AF/REMOTE installation.

Note: For TN3270E session support in an OSA-ICC environment, we recommend installing the AF/REMOTE client and AF/REMOTE server software components on each console workstation.

For further information about AF/remote software initial installation and configuration, see the AF/REMOTE on Windows NT User's Guide, RP54-5254-A, in the software package.

The AF/REMOTE TN3270E emulator configuration steps are:

1. Modifying AF/REMOTE client and server profile parameters
2. Logging on to AF/REMOTE for the first time
3. Defining the AF/REMOTE client to server connection
4. Defining an AF/REMOTE TN3270E session

F.3.1 Modifying AF/REMOTE client and server profile parameters

Before the AF/REMOTE client and server configuration process, additional startup parameters are added to the client profile and server profile. These profiles are used when the AF/REMOTE client and server programs are first started.

The AF/REMOTE client profile and server profile are text files that can be edited by most commonly available text editor programs. The AF/REMOTE client and server profile default file paths for Windows XP are:

- AF/REMOTE client profile: c:\Program Files\AFREMOTE\config\rpcliprf.txt
- AF/REMOTE server profile: c:\Program Files\AFREMOTE\config\rpsvrprf.txt

AF/REMOTE client profile update

You can run only one copy of the AF/REMOTE server on a given workstation. If a second server startup is attempted, it is quickly terminated and the window focus is transferred to the already running AF/REMOTE Server control panel (see Figure F-1 on page 134).

We recommend implementing a similar function to enforce single client execution for the AF/REMOTE client program. With this function enabled, if a workstation user starts a second instance of the AF/REMOTE client program, the new startup is quickly terminated and the
window focus is transferred to the copy of the AF/REMOTE client program that is already executing (see Figure F-2 on page 135). To enable this feature, uncomment the following entry in the AF/REMOTE client profile (rpcliprf.txt):

```
ENFORCE_SINGLE_CLIENT = YES
```

**Note:** The AF/REMOTE client program must be shut down and restarted for the new profile setting to be activated.

### AF/REMOTE server profile update

The AF/REMOTE server program has the TN3270E Bind Image feature enabled as the server startup default. TN3270E client sessions may not be able to connect to the OSA-ICC server with this feature enabled. We recommend disabling this feature.

To disable this feature, uncomment the following entry in the AF/REMOTE server profile (rpsvrprf.txt):

```
TN3270E_BIND_IMAGE_FEATURE  =  NO
```

**Note:** The AF/REMOTE server program must be shut down and restarted for the new profile setting to be activated.

Restarting the AF/REMOTE server is disruptive to all existing sessions that are currently running via this AF/REMOTE server. Before restarting the server on this workstation, we recommend that you start alternate sessions via another workstation (for example, MCS alternate input/output consoles).

---

**F.3.2 Initially defining the AF/REMOTE client to server connection**

Starting from the Windows desktop:

1. Click **Start** → **Programs** → **AF Remote** → **AFR Server**.

2. The AF/REMOTE AFR1 server panel is displayed (Figure F-1).

   The AF/REMOTE Server panel shows the status of each of the services running on the AF/REMOTE server with the default name AFR1. This panel is used only for starting and stopping the AF/REMOTE server. All other activities are performed from the AF/REMOTE client. Click **Start** → **Programs** → **AF Remote** → **AFR Client**.

   ![AF/REMOTE Server panel](image)

   *Figure F-1  AF/REMOTE Server panel*
3. The AF/REMOTE client control panel is displayed (Figure F-2).

   The AF/REMOTE Client control panel default view includes the Servers and Sessions, Scripts, and Users panes.

   ![AF/REMOTE Client control panel](image)

   **Figure F-2   AF/REMOTE client panel - part 1**

**Logging on to AF/REMOTE for the first time**

This section describes logging on to the AF/REMOTE server for the first time and performing the initial server configuration:

1. On the AF/REMOTE Client control panel, double-click the AFR1 server connection name in the Servers and Sessions pane.

2. The AF/REMOTE Logon to Server AFR1 panel is displayed. Enter the default User ID administrator and default password candle (in lowercase) and click OK.

3. Click OK on the password warning message panel. The AF/REMOTE client is now connected to the AF/REMOTE server AFR1.

   Both the AF/REMOTE server and AF/REMOTE client can now be configured via the AF/REMOTE Client control panel by using the Config menu items.

4. On the AF/REMOTE Client control panel, click **Config → Server → AFR1**.
5. The Server Configuration Properties panel is displayed (see Figure F-3). Click the **General** tab.

![Server Configuration Properties](image)

**Figure F-3** Server configuration properties

6. Enter a new server name in the Server Name field and click **OK**.

   We recommend using a unique server name that is consistent with your OSA-ICC network plan. In our configuration, the AF/REMOTE server running on Workstation 1 is named AFR W/S1.

![Server Configuration Properties](image)

**Figure F-4** Server Configuration General page
7. Click **Yes** to save all changes. Click **Yes** to restart the AF/REMOTE server.

8. Click **OK** on any AF/REMOTE Priority Message Panels that appear due to the AF/REMOTE server shutdown and restart.

9. The AF/REMOTE server reinitializes, and the new server name appears at the top of the Server status pane in the AF/REMOTE Server control panel (see Figure F-5).

---

**Note:** The name that appears in the Servers and Sessions pane of the AF/REMOTE Client control panel has not changed (see Figure F-2 on page 135).

This server connection name (AFR1) is an alias for the new server name (in our configuration, AFR W/S1). The alias name is changed as part of the AF/REMOTE client configuration process, as described in the next section.

---

### Defining the AF/REMOTE client to server connection

This section describes defining a new server connection name alias (in our configuration, AFR W/S1), and removing the default alias definition (AFR1).

1. On the AF/REMOTE Client control panel, right-click the AFR1 server connection name in the Servers and Sessions pane, and select **Disconnect**.

2. On the AF/REMOTE Client control panel, click **Config → Client**.

3. The Client Configuration Properties panel is displayed (Figure F-6 on page 138). On the Server Connections tab, right-click in the Name list and select **Add**.
4. The Server Connection panel is displayed (Figure F-7).

On the Server Connection panel:
- Enter the new server connection name alias, and description.
  
  We recommend using a unique server connection name that is consistent with your OSA-ICC network plan. In our configuration, the AF/REMOTE client to server connection name for Workstation 1 is AFR W/S1, the same as the server name.
- Select the option to connect to the server using local communication.
  
  Local communication means the AF/REMOTE client and server programs are running on the same workstation platform.
– You may select the auto connect, auto logon, and auto select options to automatically perform these functions when the AF/REMOTE client program is initially started.
– Complete the fields in the Server Connection panel, and click **OK**.

5. The Client Configuration Properties panel is displayed, listing the new and default server connection names (Figure F-8). On the Server Connections tab, right-click the default (AFR1) server connection name and select **Remove**. Click **OK**.

![Client Configuration Properties](image)

**Figure F-8**  Client configuration properties - part 2

6. On the Client Configuration Properties panel, select the **General** tab (Figure F-9). You may select a different display font and keyboard layout for all TN3270E client sessions that will be defined on this AF/REMOTE server connection. Complete the fields and click **OK**.

![Client Configuration Properties](image)

**Figure F-9**  Client configuration - General tab

7. Click **Yes** to save all changes and return to the AF/REMOTE Client control panel.
F.3.3 Defining an AF/REMOTE TN3270E session

This section describes configuring an AF/REMOTE TN3270E session on the client workstation.

1. On the AF/REMOTE Client control panel, double-click the server connection name (in our configuration, AFR W/S1) in the Servers and Sessions pane.

2. The AF/REMOTE Logon to server panel is displayed. Enter the default User ID administrator and default password candle, (in lowercase) and clickOK.

3. Click OK on the password warning message panel. The AF/REMOTE client is now connected to the AF/REMOTE server AFR1.

4. On the AF/REMOTE Client control panel, click Config → Server → <server_name>.

5. The Server Configuration Properties panel is displayed. Click the Host Sessions tab.

6. Right-click in the Name list area and select Add from the pop-up menu.

7. The Session Properties panel is displayed (see Figure F-10). On the Session Properties panel, the following options are defined:

   - **Name**
     
     This is the name of this TN3270E session. We recommend that the session name be the same as the LU name defined for the session (see Figure F-12 on page 142).

   - **Type**
     
     Select TN3270E Protocol from the Type pull-down menu.

    Complete the session parameters and click Properties.

8. The TN3270E Emulation Properties panel is displayed (see Figure F-11 on page 141) with these options defined:

   - **Language**
     
     Select the required language.

   - **Usage**
     
     The default usage is Standard MVS™ Console.
– Screen size
   We recommend matching the screen size for the TN3270E session with the display type defined for the MCS console or local non-SNA 3270 terminal. For example:
   • Display type 3277 model 2 has a screen size of 24 rows by 80 columns.
   • Display type 3277 model 3 has a screen size of 32 rows by 80 columns.
   See “MCS console definitions” on page 110 and “VTAM definitions for z/OS” on page 118.

– 3270 Extended Data Stream
   We recommend that 3270 Extended Data Stream be disabled.
   Complete the emulation properties, and click Connection.

![Figure F-11   TN3270E emulation properties](image)

9. The Telnet 3270E Connection panel is displayed (Figure F-12 on page 142) with the following options defined:

   – Host Name or IP address
     This is the IP address you allocated to the OSA-ICC PCHID port. The host IP address defined here must match the host IP address configured in the OSA-ICC server configuration (see Figure 3-7 on page 51).

   – Port Number
     This is the TCP port number used by the OSA-ICC PCHID and workstation TN3270E session, to initially establish session communications. The port number defined here must match the port number defined in the OSA-ICC server configuration (see Figure 3-7 on page 51).

   – Resource/Device Name
     This is the LU Name for this session. The LU name defined here must match the LU name defined in the corresponding OSA-ICC PCHID session configuration (see Figure 3-9 on page 53).
Complete the connection parameters and click **OK**.

![Telnet 3270E Connection](image)

10. The TN3270E Emulation Properties panel is displayed. Click **OK**.
11. The Session Properties panel is displayed. Click **OK**.
12. The Server Configuration Properties panel Host Sessions tab is displayed. Repeat the session definition steps 6 through 11 for all required sessions on this workstation (see Figure F-13) and click **OK**.

![Server Configuration Properties](image)

13. Click **Yes** to save all configuration changes.
14. Click **Yes** to restart the AF/REMOTE server program.

15. Click **OK** on any AF/REMOTE Priority Message Panels that appear due to the AF/REMOTE server shutdown and restart.

16. On the AF/REMOTE Client control panel, double-click the server connection name in the Servers and Sessions pane.

17. The AF/REMOTE Logon to Server panel is displayed. Enter the default User ID administrator and default password candle (in lowercase) and click **OK**.

18. Click **OK** on the password warning message panel. The AF/REMOTE client is now connected to the AF/REMOTE server. The server tree view in the Sessions and Servers pane lists all TN3270E sessions defined to the AF/REMOTE server (see Figure F-14).

---

**Note:** The newly defined TN3270E sessions are not available for use until the AF/REMOTE server program is restarted.

Restarting the AF/REMOTE server is disruptive to all existing sessions that are currently running via this AF/REMOTE server. Before restarting the server on this workstation, we recommend that you start alternate sessions via another workstation (for example, MCS alternate input/output consoles).

19. To start a TN3270E session, double-click the session name in the server tree view in the Sessions and Servers pane.
Advanced Facilities tasks

This appendix contains additional Advanced Facilities tasks, included for reference:

- View code level
- Set card mode
G.1 View code level

The view code level task queries the OSA-ICC microcode level currently active in an OSA-Express feature. The code level is a four-digit number that relates to a specific microcode engineering change (EC) and patch (MCL) level.

This information can be useful in the diagnosis of an OSA-Express related problem. You may be asked by the IBM Remote Technical Support Center or your IBM Service Representative (IBM CE) for the OSA-Express code level as part of information gathering to analyze a problem.

1. To access the OSA-ICC Advanced Facilities, see “OSA-Express Advanced Facilities for OSA-ICC” on page 47.

2. Starting at the Advanced Facilities panel, click View Code level, and click OK. The View Code Level panel is displayed (Figure G-1).

The four-digit code displayed will vary depending on the specific microcode EC and MCL level active in the OSA-Express feature. The code will change as microcode maintenance updates are applied to your System z9 or zSeries server by your IBM CE.

3. Click OK to return to the Advanced Facilities panel.

G.2 Set card mode

The set card mode task is used to set the speed and duplex mode of the OSA-Express port. See “Hardware support” on page 3 for more information.

You can choose any one of the following settings for the OSA-Express 1000BASE-T Ethernet feature port:

- Auto-negotiate
- 10 Mbps half-duplex
- 10 Mbps full-duplex
- 100 Mbps half-duplex
- 100 Mbps full-duplex
- 1000 Mbps full-duplex

1. Starting at the Advanced Facilities panel, click Set Card mode, and click OK. The Set Card Mode panel is displayed (see Figure G-2 on page 147).
2. Click the required Speed/Mode setting, and click **Apply**. The Set Card Mode command-completed panel is displayed.

   The card mode is now set. Enabling and disabling the OSA-ICC port is not required.

3. Click **OK** on the Set Card Mode command-completed panel to return to the Advanced Facilities panel.
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information about ordering this publication, see “How to get IBM Redbooks” on page 149. Note that some of the documents referenced here may be available in softcopy only.

- IBM @server zSeries Connectivity Handbook, SG24-5444

Other publications

These publications are also relevant as further information sources:

- Input/Output Configuration Program User's Guide for ICP IOCP, SB10-7037

Online resources

These Web sites and URLs are also relevant as further information sources:

- zSeries Networking
  http://www.ibm.com/servers/eserver/zseries/networking/
- IBM Personal Communications
- IBM Tivoli AF/REMOTE

How to get IBM Redbooks

You can search for, view, or download Redbooks, Redpapers, Hints and Tips, draft publications and Additional materials, as well as order hardcopy Redbooks or CD-ROMs, at this Web site:

ibm.com/redbooks
Help from IBM

IBM Support and downloads
ibm.com/support

IBM Global Services
ibm.com/services
Index

A
Access List 104
Advanced Facilities 16, 40, 47
AF/REMOTE TN3270E
definitions 140
Attachment 36

B
base support 2
basic configuration 12
benefits 3

C
channel path
definitions 102
CHPID 65
statement 18
Client
  session LU name 65
  workstation IP address 65
client connection
displays 69
Client’s IP 70
CNTLUNIT
  statement 19
configuration
  activation 61
  file 32
  steps 15
  tasks 40
configuration source file 57
  edit 58
  export 57
  import 59
  validate 59
connect rule 70
connection
  status information 64
console
definitions 40, 109
CONSOLEXX member 110
control unit
definitions 104
CSS Value 26

D
Default Gateway 25
Defer Host Disconnect (DHD) 28, 54
device
definitions 106
Device Number 26
DHD 28, 54
drop session utility 75

F
FC 1366 3
FC 3366 3
Frame Type 25
function 2

G
GCS 40, 114

H
Hardware Configuration Definition (HCD) 40
Hardware Management Console (HMC) 40
HCD 40
  rules 18
HMC 40
HMC Integrated Console
  comparison 5
Host code-page 37
Host IP Address 24, 65
host port 65

I
I/O cage 3
IBM 2074
  comparison 5
IBM Personal Communications (PCOMM) 5, 35
IBM Tivoli AF/REMOTE 35
ID statement 18
ignore statement 126
Input/Output Configuration Program (IOCP) 40
Interface 36
IOCDS
definitions 17
IOCP 40
  definition statement 108
  messages 21
  rules 18
IODEVICE statement 20

L
local non-SNA 3270 status 78
Logical Channel Subsystem Identifier 65
Logical Control Unit 65
Logical Terminal (LT)
  index number 65
LT Index 70
LU Name 26
M
MAC address 70
MCS console
definitions 110
MCS output-only console 20, 28, 37, 54
microcode level
display 146
MIFID 26, 65
migrating 7
mixed configuration 14
MTU Size 25
Multiple Image Facility Identifier (MIFID) 65

N
NIP console
definitions 109
non-SNA DFT 3270
session support 125

O
OSA-Express
configuration steps 47
OSA-Express 1000BASE-T 2
description 3
OSA-Express2 1000BASE-T 2
description 3
OSA-Express2 and OSA-Express 1000BASE-T
DIX V2.0 3
IEEE 802.3 (ISO/IEC 8802.3) standard 3
maximum length 4
speed and mode settings 4, 71, 146
OSA-ICC
Default Gateway 51
Frame Type 52
Host IP Address 51
MTU Size 52
server configuration 50
Server Name 51
session status 66
sessions configuration 52
Subnet Mask 51
TCP Port 51
working example 43

P
PCOMM
adding a batch file 130
creating a batch file 129
host connection log 66
session modification 41
session window settings 127
sessions batch file 128
PCOMM TN3270E
Auto-reconnect 36, 123
definitions 122
Host graphics 37, 124
Host IP address 36, 123, 141
Host Name 36, 123, 141
LU Name 36, 123
Port Number 36, 123, 141
Screen size 37, 124
Session type 37, 124
ping utility 73
Port Number 70
print screen 125
Printing
HCD I/O Device rules 20
session type 28

R
Read Time Out (RTO) 31
read timeout 54
Redbooks Web site 149
Contact us x
redundancy 33, 43
requirements 4
response mode 54
Response Mode (RSP) 30
RFC 2355 5
RJ-45 4
RSCS 40, 114
RSP 30
RTO 31

S
sample configuration 44
SE 40
server configuration 24
Server Name 24, 65
Session Index 23, 69
session index number 65
session status 65
sessions configuration
CSS Value 53
Device Number 53
LU Name 54
MIFID 53
Socket Number 70
software 4
subnet mask 25
Support Element (SE) 40
system configuration 2
system console 2
system status 75

T
TCP Port 24
TN3270 enhancements (TN3270E) 5
TN3270E
session status 64
TN3270E emulation 5
TN3270E emulator 41
TPF 4
trace route utility 74
Index

U
Unit Address  65

V
validation  55
verification  41
VLAN  46
VPN  46
VTAM
  definitions  40, 118

W
worksheet
  server  98
  sessions  99
  workstation  100
Write Control Characters (WCC)  126

Z
z/OS  4
z/OS console
  definitions  110
z/VM  4
z/VM console
  definitions  114
z/VSE  4
This IBM Redbook discusses how to plan, implement, and configure the Open Systems Adapter-Express Integrated Console Controller (OSA-ICC) function. The OSA-ICC function is supported on OSA-Express2 and OSA-Express 1000BASE-T Ethernet features for System z9, zSeries 990, and zSeries 890 servers.

The book focuses on the hardware configuration and software definitions needed to provide connectivity from the operating system to the TN3270E client emulator program. It provides information for planning purposes and system setup. Helpful utilities and commands for monitoring and managing the OSA-ICC environment are also included.

This redbook is intended for system engineers, network administrators, and system programmers who will plan and install OSA-ICC. A solid background in OSA-Express, HCD or IOCP, and TCP/IP is assumed.